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1-1   نصب برنامه 
ابتدا CD  نرم افزار SDRMAP را داخل درایو قرار داده و بر روی درایوی کــهCD قـرار دارد دو بـار کلیـک 
کرده و یا  دکمه سمت راست ماوس را زده و گزینه OPEN را اجرا کرده وبرروی فایل                دوبــارکلیک 

کنید. در این صورت پنجره ای به شکل زیر باز می گردد: 
 
 

 
 

ــائید. همچنیـن بـرای کـم و زیـاد  در این پنجره برای دیدن پاره ای از توضیحات بر روی دکمه About کلیک نم
  کلیـک کـرده و صـــدای کردن صدای موزیک می توان با استفاده از ماوس بر روی آیکون 

ــه Exit کلیـک  موزیک را کم و زیاد نمود. در صورت نیاز به خروج از مرحله نصب در پنجره فوق بر روی دکم
ــه SDRmap بـر روی دکمـه SDRmap 8.01  کلیـک کنیـد. در ایـن  نمائید و در صورت تمایل به نصب برنام

صورت پنجره ای به صورت زیر باز می گردد: 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01 نرم افزار
 
2

 

 
بر روی دکمه Next کلیک کرده تا پنجره دیگری بصورت زیر گشوده گردد: 
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ــه در                    در پنجـره فـوق مـی تـوان محـل ذخـیره برنامـه را تغیـیر داد. بصـورت پیـش فـرض محـل نصـب برنام
شاخه  C:\ program files\ SDRmaping & Design خواهد بود. با کلیک بر روی دکمه Browse  می توان 
ــابه زیـر  محل نصب برنامه را انتخاب کرده و سپس بر روی دکمه Next کلیک نموده تا وارد پنجره دیگری مش

شوید: 

 
ــر گرفتـه خواهـد شـد بـه نمـایش در  در این پنجره نامی که برای برنامه در قسمت Start menu ویندوز در نظ
ــیر  خواهد آمد که بصورت پیش فرض  SDRmaping & Design می باشد در صورت نیاز می توانید آنرا تغی

دهید. برروی دکمه Next کلیک نمائید. پنجره ای بصورت زیر باز می گردد: 
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ــک تـاپ وینـدوز بـر روی دو گزینـه  درصورت تمایل به ایجاد آیکون مربوط به نرم افزار  SDRMAP در دس
ــر روی دکمـه   Creat a Quick launch icon وCreate a desktop icon  کلیک کرده تا ? دار شوند .سپس ب

Next کلیک نمائید تا پنجره دیگری به صورت زیر گشوده شود: 

 
در این پنجره مسیر نصب و پاره ای دیگر از مشخصات مربوط به برنامه به نمــایش در مـی آیـد. بـرای نصـب 

برنامه بر روی دکمه Install  کلیک کنید. در این صورت برنامه شروع به نصب شدن می گردد: 
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پس از اتمام نصب پنجره ای به نام پنجره Information بصورت زیر باز خواهد شد.در پنجــره فـوق بـر روی 
Next کلیک کنید. 

 
ــد تـا مرحلـه نصـب بـه  پنجره دیگری بصورت زیر باز می گردد. در این پنجره بر روی دکمه Finish کلیک کنی

اتمام رسد. 
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ــد شـد. ایـن پنجـره بـه پنجـره اولیـه      در این صورت برنامه اجرا شده و وارد برنامه SDRmap V8.01 خواهی

نرم افزار معروف می باشد. 

 
 

توجه 1:  
برای خروج از برنامه از منوی File گزینه Exit را انتخاب کرده یا بر روی آیکون              ا ز گوشـه بـالا و 

سمت راست پنجره اولیه نرم افزار کلیک کنید. 
 

توجه 2:  
و برایRestore Down جهت Minimize ( کوچک ) نمودن پنجره اولیه نرم افزار بر روی آیکون                

کلیک کنید. (نیم صفحه ای ) نمودن آن بر روی دکمــه                
 

توجه 3:  
با کلیک بر روی منوی View از پنجره اولیه دو گزینه Status Bar وToolbar به چشم می خورند که بصورت 
? دار می باشند. در صورتی که گزینه Toolbar فعال نباشــد در اینصـورت نـوار ابـزار زیـر دربـالای صفحـه 

گرافیکی مشاهده نخواهد شد. 
w
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ودرصورتی که گزینه Status bar  فعال نباشد نوار اطلاعــاتی زیـر در پـائین صفحـه گرافیکـی بـه نمـایش در 
نخواهد آمد. 

 
توجه 4:  

در منوی  Options  از پنجره اولیه پنج گزینه بشرح زیر وجود دارد: 
 

-  Backup job :   جـهت ایجـاد  

ـــورد  یــک پشــتیبان از جــاب، م
ــا اجـرای  استفاده قرار می گیرد. ب

ــابل   گزینه فوق پنجره ای بفرم  مق
بازمی گردد: 

 Source ــمت در این پنجره در قس
ــــــمت  جــــاب اولیــــه ودر قس
Destination مسیر و نــام جـاب 

پشتیبان را وارد کرده و Ok کنید. 
 
 
 

- Restore a job :     توسط این 
ــی توانیـد جـاب پشـتیبان  گزینه م
تهیه شده بر روی فــلاپـی دیسـک 
ویا هارددیسک را به مسیر مــورد 

نظر منتقل نمائید. 
ـــدا در قســمت  در ایـن پنجـره ابت
ـــــتیبان ودر  Source جـــاب پش

قسمت Destination مسیر مورد 
نظر را انتخاب کرده وOk نمائید. 
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- Delete job :        توســط ایـن 
گزینه می توانید ازجابهای موجود 
 Source جاب دلخواه را درقسمت
ــودن  انتخاب کرده وپس از Ok نم

آنرا حذف کنید. 
 
 
 
 

ــه  - Rename job :     ایـن گزین
برای تغییر نام یک جــاب موجـود 
بکار می رود. با انتخاب این گزینه 

ـــاز        پنجــره ای بصــورت زیــر ب
می گردد: 

در قسمت Source نام جاب قبلــی 
ـــام  و در قسـمت Destination  ن

جدید را وارد کرده و Ok کنید. 
 
 

- Background color :      برای تغییر رنــگ 
زمینه گرافیکی نرم افــزار مـورد اسـتفاده قـرار 
مـی گیـرد. بـا انتخـاب ایـن گزینـــه پنجــره ای 

بصورت زیر باز می گردد: 
 
 
 
 
 

رنگ مورد نظــر را انتخـاب ( معمـولا سـفید یـا 
مشکی) و Ok نمائید. 
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2-1   تنظیمات اولیه  
پس از نصب برنامه بایستی قبلاَ ازهماهنگی واحدهای مورد استفاده مانند واحد زاویه ، واحد طول وترتیب 
نمایش مختصات (x.y,z –y.x.z) اطمینان حاصل کرد. لذا به محض ایجاد یک جاب جدید و یا انتخاب جاب 

موجود پنجره ای بنام First time initialization  باز خواهد شد: 

 
 

در این پنجره می توان تنظیمات اولیه ای را به نــرم افـزار معرفـی نمـود. ایـن تنظیمـات بـه سـه دسـته تقسـیم          
می شوند: 

   - Coord order :       نحوه نمایش مختصات نقاط یکی بصورت x,y که بایستی E,N فعال باشد و دیـگری 

بصورت y,x که بایستی N,E فعال شود را نشان می دهد. 
 

ـــی باشــد را در   -  Linear units :     در ایـن بخـش مـی تـوان واحـد طـول  کـه معمـولا برحسـب مـتر م

قسمتهایinput (ورودی) و output ( خروجی) معرفی نمود. در صورت نیاز به انتخاب واحد دیگری برای طول  
بر روی فلش جلوی قسمت input و output کلیک کرده و واحد مورد نظر را انتخاب کنید. 

 
ــی باشـد را در      -  Angluar :          در این بخش می توان واحد زوایا  که معمولا برحسب درجه یا گراد م
ــگری بـرای  دو قسمت input ( ورودی) و output ( خروجی) معرفی نمود. در صورت نیاز به انتخاب واحد دی

زوایا بر روی فلش جلوی قسمت output وinput کلیک کرده و واحد مورد نظر را انتخاب کنید. 
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توجه1: 
در مورد چگونگی ایجاد و یا انتخاب جاب در فصل بعدی مفصلاَ صحبت خواهد شد. 

 
توجه2: 

چنانچه پس از خروج از برنامه برای بار دوم بخواهید وارد برنامــه شـوید بایسـتی CD مربـوط بـه برنامـه را 
ــرده و سـپس وارد برنامـه مـی شـود. در  داخل درایو قرار دهید. در این صورت برنامه ابتدا قفل CD را چک ک
صورتی که CD داخل درایو قرار نگرفته باشد پیغام please insert cd  into drive  ظاهر مــی گردد. در ایـن 

صورت CD را داخل درایو قرار داده و مجددا برنامه را اجرا کنید. 
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1 .2   ایجاد یک پروژه جدید   
برای آنکه بتوان اطلاعات مربوط به پروژه های مختلف را جدا از هم ذخیره نمود، بایستی برای هر پــروژه یـک 

فایل جداگانه (اصطلاحاَ Job) ایجاد نمود. دراین نرم افزار برای نگهداری هــر پـروژه از تعـدادی فـایل اسـتفاده       
می شود که مهمترین  آنها فایل dp ( مخفف  Database) می باشد.  

با توجه به اینکه نرم افزارفوق ازامکانات Windows 95 و بالاتر بهره مند بــوده لـذا بـرای فـایل dp مـی تـوان 
پسوندی با نام دلخواه بدون محدودیت3 کاراکتری تعیین نمود. ( لازم به ذکــر اسـت کـه در SDRmap نسـخه 
6.5 و پائین تر حداکثر 3 کارا کتر می توان برای پروژه جدید بعنوان مشخصه Job وارد نمود اما در نرم افزار 

ــروژه جدیـد بـا نـام dp.Vadood1 در شـاخه  فوق این محدودیت وجود ندارد.) بعنوان مثال اگر بخواهیم یک پ
F:\TEHRAN MASSAHI ایجاد نمائیم پــس از اجـرای نـرم افـزار پنجـره ای ( معـروف بـه پنجـره اولیـه ) 

بصورت زیر گشوده خواهد شد: 
 

 
از  پنجره فوق بر روی منوی File کلیک کرده و گزینه New را از پنجره زیر  فعال نمائید. 
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در این صورت پنجره دیگری بصورت زیرگشوده خواهد شد: 

 
در پنجره بالا در قسمت :Look in  مسـیر ذخـیره پـروژه را انتخـاب (F:\ Tehran Massahi) ودر قسـمت    

ــته باشـید در هنـگام  File name  نامی برای پروژه که همان dp.Vadood1 می باشدرا تایپ نمائید. توجه داش

ایجاد یک پروژه قسمت File name بصورت *.db ظاهر می گردد که می توان بجای علامت * پســوند دلخـواه 
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خود را وارد کرد. گزینه New job را از پنجره بالا فعال کرده و در سایر قسمت های دیــگر در صـورت تمـایل 
می توان اطلاعات توصیفی مربوط به پروژه را همانند پنجره بالا پر نمود . 

 
 Description     توضیحات مربوط به پروژه                             Job  ID           مشخصه مربوط به پروژه

  Client                                    نام کارفرما                              Data created             تاریخ ایجاد پروژه
 Location                               محل پروژه                              File No               شماره فایل ایجاد شده
  Oprator                   نام اپراتور نقشه کش                             Authority                       نام نقشه بردار

 
پس از تکمیل پنجره بالا بر روی دکمه Open کلیک کرده تا صفحه گرافیکی مربوط به پروژه جدید ایجــاد شـده 

به صورت زیرگشوده گردد. این پنجره به پنجره ثانویه نرم افزار معروف می باشد. 

 
در صورت لزوم می توان محیط گرافیکی مربوط به پروژه جدید ایجاد شده را به صــورت تمـام صفحـه ای در 

آورد. این کار با کلیک کردن بر روی آیکون  مربوط به بزرگنمائی صفحه نمایش امکان پذیر می باشد. 
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توجه1: 
جهت ایجاد یک پروژه یا جاب جدید می توان از دو روش زیر نیز استفاده نمود: 

 
الف) کلیک کردن بر روی آیکون                   از پنجره اولیه یا ثانویه نرم افزار  

ب) استفاده  ترکیبی از کلیدهای Ctrt + N از صفحه کلید 
 

توجه2: 
ــورت تمـایل  همانطوری که قبلاَ گفته شد در ارتباط با پروژه ایجاد شده تعدادی فایل ساخته می شود که در ص
ــاهده نمـود. در پنجـره زیـر  به مشاهده آنها می توان از محیط ویندوز به محل ذخیره پروژه رفته و آنها را مش

فایلهای ایجاد شده برای پروژه db.vadood1 را ملاحظه می کنید. 

 
 2-2    انتخاب یک پروژه موجود  

توجـــه داشـــته باشـــید کـــه پـــس از نصـــب برنامـــه SDRMAP تعـــدادی فـــــایل در دایرکتــــوری                        
Program fiels\SDRmapping &Design\Examples\ ایجاد می شوند. این فایلها همان مثالهائی هستند که 
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به صورت پیش فرض درشاخه بالا نصب شده و جهت سهولت وفراگیری راحتتر نرم افزار پیشــنهاد مـی گردد 
که از این مثالها جهت درک بهتر نرم افزار استفاده شود.  لذاجهت انتخاب یــک پـروژه موجـود کافیسـت کـه در 

پنجره اولیه یا ثانویه نرم افزار  بر روی منوی File کلیک کرده و گزینه Open را فعال نمود. 
 

 
 

  
 
 
 
 
 

ــر  در این صورت پنجره Open باز شده و برنامه لیستی از جابهای موجود در دایرکتوری جاری رابصورت زی
نشان خواهد داد.  
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جهت انتخاب یک  job موجود در مسیر دلخواه کافیست که از پنجره Open  در قسمت :Look in مسیر ذخیره 
اـ  جاب را انتخاب کرده و از میان جابهای موجود بر روی جاب دلخواه کلیک کرده و دکمه Open را اجرا کرد. ب
کلیک بر روی جاب دلخواه مشــخصات توصیفـی آن ( در صـورت وجـود) در قسـمتهای مربوطـه  نشـان داده 
 d:\Program files\خواهد شد. جهت تمرین می توانید از جابهای نرم افزار که بطــور پیـش فـرض در مسـیر
SDRmapping&design\Examples  نصب شده اسفاده کنید. بعنوان مثــال جـهت تمریـن  جـاب dp.bdy را 

ازمسیر بالا انتخاب کرده و بر روی آن کلیک و آنرا باز نمائید. در اینجا نیز می توان جهت نمایش تمام صفحــه 
ای محیط گرافیکی جاب انتخاب شده از آیکون مربوط به بزرگنمائی صفحه نمایش استفاده نمود . 

 

 
توجه1: 

جهت انتخاب یک پروژه یا جاب موجود می توان از دو روش زیر نیز استفاده کرد: 
 

از پنجره اولیه یا ثانویه نرم افزار الف) کلیک بر روی آیکون                  
ب) استفاده ترکیبی از کلیدهای Ctrt + o از صفحه کلید 
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توجه2: 
در صورت نیاز به تغییر رنگ صفحه گرافیکی کافیست از پنجره اولیه نرم افزار بر روی منوی  Options کلیـک 
کرده و گزینه Background color را فعال نمود . از پنجره باز شده می توان رنگ دلخواه (ترجیحاَ مشـکی) را 
ــگ مـورد  انتخاب نموده و Ok کرد. لذا پس از ایجاد و یا انتخاب جاب ،رنگ صفحه گرافیکی نرم افزارشما به رن

نظرتبدیل خواهد شد. 
 

توجه3: 
برای معرفی ونشان دادن مسیر گزینه انتخابی مثلاَ انتخاب گزینه Add Points ازمنوی کرکـره ای  Points در 

طول این کتاب از فرم قراردادی زیر تبعیت می شود: 
 Points>Add Points

یعنی ابتدا بر روی منوی کرکره ای Points کلیک کرده وسپس گزینه Add Points را فعال کنید. 
 

توجه4: 
در بالای برنامه در خط دوم وسوم شما آیکونهائی را می بینید که برای دسترسی سریعتر به دستورات برنامه 
طراحی شده اند. اگر بر روی هر کدام از آیکونها نشانگر ماوس را برای چند لحظه نگهدارید پنجره کـوچکـی در 

زیر آیکون باز می شود که می توانید توضیح مختصری راجع به هر آیکون را مشاهده کنید. 
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 SDRMAP 1-3   خواندن نقاط از یک فایل نوشتاری هماهنگ با فرمت
ــد. امـا جـاب ایجـاد شـده در  همانطوری که قبلا گفته شد اولین قدم در انجام یک پروژه ایجاد یک جاب می باش
مرحله اول خالی است که در این مرحله بایستی اطلاعات مختلفی را درون جاب ایجاد شده منتقل نمائیم.یکــی از 

روشهای ورود اطلاعات، خواندن نقــاط مختصـات دار از درون یـک فـایل نوشـتاری (ASCII file) بـه درون     
ــامل شـماره  نرم افزار می باشد. این فایل متنی فقط شامل حروف و اعداد بوده و محتویات آن تنها می تواند ش

نقاط، مختصات (x.y.z) و کد نقاط باشد. اکیدا اطلاعات حاوی مشاهدات قطبــی بـه ایـن طریـق قـابل انتقـال بـه    
نرم افزار نمی باشد.در صورتی که فایل اطلاعاتی موجود بــا فرمـت SDRmap coordinate format توسـط 
نرم افزار SDRmap نسخه 6.50 و پائین تر تهیه شده باشد می توان آنرا با همین فرمت در نرم افزارفراخوانی 
کرد. پنجره زیر نمونه ای از فایل تهیه شده با فرمت SDRmap coordinate format را که توســط نـرم افـزار 

SDRmap نسخه 6.50 تهیه شده ، نشان می دهد. 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01 نرم افزار
 

24
 

ــایل موجـود  در پنجره بالا اطلاعات به ترتیب شماره ، z ، y ، x و کد نقاط مرتب شده اند.جهت انتقال اطلاعات ف
به درون نرم افزار پس از ایجاد یک جاب جدید دستور File> Import  را اجرا نموده تا پنجره ای به شکل زیر 

باز گردد: 
 

 
در ایـــن پنجـــره ابتـــدا در قســـمت File type  فرمـــت مناســـــب فــــایل اطلاعــــاتی کــــه همــــان                                              

SDRmap coordinate format  می باشد را انتخاب کرده ســپس در قسـمت file name  بـا کلیـک یـر روی 

ــل شـده و جـهت  دکمه Browse  فایل اطلاعاتی خود را پیدا  و در نهایت Ok کنید. لذا نقاط به درون جاب  منتق
نمایش نقاط انتقال یافته به درون جاب ایجاد شــده کافیسـت کـه از صفحـه کلیـد دکمـه Z و سـپس دکمـه E را 

فشرده تا تمام نقاط بر روی صفحه گرافیکی ظاهر شوند. 
 

 (Zoom) 2-3    دستور بزرگنمائی
جهت بزرگنمائی  اطلاعات ظاهر شده بر روی صفحه گرافیکی می توان به چند روش زیر عمل نمود: 

 
الف) اگر بخواهیم تصویر تا حد ممکن بزرگ شده به شرط آنکه کلیه موضوعات در محیط ترسیم دیــده شـوند 

کافیست ابتدا دکمه Z وسپس دکمه E را فشار داد. مشابه عمل    Zoom Extend در اتوکد می باشد. 
 

ب) با هر بار کلیک بر روی آیکونهای                  و                  از نوار ابزاربالای نرم افزار می توان به ترتیب 
نسبت به بزرگنمائی و کوچک نمائی اطلاعات اقدام نمود. 
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ــی را بـه انـدازه  ج)  همانند دستور Zoom Window در نرم افزار اتوکد اگر بخواهیم قسمتی از صفحه گرافیک
یک پنجره مستطیل شکل بزرگ نمائیم بایستی با کلیک بر روی آیکون              از نوار ابزاربالا ی نــرم افـزارو 
سپس رسم یک مستطیل فرضی در محلی دلخواه از صفحه گرافیکی این کار را انجام داد. پس از کلیک بـر روی 
آیکون فوق بر روی یک نقطه از صفحه گرافیکی کلیک کرده و در حالی که کلیـد سـمت چـپ مـاوس پـائین نـگه 
ــه مـاوس را رهـا مـی کنیـم.  داشته شده آنرا حرکت داده و مستطیل فرضی دلخواه را ایجاد کرده و سپس دکم

بجای کلیک کردن بر روی آیکون بالا می توان دکمه Z از صفحه کلید را فشرده و عمــل بـزرگنمـائی را توسـط  
یک  مستطیل  فرضی  مطابق روش قبلی انجام داد. 

 
 (Zoom scale) د) بزرگنمائی و کوچک نمائی به اندازه لازم

جهت این منظور ابتدا کلید Z و سپس کلید M را از صفحه 
کلید زده و در پنجره ای که ظاهر می شود ضریب  مورد 

 نظر را تایپ می کنیم.  اعداد بزرگتر از 1 عمل بزرگنمائی  
و اعداد کوچکتر از 1 عمل کوچکنمائی را  انجام می دهد. 

 
 

ه ) جهت بازگشت به وضعیت بزرگنمــائی قبلـی ابتـدا کلیـد Z و سـپس P را بزنیـد. ایـن عمـل مشـابه دسـتور         
Zoom  previuose  در اتوکد می باشد. 

 
 

  ( Pan ) 3-3    جابجائی نقشه
جهت جابجائی نقشه ابتدا بر روی آیکون                  از نوار ابزار بالای نرم افزار کلیک کرده و سپس نشــانگر 
ــه کلیـد  ماوس را که به شکل یک فلش چهار سر درآمده به محل مورد نظر برده وکلیک نمائید سپس در حالی ک
سمت چپ ماوس را پائین نگه داشته اید نشانگرماوس را به محل جدید منتقل کرده و کلید آنــرا رهـا نمـائید. در 
اینصورت نقشه به اندازه مقدار مشخص شده جابجا خواهد شد. این عمل توسط دکمه p از صفحه کلید نیز قابل 

اجرا می باشد. 
 
 

توجه: 
درماوس هائی که دارای یک چرخ کوچک بر روی دکمه ماوس (موسوم بــه SCROLL) هسـتند مـی توانیـد بـا 
چرخاندن این دکمه برروی صفحه گرافیکی عمل زوم را انجام دهید. چنانچه این دکمــه از مـاوس را فشـار داده 

وماوس را به حرکت درآورید می توان عمل جابجائی نقشه را نیزانجام داد. 
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  ( Redraw ) 4-3     ترسیم مجدد یا بازسازی نقشه
بعضی اوقات در هنگام پاک کردن یا ویرایش موضوعات بخشی از آنها به ظاهر بــر روی محیـط ترسـیم بـاقی  
می مانند . برای پاک کردن این علائم کاذب از دستور Redraw استفاده می کنیم. در این نــرم افـزار جـهت ایـن 

عمل می توان دکمه D را از صفحه کلید فشار داد. 
 

 SDRMAP 5-3    خواندن اطلاعات از یک فایل نوشتاری غیر هماهنگ با فرمت
اگر فایلی را که بخواهیم به درون نرم افزار منتقل نمائیم با فرمت نرم افزار SDRMAP  هماهنگی نداشته باشد 

یا به عبارتی دیگر مطابق با فرمتهای موجود در داخل نرم افزار نباشد، می توان آنرا به شکل قــابل اسـتفاده در                                              
ــایلی را نشـان مـی دهـد کـه فرمـت آن بـا فرمـت                                               این نرم افزار در آورد. بعنوان مثال پنجره زیر نمونه ای از ف

Wildosft بوده و اطلاعات مربوط به هر نقطه توسط کاما از هم جدا شده اند. 

اما چنین فرمتی در داخل نرم افزار موجود نمی باشد. بنابراین قاعدتاَ نمی توان  آنرا به درون نرم افــزار منتقـل 
نمود. اما این نرم افزار قابلیت آنرا دارد که فرمت فایل موجود را بشکلی در آورد که قابل خواندن در نرم افــزار 

باشد. 
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جهت این امر نیز همانند حالت قبلی از دستور File> Import استفاده می نمائیم و در پنجره باز شــده ابتـدا در 
ــایل  قسمت File Type فرمت Variable Ascii و سپس در قسمت File name با استفاده از دکمه Browse  ف

مورد نظر را انتخاب و Ok  می کنیم. در اینصورت پنجره ای به شکل زیر گشوده خواهد شد:  
 

 
در پنجره بالا ابتدا قسمت Retrieve a previously saved format را به حالت خاموش در آورده و در قسمت                                             

Start import at row عدد 1 را انتخاب کنید. عدد 1 به این خاطر می باشد که از نقطه شماره 1 اطلاعــات فـایل 

ــه  نوشتاری به درون جاب منتقل گردد. اگر در این قسمت عدد 50 را وارد کنید نقاط فایل از شماره 50 به بعد ب
 Next ــه نمـایش در خواهـد آمـد. بـا زدن  دکمـه درون جاب منتقل خواهند شد.در پائین پنجره محتویات فایل ب

پنجره ای دیگر ی بصورت زیر باز می گردد: 
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چون اطلاعات هر نقطه توسط کاما از هم جدا شده اند ابتدا گزینه Comma را انتخاب کرده و سپس در قســمت 
ــی باشـد کـه اطلاعـات هـر نقطـه شـامل پنـج  Fields  per  record عدد 5 را وارد کنید. عدد 5 به این منظور م

ــد. در ایـن صـورت  پارامتر شماره نقطه ,  z ,y,x و کد نقطه می باشد.در نهایت بر روی دکمه Next کلیک نمائی
پنجره زیر باز می گردد: 

 

 
 Point number گزینـه Field data format فعـال بـوده لـذا از قسـمت Field 1 در این پنجره چون قسمت
(شماره نقطه)را روشن می نمائیم. بنابراین  Field 2 فعال می گردد برای این قسمت گزینــه Easting از سـمت 

ــه همیـن ترتیـب بـرای Field 3 گزینـه Northing و بـرای Field 4 گزینـه Height وبـرای     راست پنجره و ب
 Field 5 گزینه Code را انتخاب نموده و در نهایت بر روی دکمــه  Finish کلیـک مـی کنیـم. در صورتـی کـه 

ــهای بعـدی تکـرار نـگردد گزینـه Save format for future use  را روشـن          بخواهیم این تعاریف برای فایل
ــک بـر روی دکمـه Finish درپنجـره ای کـه بـاز مـی شـود ابتـدا نـامی در       می کنیم. در این صورت پس از کلی

  Save راوارد کرده و سپس بر روی دکمه  Wildsoft برای فرمت ایجاد شده بعنوان مثال File name  قسمت
کلیک می کنیم. 
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 سپس پنجره زیر جهت انتخاب همه نقاط موجود در فــایل (All points ) و یـا بخشـی از شـماره نقـاط فـایل                                              

(Range )  باز شده که گزینه All points را روشن و در نهایت Ok کنید. 

 

 
در این صورت نقاط به درون  نرم افزار منتقل شده و بصورت زیر بــه نمـایش در خواهنـد آمـد. در اینجـا نـیز    

می توان از حالت های مختلف Zoom استفاده نمود. 
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 توجه1: 
در صورتی که بخواهید بخشی از نقاط فایل را به درون جاب منتقل نمائید به جــای گزینـه All Points  گزینـه 
ــپس  Range را انتخاب کرده ودر قسمتهای MIN وMAX  کمترین و بیشترین شماره نقطه را وارد کرده و س

OK  کنید. 

  
توجه2: 

اگر نیاز به ورود اطلاعات فایلی مشابه فــایل فـوق بـه همـان فرمـت Wild soft باشـد. بـا توجـه بـه اینکـه در 
پنجرهVariable ascii step 1 of  3  این قالب ذخیره شده است پس از اجرای فرامین کافیســت کـه در پنجـره 
فوق  گزینه  Retreive   a previously  Saved format را روشن کرده و دکمه Next را کلیک نمائید. در این 
 Ok کلیک نمائیدو پس از انتخاب نقاط Open صورت نام فایل قالب سوال می گردد آنرا انتخاب کرده و بر روی

کرده تا نقاط بر روی صفحه گرافیکی ظاهر شوند. 
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6-3      ورود اطلاعات تاکئومتری به نرم افزار 

با فرض اینکه نقشه برداری بصورت طول و زاویه ( قطبی) صورت پذیرفتــه باشـد و کـاربر برنامـه ای غـیر از   
نرم افزار SDRmap جهت تبدیل اطلاعات برداشت شده زمینی به مختصات نداشته باشد، در این بخــش نحـوه 
ورود اطلاعات تاکئومتری نقاط برداشت شده زمینی به نرم افزار SDRmap ومحاسبه مختصات نقاط برداشت 
شده ونیز ذخیره نقاط مختصات دار در Database نرم افزار را توضیح خواهیم داد. جهت درک بهتر این بخش 
به مثالهای زیر توجه فرمائید توصیه می شود که کاربران مثالهای ارائه شده در این بخش را به ترتیب به خاطر 

ــایر مـوارد دیـگر را نـیز مطـابق آنچـه کـه گفتـه        بسپارند زیرا با فراگیری دقیق مثالهای ذکر شده می توانند س
می شود انجام دهند. 

 
مثال 1: 

فرض کنیــد مختصـات ایسـتگاه اسـتقرار (10.120 و 100.00 و 200.00 ) S1  ومختصـات نقطـه نشـانه روی        
( 11.100 و 200.00 و 400.00 ) S2  وارتفاع دستگاه روی ایستگاه استقرار S1 برابر Hi=1.66 m باشـد.بـا 

  Ht =1.66m صفر صفر کرده ایم و ارتفاع منشور روی نقاط برداشت شــده S2 به S1 فرض اینکه از ایستگاه
قرار گرفته است. مطلوبست محاسبه مختصات نقاط برداشت شده زیر با توجه به اطلاعات ارائه شده بالا. 

شماره نقطه      زاویه قائم                  زاویه افقی                             طول مایل
  1      44.670               71° 41΄ 30˝               90° 00΄ 00˝ 
  2      56.413 69° 36΄ 30˝  89° 59΄ 10˝
  3      56.997 67° 40΄ 05˝  89° 58΄ 20˝
  4      57.914 67° 50΄ 10˝ 89° 57΄ 30˝
  5      25.395 43° 03΄ 30˝               89° 99΄ 00˝
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حل: 

جهت ورود اطلاعات بالا و محاسبه مختصات نقاط بایستی مراحل زیر را طی نمود: 
 (  E:\ Massahi در شاخه MA1مثلا جاب ) جدید job و ایجاد یک SDRmap V 8.01 الف)  اجرای نرم افزار

ب ) اجرای دستور Entry>Eletronic stadia  . با اجرای فرمان فوق پنجره ای مشابه زیر باز می گردد: 

 
 

درپنجره بالا گزینه stadia را فعال کرده و شــماره ای در قسـمت Survey number بـه عنـوان شـماره بـرگه 
تاکئومتری وارد مــی کنیـم بـا توجـه بـه عبـارت ظـاهر شـده در قسـمت path مـی تـوان بـا اسـتفاده از دکمـه        

 Open existing   فایل تاکئومتری موجودی را پس از جستجو توسط دکمه Browse انتخاب کرده وآنــرا بـاز 

نمود. ودر صورت دلخواه نسبت به اعمال یکسری تغییرات برروی آن اقدام کــرد. چنانچـه فـایل تـاکئومتری از 
 E:\massahi در مســیر Stad1.ma1 از پنجره بالا فایلی با نام New  قبل موجود نباشد با کلیک بر روی دکمه
ایجاد خواهد شد. ملاحظه می فرمائید که بصورت پیش فرض فرم تاکئومتری با نام Stad1 ایجاد خواهد شد که 
عدد 1 همان شماره ای است که در قسمت Survey Number وارد کرده ایم وپسوند آن همان مشــخصه جـاب 
ــت کـه در هنـگام ایجـاد  می باشد که در هنگام ایجاد جاب وارد نموده و E:\MASSAHI محل ذخیره جاب اس
جاب معرفی نموده ایم.  در صورت دلخواه می توان  فــایل تـاکئومتری ایجـاد شـده را بـا نـام دیـگر در مسـیر 
ــاکئومتری  در همـان مسـیر E:\MASSAHI وبـا نـام  دلخواه ایجاد نمود. بعنوان مثال اگر بخواهیم اطلاعات ت
Vadood.ma1 ایجاد گردد در قســمت path عبـارت E:\massahi\vadood.ma1 را تـایپ کـرده و سـپس بـر 

روی دکمه New کلیک کنید. با کلیک بر روی دکمه New پنجره مربوط به ورود اطلاعات تاکئومتری بفرم زیـر 
گشوده می گردد: 
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در پنجره بالا با کلیک بر روی فلش کنار STN در هر ردیف می توان یکی از موارد زیر را انتخاب نمود: 

 
STN : جهت تعریف مختصات ایستگاه استقرار  

AT/BS : جهت توجیه ایستگاه استقراربه قراولروی 
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Fnote : جهت تعریف توضیحاتی در مورد نقطه 

 ( S/pist) طول مایل ، ( Vt cir) زاویه قائم ، ( Hz cir ) زاویه افقی ،( Pt#) جهت تعریف شماره نقطه : SD/HT

  (  Ht) و ارتفاع رفلکتور یا منشور
 HZ/DH : جهت تعریف شماره نقطه (#Pt ) ، زاویه افقی ( Hz cir ) ، زاویه قــائم (Vt cir ) ، اختـلاف ارتفـاع 

 ( Ht) بین ایستگاه و نقطه برداشت شده زمینی و ارتفاع رفلکتور ( Ht/Diff)
HD/RL : جهت تعریف شماره نقطه (#Pt ) ، زاویه افقی ( Hz cir ) ، طول افقی (Hz dist )و ارتفاع نهائی نقطه 

( Height ) برداشت شده زمینی 
  

بنابراین با توجه به اطلاعاتی که در مثال 1 ارائه شده ودر اختیار ما می باشد می توان یکی از موارد مورد نیاز 
ــرای ورود اطلاعـات برداشـت شـده زمینـی بـه  را برای وارد کردن اطلاعات برداشت شده انتخاب نمود. حال ب
ــتقرار معرفـی گردد. لـذا در خـط اول پنجـره مربـوط بـه ورود  درون نرم افزار ابتدا باید مختصات ایستگاه اس
ــابل آن اطلاعـات ایسـتگاه اسـتقرار را وارد  اطلاعات ابتدا گزینه STN را انتخاب کرده و سپس در ستونهای مق
ــه Z,Y,X  ایسـتگاه اسـتقرار مـی باشـد. در  کنید. قسمتهای North ,East , Pt وheight  به ترتیب شماره نقط
ــدی بـرای نقطـه مـورد  قسمت #Pt شماره ای را به ایستگاه استقرار نسبت می دهیم ودر قسمت Pc می توان ک

نظر (مثلاS1ً ) و در قسمت Comment در صورت نیاز می توان توضیحی به ایستگاه اختصاص داد.  
 

توجه:  
در صورتی که در قسمتهای PC وComments اطلاعاتی وارد نگردد می توان بـا هـر بـار زدن کلیـد Enter از 

ستونهای فوق گذشته تا به خط یا ردیف بعد برسیم. 
 

با توجه به مثال 1 در ردیف دوم همانند ردیف اول مختصات نقطه نشانه روی S2 را وارد مــی کنیـم. در اینجـا 
نیز یک شماره در قسمت #Pt به ایستگاه نشانه روی نسبت داده و در ردیف سوم که به خــط توجیـه معـروف 

ــه بـه ایسـتگاه  اسـتقرار و نقطـه قراولـروی را وارد      بوده  گزینه AT/BS را انتخاب کرده و مشخصات مربوط
می کنیم.در این ردیف در قسمت #AT شماره نقطه ایستگاه استقرار، در قسمت Hz cir زاویـه افقـی  ایسـتگاه 

استقرار به نقطه نشانه روی راوارد کرده که در اغلب موارد صفر صفر می باشد. 
 

ـــم تــایپ کــرده ودر           در قسـمت #BS شـماره نقطـه ایسـتگاه نشـانه روی را کـه در خـط دوم وارد نمـوده ای
ــته مـی شـود. سـپس درردیـف هـای بعـدی بـا اسـتفاده از       قسمت Ht In ارتفاع دوربین در نقطه استقرار نوش

گزینه SD/HT اطلاعات مربوط به نقاط برداشت شده را به صورت زیر وارد می کنیم. 
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توجه: 

 همانطوری که متوجه شده اید در هر ردیف از پنجره بالا گزینه STN بصــورت پیـش فـرض ظـاهر مـی گردد 
برای آنکه در هر ردیف گزینه مورد نیاز خود را بصورت پیش فرض در آوریم به طوری که با ورود به ردیــف 
جدید گزینه مورد نیاز ما ظاهر گردد کافی است که در پنجره بالا از منــوی Options گزینـه  Entry Tpye را 
کلیک کرده و از پنجره ای که باز می گردد گزینه مورد نیاز خود را فعــال کـرده وآنـرا بحـالت پیـش فـرض در 

آوریم. 
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ــل ورود اطلاعـات جـهت محاسـبه مختصـات نقـاط وارد شـده بایسـتی از منـوی Options گزینـه  پس از تکمی
 Catculate Coordinates را فعـال نمـائید و در نـهایت بـرای رویـت نمـــودن مختصــات نقــاط مجــدد از               

ــک نمـائید. در ایـن صـورت همـانند زیـر مـی تـوان  منوی  Options بر روی گزینه Show Coordinates  کلی
مختصات نقاط را مشاهده نمود. در صورت نیاز می توانید پهنای ستونهای حاوی مختصات نقاط را بــه انـدازه 
لازم پهن نمود تا مختصات نقاط بطور کامل دیده شوند. جهت اینکار کافی است در بالای جــدول بـر روی خـط 

جدا کننده ستونها کلیک کرده سپس توسط ماوس عرض ستونها را کم و یا زیاد کرد. 
 

 
 
 

در صورتی که بخواهید مختصات بدست آمــده 
ــل نمـائید  نقاط را به Database  نرم افزار منتق
ـــر روی گزینــه  بایسـتی از منـوی Options ب
Store Data in Database  کلیک کنید. در این 

ــابل گشـوده خواهـد  صورت پنجره ای بفرم مق
شد: 

ــوق در صورتـی کـه بخواهیـد کـل  در پنجره ف
نقـاط را بـه Database منتقـل نمـائید بایســتی 
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گزینه ALL و در صورت انتقال بخشی از نقاط به Databese پس از انتخاب گزینه Point range و وارد کردن 
محدوده شماره نقاط مورد نظربر روی Ok کلیک نمائید.  در نهایت پس از انتقال نقاط به Database می توانیــد 
فرم تاکئومتری ایجاد شده را با کلیک بر روی دکمه                و یا با استفاده از دستور  File>save  در همان 

مسیر اولیه وبا همان نام اولیه ذخیره نمود. 
ویا با استفاده از دستور   File> save as  می توان فایل تاکئومتری ایجاد شده را با نام دیگر و در مسیر دیگر 
ذخیره کرد.  پس از ذخیره فرم تاکئومتری تحت نام مشخص می توان در آینده این فرم را با استفاده از دستور 

File>open  ویا کلیک بر روی دکمه             باز نمود و در صورت نیاز آنرا ویرایش کرد. 

 
توجه1: 

ــر روی  پس ازانتقال نقاط به Database  می توان پنجره مربوط به ورود اطلاعات تاکئومتری را بست تا نقاط ب
صفحه گرافیکی ظاهر شوند. در اینجا جهت رویت نمودن کلیه نقاط می توان ابتدا کلیدZ از صفحــه کلیـد سـپس 

 .(Zoom Extend) را فشرد E کلید
توجه2: 

کاربرد برخی از آیکونهای مربوط به پنجره ورود اطلاعات تاکئومتری به شرح زیر می باشد: 
 

               : کرسر را به انتهای فرم تاکئومتری منتقل می کند. 
    (جایگرین دستور  End Data از منوی GOTO درپنجره تاکئومتری ) 

 
                : کرسر را به ابتدای فرم تاکئومتری منتقل می کند. 

     (جایگرین دستور  Start Data از منوی GOTO درپنجره تاکئومتری ) 
 

                 : فرم تاکئومتری را صفحه به صفحه از انتها به ابتدای فرم ورق می زند. 
 (جایگرین دستور  Page up از منوی GOTO درپنجره تاکئومتری ) 

 
                : فرم تاکئومترى را صفحه به صفحه از ابتدا به انتهاى فرم ورق مى زند. 

        (جایگرین دستور  Page Down از منوی GOTO درپنجره تاکئومتری ) 
 

                : با یک بار  کلیک  بر روی این دکمــه مختصـات آشـکار و بـا کلیـک مجـدد مختصـات نقـاط نـهان         
می گردند.                 (جایگزین دستور   show coordinates  از منوی Optins در پنجره تاکئومتری) 

 
                 : با کلیک کردن بر روی دکمه فوق پنجره ای باز می گردد که با وارد کردن شماره نقطه مورد نظر        

در آن می توان آن نقطه را سریع جستجو کرد.   
(جایگرین دستورGet point از منوی Options  درپنجره تاکئومتری ) 
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ــخصات ایسـتگاه                   : با کلیک کردن بر روی دکمه فوق کرسر یا خط هایلایت به ردیف مربوط به مش
استقرار منتقل می گردد. 

 
               : با استفاده از این دکمه می توان در صورت نیاز به جای یــک کـد دلخـواه کـد دیـگری را جـایگزین 
ــمت  نمود. در این صورت پنجره ای باز می گردد که می توان در قسمت  Enter point code کد اولیه و در قس

 Replace  کد جایگزین را وارد کرده و Ok  نمود.  

(جایگرین دستورReplace code از منوی Options  درپنجره تاکئومتری ) 
 

                : همانند آنچه که قبلاَ گفته شد می توان نقاط را به Database منتقل نمود. 
           (جایگرین دستورStore data in database از منوی Options  درپنجره تاکئومتری ) 

 
توجه1: 

چنانچه اشتباهی در ورود اطلاعات تاکئومتری رخ دهد نگران نباشید زیرا نرم افزار آنرا اعلام خواهد نمود. 
 

توجه2: 
 Calcalate اگر در اطلاعات وارد شده در فــرم تـاکئومتری تغیـیراتی اعمـال گردد بایسـتی مجـدداَ از دسـتور
ــتور  Show coordinate  آنـها را مشـاهده   coordinate مختصات ها را محاسبه نموده و سپس توسط دس

نمود. 
مثال 2: 

مختصات ایستگاه استقرار S1 برابر ( 1000,1000,100 ) می باشد. ارتفاع دستگاه روی ایستگاه S1 برابر 1.5 
متر و از ایستگاه S1 به شمال صفر صفر نموده ( Azimuth = 0° 00′ 00″) و نقاط زیر را برداشت کرده ایم. 
ارتفاع نقاط                       طول افقی        زاویه افقی              شماره نقطه 

           1 40° 23′            99.8 102.52
         2 25° 52′      98.84 100.23
        3 51° 11′ 75.19 100.60

           4         356° 42′ 18.58                           100.31
        5 54° 23′ 101.28 101.60

            6 37° 16′ 56.28 98.30
ــوق سـانتراژ و تـراز  سپس دوربین را به نقطه شماره 5 منتقل کرده و دوربین را با ارتفاع1.65 بر روی نقطه ف
کرده و سپس به نقطه 1 قراولروی کرده و ژیزمان امتداد 5 به 1 را که برابر ′23  °234 خواهــد بـود یادداشـت 

می کنیم ونقاط زیر را از ایستگاه 5  برداشت می کنیم: 
 

          7                             40° 48′                     38.47                            101.15
        8                             84° 29′                     23.47                            101.85
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         9                             156° 27′                   40.70                            102.35
                 10                            166° 48′                   58.25                            103.85

 
حال مطلوبست ورود اطلاعات برداشت شده فوق به درون نرم افزار و محاسبه مختصات نقاط برداشت شده و 

انتقال نقاط به Database نرم افزار.  
 

حل: 
همانند مثال یک این بخش جهت ورود اطلاعات برداشت شده بالا و محاسبه مختصات نقاط بایستی مراحل زیر 

را طی نمود: 
 ( E:\ massahi درشاخه  MA2مثلا جاب ) و ایجاد یک جاب جدید SDRmap V8.01 الف) اجرای نرم افزار

ب) اجرای دستور  Entry> Eletronic stadia  . با اجرای فرمان فوق پنجره ای مشابه زیر گشوده  می گردد: 
در پنجره مقابل ( در مورد ایــن پنجـره 
در مثال 1 صحبت شــد ) همـانند مثـال 
ــک بـر روی دکمـه  یک این بخش با کلی
New فایلی بــا نـامstad 1.ma2  در 

مسیر پیش فرض ایجاد خواهد شد. این 
ــوط بـه  فایل ایجاد شده همان فایل مرب
ــات تـاکئومتری اسـت  فرم ورود اطلاع

که در زیر به نمایش در آمده است: 
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ــوه ورود اطلاعـات در  پس همانند مثال یک این بخش فرم باز شده بالا را بصورت زیر پر نمائید. تنها تفاوت نح
این مثال با مثال یک در اینست که پس از معرفی ایستگاه استقرار در خط اول فرم تاکئومتری بایستی در ردیف 
دوم فرم گزینه At\Bs را انتخاب کرده و سپس در ستون #Bs چون به شمال صفر کرده ایم بایستی عدد صفر 
ــائید.  تایپ گردد. و در سایر ردیف های فرم تاکئومتری از گزینه HD\RL جهت ورود اطلاعات خود استفاده نم
ــه  سایر ستونهای دیگر فرم تاکئومتری با توجه به نیاز پر گردد. در زیر فرم تاکئومتری تکمیل شده مثال فوق ب

نمایش در آمده است: 
 

 
 

پـس از تکمیـل ورود اطلاعـات جـهت محاسـبه مختصـات نقـاط داده شـده بایسـتی از منـوی options گزینـــه 
 Calculate coordinates را فعال کرده تا مختصات نقاط بصورت زیر به نمایش درآیند: 
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ــال  حال برای انتقال نقاط مختصات دار به Databese از منوی options گزینه Store data in dalabase را فع
ــاط را  کرده و پس از انتخاب نقاط همانند آنچه که در مثال یک این بخش گفته شد با کلیک بر روی دکمه OK نق
به Database منتقل نمائید. پــس از انتقـال نقـاط بـه Database مـی تـوان پنجـره مربـوط بـه ورود اطلاعـات 
تاکئومتری را minimize کرده و یا بست تا نقاط بر روی صفحه گرافیکی ظاهر شوند. جهت مشاهده کلیه نقاط 

بــــر روی صفحــــــه 
گرافیکی ابتدا کلیـد Z و 
ــــد E را از  ســپس کلی
صفحه کلید فشــرده تـا 
ـــاط بصــورت  کلیـه نق
روبرو بر روی صفحـه 
گرافیکــی نــرم افـــزار 

مشاهده شوند. 
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7-3 ورود اطلاعات یک فایل اتوکد به داخل نرم افزار 
ــن اسـت همـه آنـها مـورد نیـاز  معمولا مهندسین در طراحی خود اجزای بسیار زیادی را قرار می دهند که ممک
ــرای برنامـه SDRmap اجـزای زائـد را حـذف  نباشد . پس بهتر است درهنگام ذخیره طرح بصورت یک فایل ب
کرده تا حجم فایل خروجی کم شود. لایه های غیر ضروری را به طور کامل حذف کنید . به خاطر داشته باشید 
در صورتیکه می خواهید فایلی را برای برنامه SDRmap ذخیره کنید آن را بصورت DWG ذخیره کرده زیرا 
ــته،  این فایل حجم کمتری دارد. این نرم افزار قادر است یک فایل اتوکد را دریافت کرده و کلیه نقاط، کمان، نوش

خطوط و…. را به محیط خود وارد نماید. 
 

برای این منظور ابتدا یک جاب خالی ایجاد نموده سپس از منــوی File گزینـه Import DWG\DXF  را فعـال 
کرده تا پنجره ای بفرم زیر گشوده شود:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

در این پنجره  فایل مورد نظر خود را پیدا کرده سپس توسط دکمــه Open آن را بـاز کنیـد.. بـرای مثـال فـایل 
LOTDWG.DWG را از شاخه Program files\SDRmapping & design\Examples\ انتخاب کرده و بر 

روی آن کار کنید. در اینصورت پنجره دیگری بصورت زیر گشوده خواهد شد: 
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قبل از ورود فایل اتوکد بــه درون نـرم  افـزار بایسـتی بدانیـم کـه در فـایل اتوکـد چـه اطلاعـاتی وجـود دارد. 
ــط گزینـه Convert lines ودر صـورت  درصورت وجود نقطه گرینه Convert points ودر صورت وجود خ
وجود کمان گرینه  Convert arcs و…. را از پنجره بالا انتخاب کرده  ســپس درقسـمت Start point شـماره 

ـــرای نقــاط جدیــد ، در  شـروع ب
ـــامی  قســمت String folder  ن
ـــد ودر  بـرای پوشـه خطـوط جدی
قسمت #String  شماره ای بــرای 
ـــوط  شــروع شــماره گذاری خط

جدید تایپ می کنیم.  
 
 
 
 

 Read ـــر روی دکمــه بـا کلیـک ب
پنجـره ای همـانند مقـابل گشــوده 

خواهد شد: 
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در این پنجره اسامی لایه ها  در قسمت Layer name و نوع خطوط بکار گرفته شده در فایل اتوکــد در قسـمت 
ــمت Layername لایـه  Linetype به نمایش در خواهد آمد. همانطور که در پنجره بالا مشاهده می کنید در قس

ــا Freeze وارد نـرم افـزار  Road  قفل دار می باشد. در چنین موقعی موارد قرار گرفته در لایه های خاموش ی

نخواهند شد. اگر به چنین فایلی برخورد کردید باید وارد برنامه اتوکد شده ولایه قفل شده را باز کنید و مجــددا 
 SDRmap اطلاعات از فایل اتوکد بــه درون نـرم افـزار Save فایل را فراخوانید. در انتها با کلیک بر روی دکمه

منتقل خواهند شد. برای دیدن اطلاعات انتقال یافته ابتدا دکمه Z وسپس دکمه E را فشار دهید. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

توجه1: 
پس از انتقال فایل اتوکد به درون نرم افزار در دو سر خطوط و کمانها و مراکز کمانــها و دوایـر هـر کـدام یـک 

نقطه ایجاد خواهد شد.  
 

توجه2: 
ــک کپـی  در صورت احضار یک فایل اتوکد به نرم افزار حتما از کل اطلاعات موجود در نرم افزار SDRmap  ی

پشتیبان تهیه کنید زیرا این عمل برگشت پذیر نبوده وممکن است منجر به از دست رفتن اطلاعات شود. 
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8-3 ورود اطلاعات از فیلد بوک (Data collector ) به داخل نرم افزار 
فیلدبوکها (دفترچه های الکترونیکی صحرائی) وسایلی هستند که به عنوان حافظه خارجی برای ثبت و محاســبه 
اطلاعات بکار برده می شوند. فیلدبوک را می توان یک کاغذ بزرگی تصور نمود که بر روی آنها 2000 تا 5000 
نقطه را می توان ثبت وسپس محاسبات مربوط به این نقاط را با آن انجام داد. تمام مشاهدات صحرائی توســط 
فیلدبوک بایستی درون یک جاب ذخیره شوند. سپس توسط یک کابل ارتباطی اطلاعــات از درون جـاب بـه یـک 

فایل خروجی  منتقل خواهند شد و پس از پردازش بر روی آنها به نرم افزار SDRmap انتقال می یابند. 
 برای دریافت اطلاعات از فیلدبوک ابتدا یک جاب خالی ایجاد کرده وسپس مسیر زیر را دنبال کنید: 

 Entry>Data collrctors > Collect raw data
 پنجره ای بصورت زیر باز خواهد شد: 

 

 
در پنجره فوق ابتدا بایستی ارتباط بین فیلدبوک و نرم افزار را برقرار سازیم. لذا بایستی از پنجره بالا از منوی 

 Setting  گزینه   Comminucation in را انتخاب کرده تا پنجره دیگری بصورت زیر گشوده گردد: 
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در این پنجره بایستی تنظیمات فیلدبوک را مطابق دفترچه راهنمای آن انجــام داده در غـیر اینصـورت قـادر بـه 
برقـراری ارتبـاط بـا فیلدبـوک نخواهیـم بـود. مثـلا در قســمت Baud rate ســرعت انتقــال اطلاعــات و در 
ــام کلیـه تنظیمـات بـر روی دکمـه OK کلیـک  قسمت   Connector درگاه مناسب را انتخاب کرده و بعد از انج

نمائید. سپس از منوی Transfer  گزینه Data to computer را انتخاب نمائید.  
 البته قبل از این مرحله بایستی فیلدبوک را به کامپیوتر متصل کرده و آن را روشن نمود. در این مرحله دستور 
مربوط به ارسال اطلاعات را (Send) در فیلدبوک فعال کنید . لذا اطلاعات به کامپیوتر ارسال وخط به خط روی 
ــات کلیـد Esc را زده واز پنجـره بـالا از منـوی File گزینـه  صفحه ظاهر خواهند شد. پس از پایان انتقال اطلاع
Save as  را انتخاب و اطلاعات دریافتی را در یک فایل ذخیره نمائید. این فایل حــاوی اطلاعـات خـام بـوده کـه 

بایستی پردازش شده سپس وارد Database  نرم افزار شوند. 
 

 به این منظور از پنجره دریافت اطلاعات خارج شده و مسیر زیر را دنبال می کنیم: 
 Entry > Data collector > Import raw data

پنجره ای بصورت زیر باز خواهد شد: 
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ــتگاه و در سـمت راسـت در صـورت موجـود بـودن فرمـت  در پنجره فوق در قسمت بالا و سمت چپ نوع دس
ــات خـام را در قسـمت Raw Data File انتخـاب و در قسـمت  اطلاعات را انتخاب کرده ودر انتها  فایل اطلاع
Survey Number عددی را  (توصیه می شود این عدد را به خــاطر بسـپارید زیـرا در مرحلـه بعـد آنـرا نیـاز 

دارید.)  به فایل تاکئومتری ایجاد شده نسبت دهید . سپس بــروی دکمـه OK کلیـک تـا اطلاعـات از فـایل خـام 
ــگران نشـوید  استخراج و بصورت تاکئومتری ذخیره شوند. اگر بر روی صفحه نمایش چیزی مشاهده نکردید ن
ــاید ایـن نقـاط مختصـات دار شـوند تـا بتـوان آنـرا مشـاهده نمـود. حـال از منـوی  Entry گزینـه  زیرا ابتدا ب
-Electronic Stadia را انتخاب و پس از تعیین شماره فرم تاکئومتری در قسمت Survey Number  بـر روی 

دکمه  Open Existing  کلیک کرده و فایل مورد نظر را انتخاب تــا پنجـره تـایپ اطلاعـات تـاکئومتری کـه در 
بخشهای قبل در مورد آن صحبت شد باز گردد. پس از بررسی اطلاعات ظاهر شده ودر صورت لزوم ویرایش 
ــده بـه دیتـابیس اقدامـات لازم را  آنها ، نسبت به محاسبه و مشاهده مختصات وبالاخره انتقال نقاط محاسبه ش

انجام دهید.  
  

9-3    ارسال اطلاعات از نرم افزار به فیلدبوک  
ــرده تـا  جهت ارسال اطلاعات از نرم افزار به فیلدبوک از منوی  Entry گزینه Export Raw Data را انتخاب ک

پنجره ای بصورت زیر گشوده گردد: 
 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01 نرم افزار
 

48
 

 
 Raw Data File ودر قسمت job نام پروژه را در قسمت Data type در پنجره بالا نوع اطلاعات را در قسمت
نام و مسیر فایل خروجی را انتخاب کرده و OK نمائید. تا این مرحله اطلاعات موجــود در جـاب بصـورت یـک 
فایل اطلاعات خام در آمده که بایستی این فایل ایجاد شده را به فیلدبوک انتقال داد. به این منظور مسیر زیــر را 

دنبال نمائید: 
 Entry > Data collector > Send  Raw Data to Datacollector

لذا پنجره ای به شکل زیر باز خواهد شد: 
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در پنجره بالا ابتدا از منوی File گزینه  Open را فعال وسپی فایلی را که در بالا ساخته شده بود را انتخــاب و 
 Comminucation گزینـه Setting نموده تا اطلاعات موجود در فایل روی صفحه ظاهر شوند. از منــوی OK

ــات را در  out را انتخاب و پارامترهای ارتباطی را تعیین کنید. حال مراحل و دستورات لازم برای دریافت اطلاع

ــره بـالا گزینـه  Data to Datacollector را جـهت ارسـال  فیلدبوک اجرا کرده و از منوی  Transfer از پنج
اطلاعات به فیلدبوک انتخاب کنید. 
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در این فصل قبــل از پرداختـن بـه روش هـای مختلـف ایجـاد وانتخـاب نقـاط موجـود در دیتـابیس نـرم افـزار 
ــروژه ، لایـه بنـدی  SDRmap واعمال برخی تغییرات بر روی نقاط انتخاب شده به چگونگی نمایش اجزاء یک پ

اجزاء یک پروژه ، مدیریت لایه هاوکاربرد کلیدهای تابعی در این نرم افزار خواهیم پرداخت . 
 

1-4     چگونگی نمایش اجزاء یک پروژه   
در این بخش خواهیم آموخت که چه  اجزائی در یک پروژه به نمایش در آمده و چه اجزائی نمایان نباشند. مثــلا  
 ( X,Y) ــاط بصـورت می توان مشخص نمود که منحنی میزانها به نمایش در آیند یا خیر و یا اینکه مختصات نق

 . (Y,X ) به نمایش در آیند یا بصورت
در هر حال جهت نیل به این هدف می توان بر روی آیکون                از نوار بالای نرم افزار کلیک نموده و یــا 
اینکه از صفحه کلید دکمه F9 را فشار داد. در اینصورت پنجره ای مشابه زیر جــهت تعییـن پارامترهـا و نحـوه 

نمایش اطلاعات، ظاهر خواهد شد: 
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ــت کـه از پنجـره بـالا  ابتـدا گزینـه  بعنوان مثال اگر بخواهید شماره نقاط در کنار نقاط نشان داده شوند کافیس
Modes را انتخاب و سپس گزینه Point numbers را به حالت روشن در آورده و OK نمــائیم. در اینصـورت 

مشاهده خواهید نمود که شماره  هر نقطه در کنار آن درج خواهد شد: 
 

 
توجه داشته باشید در صورتی که بخواهید نقاط بر روی صفحه ظاهر نشوند بایستی پس از فعال نمودن حالت 

ــاب نمـود . در اینصـورت نقـاط از صفحـه گرافیکـی      Modes از پنجره بالا گزینه Points را در حالت Off انتخ

نرم افزار محو خواهند شد. 
 

توجه1: 
در پنجره بالا دو گزینه Modes وLayer  دیده می شوند. که حالت پیش فرض Layer می باشد. تفــاوت حـالت 
ــم تفکیـک  Layer با Modes در این است که برای جلوگیری از شلوغی نقشه  می توان عوارض مختلف را از ه

نموده و در لایه های متفاوتی آنها را ذخیره نمود( در مورد چگونگی ایجاد لایــه صحبـت خواهـد شـد). سـپس          
ــگ آنـها را تغیـیر دهیـد. سـپس در ایـن  می توانید بنا به نیاز لایه ها را روشن و یا خاموش نموده و یا اینکه رن
حالت می توانید در پنجره بالا گزینه Layer را انتخاب نموده تا بتوان اجزاء خود را با توجه به لایه های تعریف 
ــاربران مبتـدی ) کـه اجـزاء بطـور  شده روشن یا خاموش کرد. اما بعضی اوقات اتفاق می اقتد ( معمولا برای ک
منظم در لایه های مشخص قرار نگرفته اند و شما می خواهید که شماره نقاط، ارتفاع نقاط و… را روشن و یــا 
خاموش نمائید. لذا در اینگونه موارد بایستی ابتدا گزینه  Modes را انتخاب کرده و  سپس اجزاء مــورد نظـر را 
کنترل نمود. توجه داشته باشید که در حالت Modes نمی توان بطور همزمان دو یا چند مشخصه ( مثلا شماره 
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ــی کـه از حـالت  Layer اسـتفاده  کـرده باشـیم       نقاط، ارتفاع نقاط و کد نقاط) را مشاهده نمود ولی در صورت
می توان هر مشخصه را در لایه های جداگانه قرار داده و سپس بنا به نیاز لایه ها را روشن یا خاموش کرده و 

یا اینکه رنگ آنها را تغییر داد. 
 

2-4     لایه بندی اجزاء یک پروژه   
لایه بندی اجزاء یک پروژه یا در حین ترسیم اجزاء و یا پس از انتخاب اجزاء ترسیم شده امکان پذیر می باشــد. 

ـــتفاده از دســتور          مثـلا اگر بخواهیـم یـک نقطـه ایجـاد کـرده و آنـرا در لایـه P1 قـرار دهیـم کافیسـت بـا اس
Points> Add points  بر روی نقطه ای از صفحه گرافیکی کلیک کرده تا پنجره مربوط به ایجاد نقطه باز شده 

و پس از وارد کردن شماره نقطه و مختصات نقطه در قسمتهای  Height, Northing , Easting , Point نـام 
ــی یـابیم کـه در  لایه مورد نظر را ( مثلا P1 ) در قسمت Layer وارد کرده و Ok می کنیم. به این صورت در م

حین ورود اطلاعات می توان لایه ای برای آن در نظر گرفت.  

 
راه دوم این است که چگونه پس از اینکه اطلاعات را وارد کردیم آنها را لایه بندی کنیم. در اینجا نیز فرض کنید 
که تعدادی نقطه وارد جاب نموده ایم. حال می خواهیم تعدادی از آنها راوارد یک لایــه بنـام P2 نمـائیم. در ایـن 
صورت کافیست با استفاده از دستور Points> select نقاط مورد نظر را به روش های متفاوتی که در بحثهای 
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بعدی در این مورد صحبت خواهد شد  انتخاب کرده و پس از کلیک نمودن دکمه سمت راست ماوس پنجــره ای 
را به صورت زیر نمایان کنیم: 

 

 
ــام لایـه مـورد نظـر  در پنجره بالا با انتخاب گزینه Alter در پنجره ای که بصورت زیر باز می شود می توان ن
مثلا P2 را در قسمت Layer وارد کرده و سپس OK نمائید. در این صورت اجزاء انتخاب شده یک پــروژه بـه 

لایه مورد نظر انتقال خواهند یافت. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01   نرم افزار
 

57  

توجه: 
در مورد چگونگی ایجاد نقاط و یا خطوط و …. و همچنین در مورد چگونگی انتخاب اجزاء در بخشــهای بعـدی 

مفصلا صحبت خواهد شد. 
 

3-4     مدیریت لایه ها 
پس از لایه بندی نمودن اجزاء یک پروژه می توان به دو راه لایه های مورد نیاز را خاموش و یا روشن نمود: 

الف) کلیک بر روی آیکون                                                    و یا زدن دکمه F10 از صفحه کلید 
 

  Layers از صفحه کلید و سپس انتخاب منوی F9 ب) کلیک بر روی آیکون                  و یا زدن دکمه
 

در هر دو راه پنجره ای به صورت زیر نمایان می گردد: 

 
ــه بنـام صفـر  همانطوری که ملاحظه می فرمائید در صورتی که لایه بندی انجام نشده باشد کل جاب در یک لای
ــد. در  قرار می گیرد ولی در صورت لایه بندی جاب ،لایه های ایجاد شده در پنجره بالا به نمایش در خواهند آم

پنجره بالا شش ستون زیر به چشم می خورند: 
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ــار مـی رود. در صورتـی کـه بخواهیـم یـک لایـه   - Display :   جهت روشن و یا خاموش کردن لایه ها بک

دلخواه را خاموش نمائیم ابتدا با ماوس روی لایه دلخواه رفته و آنرا هایلایت نموده و ســپس در قسـمت پـائین 
ــارت off در قسـمت جلـوی نـام لایـه ظـاهر     ستون Display بر روی دکمه off کلیک نمائید. در این صورت عب

ــه OK کلیـک نمـائید. دکمـه on بـرای روشـن  می شود. در نهایت برای تثبیت تغییرات اعمال شده بر روی دکم
ــرای  کردن لایه بکار می رود. برای اینکه بخواهیم به یکباره کل لایه ها را روشن کنیم بر روی دکمه All on و ب

خاموش کردن کلیه لایه ها بر روی دکمه None on کلیک کنید. 
 

توجه:  
ــارگیـری مـاوس یـا کلیدهـای جـهت نمـای صفحـه کلیـد        می توان با فشار دادن کلید Shift از صفحه کلید و بک

لایه های مورد نظر را هایلایت نموده و سپس عملیات مربوطه را بر روی لایــه هـا بـه یکبـاره انجـام داده و در 
نهایت با زدن دکمه OK نتیجه کار را مشاهده نمود. 

 
 -  Colour :    در این ستون می توان رنگ لایه های انتخاب شده را مشخص نمود. در اینجــا نـیز کافیسـت 

پس از هایلایت نمودن لایه یا لایه ها ی دلخواه بــا کلیـک بـر روی فلـش زیـر سـتون Colour رنـگ دلخـواه را 
انتخاب نمود. توجه داشته باشید که شماره رنگ ها مطابق شماره رنگ ها در اتوکد می باشند. 

 
ــاط و..  )   -  Attribute:    در این ستون می توان مشخصه خاصی ( از قبیل شماره نقاط، ارتفاع نقاط، کد نق

ــا  را برای عوارض موجود در لایه یا لایه های هایلایت شده انتخاب نمود. برای این کار نیز  کافیست ابتدا لایه ی
ــتون Attribute مشـخصه دلخـواه را  لایه های دلخواه را انتخاب نموده و سپس با کلیک بر روی فلش پائین س
 Code ،معـرف ارتفـاع Hgt ،ــماره نقطـه برای لایه یا لایه های مورد نظر انتخاب کرد. در اینجا Pt no معرف ش
معرف کد، Desc معرف توضیح، Rd no معرف شماره مسیر،  Chain معرف کیلومتراژو Offs معرف فاصلــه 

چپ و راست از محور مرکزی مسیرمی باشند. 
 
 

ــود.   - Locked :    در این ستون می توان حالت قفل و فعال بودن لایه یا لایه های انتخاب  شده را کنترل نم

ــایلایت شـده قفـل بـوده لـذا تغیـیراتی بـر روی لایـه هـای فـوق صـورت          در حالت Locked لایه یا لایه های ه
نمی پذیرد. در حالت Active لایه ها فعال می باشند. لذا در صورت تمایل می توان بر روی آنها تغییراتی اعمال 

نمود. 
 

 - Plot :    در این ستون می توان قابل چاپ بودن یا نبودن لایه ها را کنترل نمود. دکمه yes در زیر ســتون 

 plotبه معنای قابل چاپ بودن لایه هایلایت شده می باشد. با دکمه All on می توان همه لایه ها را بــه یکبـاره 

قابل چاپ کرده و با استفاده از دکمه None on می توان همه لایه ها را از قابل چاپ بودن خارج کرد. 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01   نرم افزار
 

59  

ــی باشـد را انتخـاب   - Mark :    در این ستون می توان علامت خاصی را که معرف محل قرارگیری نقاط م

نمود. در اینجا می توان از علامت  +,0,.,00 بهره جست. که حالت متد اول در ایران علامت . می باشد. 
 

4-4    کاربرد کلیدهای تابعی  
ــون کلیدهـای تـابعی ( F1……..F12 ) محـدود مـی باشـند لـذا بـه مـهم تریـن و پـر     توجه داشته باشید که چ

استفاده ترین توابع خاص در این نرم افزار اختصاص داده شده اند. 
 در زیر کاربرد کلیدهای توابع به اختصار آمده است: 

 F1..………………………………………  خاموش یا روشن نمودن راهنما
 F2………………………………… … خاموش یا روشن نمودن رشته نقاط

  F4...…………………………………  خاموش یا روشن نمودن نام رشته ها
  F5.………………………………… …خاموش یا روشن نمودن ارتفاع نقاط
 F6 ………………………………… ……خاموش یا روشن نمودن کد نقاط
 F7.…………………………………  خاموش یا روشن نمودن منحنی میزان
 F8………………………………… … خاموش یا روشن نمودن مثلث بندیها
 F9 ………………………. .Modes screen  خاموش یا روشن نمودن صفحه
 F10……………………………… خاموش یا روشن نمودن صفحه لایه بندی
 F11 ……………………………………………انتخاب علامت معرف نقطه

 
5-4      ایجاد نقطه با استفاده از مختصات  

برای اضافه کردن نقاط جدید به database نرم افزار کافیست که دستور زیر را اجراء کنید: 
 Points> Add points
با اجرای دستور بالا ملاحظه خواهید کرد که نشانگر ماوس به شکل یک +  در می آیــد. در ایـن حـال بـر روی  

نقطه ای ازصفحه گرافیکی کلیک نمائید. در این صورت پنجره ای مشابه زیر باز می گردد: 
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               Y مختــص ، ( Easting ) X مختـص ، ( point number ) در پنجـره بـاز شـده مـی توانیـد شـماره نقطـه
ــه ای  ( northing ) ، مختص  Z (Height) ، کد نقطه ( code ) ، توضیح نقطه ( Description )  و حتی نام لای

ــی تـوان شـماره مسـیر  ( Layer ) را که نقطه بایستی در آن قرار گرفته باشد را وارد کنید. در سایر قسمتها م

(Road Number) کیلومتراژ(Chainage) و فاصله از محور( Offset) مربوط به نقطه ایجــاد شـده را نـیزوارد 
کرد.  پس از ورود اطلاعات لازم پنجره بالا را Ok نمائید. برای ایجاد نقاط دیگر مجددا بــه همیـن ترتیـب عمـل 

نمائید. 
 

توجه: 
اگر نقطه یا نقاط ایجاد شده بر روی صفحه دیده نشدند دکمه D را فشار دهید و صفحــه را بازسـازی کنیـد تـا 
نقطه یا نقاط مشاهده گردند. اگردقت کنید گزینه Add points در منوی Points تیک دار بوده و علامت مــاوس 
بشکل یک مربع درآمده است در اینحال با کلیک بر روی هر نقطه از صفحه گرافیکــی پنجـره مربـوط بـه ایجـاد 
نقطه باز می شود. اگر بخواهیم این حالت را غیر فعال نمائیم یا دکمه Esc از صفحه کلید را فشار داده  یا دکمه 
سمت راست ماوس را زده و گزینه  Cancel را اجراء کرده و یا اینکه مجــدد از منـوی Points بـر روی گزینـه 

Add Points کلیک کرده و آنرا از حالت تیک خارج نمائید. 

 
6-4    ایجاد نقاط با استفاده از طول و ژیزمان 

مطابق شکل با معلوم بودن زاویه ∝ و فاصله d از نقطه O   می تــوان نقطـه M را بدسـت آورد. جـهت اینکـار 
کافیست بر روی آیکون                      از نوار بالای نرم افزار کلیک کــرده و یـا اینکـه از منـوی Cogo گزینـه 

Bearing & Distance را انتخاب نمائید. پنجره ای بصورت زیر باز   خواهد شد: 
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در قسـمت From points شـماره نقطـه مبنـاء ( ایسـتگاه ) را وارد کنیـد. شـماره نقطـه را از صفحـه کلیـد در 
قسمتfrom point وارد کرده و یا با ماوس بر روی نقطه مورد نظــر کلیـک نمـائید در ایـن صـورت بـه طـور 
خودکار شماره نقطه در قسمت from point وارد می شود. در قسمت Bearing زاویه ( در اینجا مبنــای زاویـا 
ــان امتدادهـا مـی باشـد ) و در  نسبت به شمال سنجیده می شوند به عبارت دیگر زوایای وارد شده همان ژیزم
قسمت  Distance مقدار طول را وارد کنید. پس از ورود طول و زاویه نرم افزار شماره نقطه جدید ایجاد شــده 
را در قسمت New point نشان می دهد. در صورت لزوم می توانید آنرا تغییر دهید در غــیر اینصـورت دکمـه 

Apply را کلیک کنید. 

 
توجه 1:  

جهت وارد کردن مقدار زوایا بطور مثال زاویه ″44 ′23 °213 کافیست که عدد 213.2344 را وارد کنید. 
 

توجه2: 
  اگر بخواهید مثلا 3 نقطه به فواصل وارد شده  در قسمت Distance ( مثلا 50 متر ) در یک امتداد ( 45 درجه ) 
ــه مبنـاء را  ایجاد نمائید کافیست پس از انتخاب گزینه Bearing & Distance از منوی  Cogo ابتدا شماره نقط
ــدد 50 در قسـمت Distance و وارد کـردن  وارد کرده و سپس از وارد کردن عدد 45 در قسمت Bearing و ع
عدد 3 در قسمت Multiple و کلیک بر روی دکمه Apply ملاحظه خواهید کرد که سه نقطــه در یـک امتـداد بـا 
فواصل مشخص ایجاد می گردند. این روش در شبکه بندی و یا مثلا وارد کردن تیرهای چراغ برق و یــا آکـس 

ستونها کاربرد دارد.  
 

 1-6-4       نکات مهم و کاربردی 
ــدار  1-  هنگامی که پنجره Bear&Dist باز می باشد و مکان نما در قسمت Bearing قرار دارد اگر بخواهیم مق
ــدار90  90 درجه به عدد موجود در این قسمت اضافه گردد بایستی دکمه R را از صفحه کلید و اگر بخواهیم مق

درجه از عدد موجود در این قسمت کسر گردد بایستی دکمه L را از صفحه کلید زد. 
 

2-  زمانی که مکان نما در قسمت Bearing قرار گرفته باشد با زدن دکمه P از صفحه کلید و انتخاب دو نقطــه 
ــان امتـداد بیـن دو نقطـه را محاسـبه کـرده و در ایـن محـل نشـان         از دیتابیس به کمک ماوس ، نرم افزار ژیزم

می دهد. 
 

ــه کلیـد مـی تـوان امتـداد  3- زمانی که مکان نما در قسمت Bearing قرار گرفته باشد با زدن دکمه D از صفح
ــاء دکمـه  مورد نظر را با ترسیم خطی در صفحه مشخص نمود. برای اینکار پس از وارد کردن شماره نقطه مبن
ماوس را پائین نگه داشته و در همین حال آنرا به محل مورد نظر منتقل نمائید تا زاویه خط فرضی رســم شـده 
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در این محل وارد گردد. 
 

ــوان مجمـوع و تفـاضل دو زاویـه را در قسـمت Bearing وارد کـرد. بطـور مثـال بـا نوشـتن عبـارت  4- می ت
 50.35+110.13 و زدن کلید  Enter عدد 160.48 بطو خودکار ظاهر خواهد شد. 

 
5- اگر در پنجره Bear&Dist مکان نما در قسمت Distance قرار گرفته باشد با زدن دکمه P از صفحه کلید و 
انتخاب دو نقطه از دیتابیس به کمک ماوس، نرم افزار فاصله بین دونقطه را محاسبه کرده و در این محل نشـان 

می دهد.  
 

6- اگر در پنجره Bear&Dist مکان نما در قسمت Distance قرار گرفته باشد با زدن دکمه D از صفحه کلیــد 
می توان طول مورد نظر را با ترسیم خطی در صفحه مشخص نمود. برای اینکار کافیست دکمه ماوس را پائین 
نگه داشته و در همین حال آنرا به محل مورد نظر منتقل نمائید تا طول خط فرضی رسم شده در این محل وارد 

گردد. 
 

7- اگر در پنجره Bear&nist قسمتی بنام AZ ( آزیموت ) وجود دارد. این قسمت بطور پیش فرض برابر صفر 
می باشد. مقدار وارد شده در این قسمت به زوایای وارد شده در قسمت Bearing در هنگام ایجاد نقطه افـزوده 

خواهد شد. 
 

7-4  ایجاد نقاط با استفاده از طول و زاویه به طور شعاعی یا متوالی 
جهت ایجاد نقاطی در Database نرم افزار با استفاده از طول و زاویــه کافیسـت یـا بـر روی آیکـون           از 

نوار بالای نرم افزار کلیک نموده ویا دستور زیر را اجراء نمائید: 
 Cogo> Angle&Distance

با اجرای دستور بالا پنجره زیر باز خواهد شد: 
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در پنجره بالا اگر بخواهیم نقاط بصورت پی در پی ایجاد گردند گزینه Traverse و اگر بخواهیم نقاط بصــورت 
شعاعی ایجاد گردند گزینه  Radiate را انتخاب کنید. در قسمت Back sight point شماره نقطه قرائت عقب را 
با استفاده  از صفحه کلید یا ماوس وارد کنید. در قسمت From point شـماره نقطـه شـروع ( مبنـاء ) را وارد 
کرده و پس از وارد کردن مقادیر طول و زاویه در قسمت  Distance و Angle  می توان شــماره نقـاط جدیـد 
 Apply مشاهده نمود و در صورت لزوم آن را با کلیــک بـر روی دکمـه New point بدست آمده را در قسمت

ثبت کرد.  
 

8-4     یافتن یک نقطه خاص 
جهت مشاهده مشخصات یک نقطه خاص و یا ویرایش آن می توان بر روی آیکــون                 از نـوار بـالای 

ــاز   نرم افزار کلیک کرده و یا اینکه دکمه    ? را از صفحه کلید فشار داد. در این صورت پنجره ای مشابه زیر ب
می گردد: 

 
ــماره نقطـه مـورد نظـر در  در پنجره فوق می توان با وارد کردن ش
ــخصات  قسمت Point number و یا کلیک بر روی نقطه دلخواه مش
آن را مشاهده نمود. با وارد کردن شــماره نقطـه یـا کلیـک بـر روی 
نقطه دلخواه یک خط فرضی از گوشــه پـائین و سـمت چـپ صفحـه 
گرافیکی به نقطه مورد نظر ترسیم می گردد. در پنجره بالا با هر بار 

کلیک بر روی دکمه  Previous یـا Next  نقـاط قبـل و یـا بعـدی را  
ــس از مشـخص نمـودن نقطـه مـورد نظـر          می توان مشاهده نمود. پ

ــه مشـخصات نقطـه را عـوض کنیـد.  می توانید در قسمتهای مربوط
ــابل تغیـیر نمـی باشـد. پـس از  توجه داشته باشید که شماره نقطه ق
تغییر مشخصات نقطه بر روی دکمه OK  کلیک کنید. با زدن دکمــه 
OK پیغامی مبنی بر ذخیره تغییرات اعمال شده ظاهر خواهد شد.در 

صورت نیاز به ذخیره تغییرات اعمال شده بر روی دکمه Yes و در 
غیر این صورت بر روی دکمه No کلیک نمائید. 

 
 

9-4    مشاهده آزیموت، طول و شیب بین دو نقطه 
ــزار  SDRmap نسـخه 6.50 و قبـل از آن عمـل  Inverse مـی گوینـد. در ایـن نسـخه          این عمل را در نرم اف

 J برای مشاهده آزیموت، طول و شیب بین دو نقطه کافیست از صفحه کلید بر روی دکمـه SDRmap نرم افزار
به معنای Join ( متصل کردن ) استفاده نمود. در این صورت پنجره ای مشابه زیر گشوده خواهد شد: 
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در پنجره بالا می توان با وارد کردن شماره نقاط یا کلیک کردن بر روی نقاط مورد نظر، شــماره نقـاط ابتـدا و 
 ، Bear وارد کرد. در این صورت آزیموت امتداد در قسمت point2 , point1  انتهای یک امتداد را در قسمتهای
طول بین دو نقطه در قسمت Dist و شیب بین دو نقطه در قسمت Grade به نمایش در خواهند آمد. در صورتی 
که با استفاده از صفحه کلید شماره نقاط را وارد کرده باشید برای دیدن مشــخصات بیـن دو نقطـه وارد شـده 
بایستی بر روی دکمه Calculate کلیک نمائید. اما اگر با استفاده از ماوس بخواهید مشخصات بین دو نقطــه را 
مشاهده کنید پس از کلیک بر روی دو نقطه مورد نظر مشخصات بین دو نقطه در قسمتهای مربوطه نشان داده 
ــه  خواهد شد. در صورتی که در قسمت  Grade عبارت Vertical نمایش داده شود به معنای اینست که دو نقط

ــچ گونـه اختـلاف ارتفـاعی ندارنـد. اگر از پنجـره بـالا منـوی Arc انتخـاب گردد         در یک سطح قرار داشته و هی
ــهت اینکـار پـس از انتخـاب منـوی Arc پنجـره ای بصـورت زیـر بـاز         می توان طول قوس را مشاهده نمود. ج

می گردد: 
 

در ایـن پنجـره در قسـمت point1 نقطـه شـروع قـوس و در قســـمت 
 point2 نقطه انتهائی را وارد کرده سپس در قســمت Center شـماره 

ــاوس وارد  نقطـه مرکـز قـوس را بـا اسـتفاده از صفحـه کلیـد و یـا م
کنید.توجه داشته باشید که شماره نقطه مرکز قوس را بایستی + و یــا 
ــه قـوس از نقطـه شـروع در جـهت  – معرفی نمود. علامت + یعنی اینک
عقربه ساعت به نقطه انتهائی برســدو علامـت – یعنـی اینکـه قـوس از 
نقطه شروع در جهت خلاف عقربه های ساعت به نقطه انتهائی برسد.  

 
 

در پنجره بالا اگر منوی Angle را انتخاب نمائید پنجره ای به صورت زیر باز   می گردد: 
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در اینجا می توان در قسمتهای point1وpoint2 وPoint3  دو امتداد متوالی را معرفی کرد.سپس در قسـمتهای 

Angle 1 زاویه داخلی بین دو امتداد و در قسمت Angle2 زاویه خارجی بین دو امتداد را مشاهده نمود. 

 
10-4    استفاده از چندین پنجره به صورت همزمان در یک پروژه 

ــن منظـور  در بعضی مواقع نیاز است که یک پروژه را از نماهای خاصی بطور همزمان مشاهده  نمائیم. برای ای
از منوی window گزینه New  window را انتخاب کنید. حال می توانید قسمت خاصی از یک پروژه را در هر 

پنجره مشاهده نمائید. توجه داشته باشید تغییر در لایــه و یـا نقـاط و یـا خطـوط و … در پنجـره فعـال اعمـال      
ــاظ گردنـد بایسـتی نقشـه بازسـازی گردد.  می گردد. برای اینکه تغییرات اعمال شده در سایر پنجره ها نیز لح

جهت بازسازی نقشه کافیست دکمه  D را از صفحه کلید فشار دهید. 
برای فعال کردن پنجره خاص می توان از منوی window پنجره خاصی را که با شماره های .…,1,2,3 نشان 
ــال کـرد.  داده شده اند را انتخاب کرده و یا اینکه با ماوس بر روی پنجره خاص دلخواه کلیک نموده تا آن را فع
همانطوری که ملاحظه می کنید قسمت بالای پنجره فعال به رنگ آبی درآمده و سایر پنجره های غــیر فعـال بـه 
ــم قـرار خواهنـد گرفـت لـذا  رنگ خاکستری می باشند. توجه داشته باشید که پنجره های ایجاد شده بر روی ه

حالتهای مختلفی برای چگونگی نمایش پنجره ها وجود دارند که عبارتند از: 
 

 Cascade : نمایش پنجره ها بصورت آبشاری 

 Tile horizontally: نمایش پنجره ها بصورت افقی 

 Tile Vertically: نمایش پنجره ها بصورت عمودی 

  
در زیر توپوگرافی ، پروفیل طولی و پروفیل عرضی یک پروژ نشان داده شده است. 
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11-4    مشاهده چند جاب به طور همزمان 

ــواه  شما می توانید در نرم افزار SDRmap V8.01 چند جاب را بطور همزمان مشاهده کنید و در صورت دلخ
بر روی هر کدام از جابهای مورد نظر بطور مجزا کار کنید.برای این کار کافیست بعــد از بـاز کـردن جـاب اول 
جاب دوم را نیز باز کنید. حال با استفاده از گزینه های مختلف منوی window دو یا چند جاب باز شــده را بـه 
روش دلخواه مرتب سازی نمائید. توجه داشته باشید که با توجه به تغییراتی که در این نسخه نرم افزار بوجود 
آمده سرعت محاسبات آن افزایش یافته ولی باز کردن چندین جــاب بطـور همزمـان سـرعت اجـرای برنامـه را 

کاهش می دهد. 
 

توجه1: 
در صورت بستن تمام پنجره های مربوط به یک پروژه و یا خروج از برنامه، تغییرات داده شده بطور خودکــار 
ــروژه اقـدام  ذخیره می شوند. ولی می توان در هر لحظه با انتخاب گزینه save از منوی File نسبت به ذخیره پ
نمود. در صورت ذخیره پروژه تحت نام دیگر و در محل دیگر بایستی از گزینه save as از منوی File استفاده 

نمود. 
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توجه2: 
ــروژه فعـال رادر  با استفاده از دستور Options>Backup  و فعال کردن گزینه Archive فایلهای مربوط به پ

محل مشخص شده به فرمت cab فشرده نمود که بعدا می تــوان آنـرا توسـط خـود نـرم افـزار و یـا بـه کمـک     
برنامه هائی نظیر win zip به صورت عادی در آورد. 

 
در زیردوپروژه بطور همزمان در یک صفحه نمایش داده شده است.  

 
12-4   انتخاب نقاط 

در این بخش به چگونگی انتخاب نقاط جهت اعمال برخی از تغییرات بر روی آنــها خواهیـم پرداخـت. بـا اندکـی 
ــال مـی باشـند. ایـن  دقت در می یابیم که تعدادی از گزینه های موجود در منوهای Strings و Points   غیر فع
ــن  گزینه ها گزینه های ویرایشی ویا گزارشی می باشند و تا زمانی که نقاط و یا رشته خطوط انتخاب نشوند ای
گزینه ها فعال نخواهند شد و به محض انتخاب نقاط و رشته خطوط گزینه های فــوق فعـال مـی گردنـد.بعنـوان 
مثال ابتدا یک جاب  که حاوی تعدادی نقطه می باشد را باز کرده سپس از منوی Points گزینه Select وســپس 
زیر گزینه Select All را فعال کرده وتمام نقاط موجود در دیتابیس را انتخاب نمائید.لذا مشاهده خواهید نمــود 
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ــه هـای دیگرمنـوی Points مـانند Rotate ( چرخـش )، Transform ( انتقـال )، Copy  ( کپـی )  که سایر گزین
وDelete  (پاک کردن) و … فعال گشته تا بتوان بر روی نقاط انتخاب شده تغییرات لازم را اعمال نمود. 

لذا برای انتخاب نقاط مورد نظر بایستی مسیر زیر را دنبال  کینم: 
 Points> Select

پنجره ای بصورت زیر باز شده و شش گزینه در اختیار ما قرار خواهد گرفت که عبارتند از: 

 
  : Single selection -

ــی تـوان بـا کلیـک بـر  جهت انتخاب نقاط به صورت تک تک بکار می رود . بنابراین پس از انتخاب گزینه فوق م
روی هر کدام از نقاط Database آن را انتخاب نمود. 

 
  : Select all-

با استفاده از این گزینه می توان تمامی نقاط موجود در Database را انتخاب نمود. 
 

  : Select by range-

توسط این گزینــه پنجـره ای بـاز 
مـی گردد کـه مـــی تــوان نقــاط 
ـــابیس را از روی  موجـود در دیت
مشخصات مربوطه انتخاب نمود. 

 
به عنوان مثال اگر بخواهید نقــاط 
را از طریق شــماره انتخـاب کنیـد 

ــالا بـا کلیـک بـر روی   در پنجره ب
قسمت     point number آنرا به 
? درآورده  ســــپس اگر  حـــالت 
بخواهید همه نقاط را انتخاب کنید 
ــــه  All   و اگر  بــر روی دکم
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بخواهید رنجی از شماره نقاط را انتخاب کنید در فضای خالی جلوی  Point  number محدوده دلخواه را وارد 
ــارت 50~15    کنید. بعنوان مثال اگر بخواهید شماره نقاط بین 15 الی 50 انتخاب گردند بایستی در این قسمت عب
ــلا نقـاط 1 ، 5 ، 15 ، 65 ، 95 انتخـاب گردنـد بایسـتی در قسـمت خـالی  را وارد نمائید. ولی چنانچه بخواهید مث
عبارت 1,5.15,65,95 را وارد کرده و سپس OK نمائید. در پنجره بالا می توانیــد عـلاوه بـر شـماره نقـاط از 
ــا  گزینـه Easting مـی توانیـد نقـاط را بـا توجـه بـه  مشخصه دیگری برای انتخاب نقاط استفاده نمائید. مثلا ب

مشخصه X و با گزینه Northing نقاط رابا توجه به مشخصه Y و…. انتخاب نمائید. 
 

 : Select by polygon -
 توسط این گزینه می توانید با کمک ماوس یک چند ضلعی بسته فرضی را ایجاد کنید و سپس دکمه  Enter را 

بزنید. در این صورت تمامی نقاطی که داخل چند ضلعی بسته فرضی قرار گرفته باشند انتخاب خواهند شد. 
 

 : Select by selected string-
 توسط این گزینه می توانید نقاطی را انتخاب کنید که به یک رشته خطوط متعلق هستند. 

 
 : Clear selection-

ــه   از این گزینه می توانید نقاط انتخاب شده را که فعال بوده از حالت انتخابی خارج نمائید. این عمل با زدن دکم
Esc ویا فشردن دکمه سمت راست ماوس و انتخاب گزینه Cancel نیز امکان پذیر می باشد. 

 
13-4   اعمال برخی از تغییرات بر روی نقاط  

حال که با چگونگی انتخاب نقاط آشنا شدید توجه شما را به توضیــح برخـی از گزینـه هـای موجـود در منـوی 
Points جلب می نمائیم. توجه داشته باشید که این گزینه ها همانطوری که قبلا نیز گفته شد پس از انتخاب نقاط 

کاربرد خواهند داشت. 
 

1-13 –4   ترانسفورماسیون 
ترانسفورماسیون به دو دلیل انجام می پذیرد: 

1 – تبدیل مختصات محلی به کشوری یا سیستم مختصات دیگر 
2 – اشتباه در تعریف مختصات ایستگاه استقرار یا ایستگاه مرجع و یا اشتباه در صفر صفر کردن دوربین 

ــاید حداقـل  در هر دو صورت شرط لازم و کافی برای آنکه محاسبات ترانسفورماسیون بدرستی انجام پذیرد ب
دو نقطه در مختصات اولیه و ثانویه وجود داشته باشد.  

ــوی Points اسـتفاده مـی شـود. بـا انتخـاب گزینـه فـوق    حهت ترانسفورماسیون  از گزینه Transform در من
پنجره ای بصورت زیر باز می گردد: 
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در این پنجره بایستی دو نقطه اولیه را در قسمت های Old point 1 و Old  point 2  بعنـوان نقـاط مبـداء و 
 OK وارد نمـوده و  New pont 2 و New point 1 سپس دو نقطه جدید را به عنوان نقاط مقصد در قسمت
ــیز اسـتفاده نمـود. قبـل از  کنید. توجه دلشته باشید از این گرینه می توان برای انتقال نقاط به مختصات جدید ن

زدن دکمه Ok می توان با کلیک بر روی دکمه Report گزارشی از مختصات جدید بدست آمده را بصورت زیر  
مشاهده نمود : 
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ــی تـوان اقـدام بـه  پس از مشاهده گزارش بدست آمده در صورت مثبت بودن آن با کلیک بر روی دکمه OK م
ترانسفورماسیون کرد . در غیر اینصورت با کلیک بر روی دکمه Cancel از دستور Transform خارج خواهید 
شد. روش دیگر جهت انجام عمل ترانسفورماسیون اینست که پس از انتخاب نقطه یا نقاط دکمــه سـمت راسـت 

ماوس را فشار داده وسپس گزینه Transform را از پنجره باز شده انتخاب نمود. 
  

2-13-4    انتقال 
جهت جابجا کردن نقاط انتخاب شده با طول و زاویه ای که به نرم افزار داده می شود از دستور Translate در 
منوی Points  استفاده می گردد. روش دیگر جهت اجرای این دستور اینست که پس از انتخــاب نقطـه یـا نقـاط 
ــا اجـرای  دکمه سمت راست ماوس را فشار داده وسپس گزینه Translate را از پنجره باز شده انتخاب نمود. ب

دستور فوق پنجره ای بصورت زیر باز خواهد شد: 

 
 

در قسمت  Bearing زاویه ودر قسمت  Distance طول مورد نظر را وارد کرده و Ok نمائید. در اینجا نــیزقبل 
از زدن دکمه Ok می توان با کلیک بر روی دکمه Report گزارشی از مختصات جدید بدست آمده را   مشاهده 

نمود . 
 

3-13-4    تغییر مشخصات نقاط 
ــده را بصـورت یکجـا تغیـیر  با استفاده از دستور Alter از منوی Points  می توان مشخصات نقاط انتخاب ش
داد. با استفاده از این دستور می توان تواما بر روی چندین نقطه تغییرات دلخواه را اعمال نمود. با انتخاب ایــن 

دستور پنجره ای مشابه زیر باز می گردد: 
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در پنجره بالا در قسمت های مربوط به Add a constant to می توان یک مقدار ثابتی را به مقادیر قبلی اضافه 
ــمت Height عـدد  یا کسر نمود. مثلا اگر بخواهیم از ارتفاع نقاط انتخاب شده به میزان 1 متر کسر گردد در قس
ــه  1- را وارد کرده و OK می کنیم به همین صورت این عمل برای مقادیر شماره نقاط، z,y,x، کیلومتراژ، فاصل
ــابیس عـدد 1000 اضافـه  از محور مرکزی و… صادق می باشد. یا اگر بخواهیم به شماره نقاط موجود در دیت

شود در قسمت  Point number عدد 1000 را وارد کرده و OK نمائید. 
ــوان بجـای سـایر مشـخصات مربـوط بـه نقـاط مقـادیر و یـا  اما در قسمتهای مربوط به Replace with می ت
ــامی نقـاط  مشخصه دیگری را جایگزین نمود. به عنوان مثال اگر در قسمت Code عبارت Tree را وارد کنید تم
ــد Tree جـایگزین آنـها  انتخاب شده دارای کد Tree خواهند شد و در صورت وجود کدی از قبل برای نقاط ، ک

خواهد شد. 
 

4-13-4   چرخش 
توسط گزینه  Rotate از منوی Points می توان نقاط انتخاب شده را نسبت به یک مرکز و با زاویـه مشـخصی 
چرخاند.  در این صورت در پنجره باز شده در قســمت  Rotate about which point شـماره نقطـه مرکـز 

چرخش و در قسمت Angle of rotation میزان چرخش را وارد کرده و OK  کنید. 
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ــت مـاوس را فشـار  روش دیگر جهت اجرای این دستور اینست که پس از انتخاب نقطه یا نقاط دکمه سمت راس
ــه Ok مـی تـوان بـا  داده وسپس گزینه Rotate را از پنجره باز شده انتخاب نمود. در اینجا نیزقبل از زدن دکم

کلیک بر روی دکمه Report گزارشی از مختصات جدید بدست آمده را  مشاهده نمود . 
 

6-13-4 مرتب سازی نقاط   
توسط گزینه Compress numbering  از منـوی Points مـی تـوان شـماره نقـاط موجـود در دیتـابیس را بـا 
شماره های جدید جایگزین نمود. بعنوان مثال اگر نقاط دیتابیس از  1 الی آخر مرتـب شـده باشـند و بخواهیـد 
نقاط را از شماره 1000 به بعد مرتب نمائید بایستی پس از اجرای این دستور در پنجره ای که باز می شود عدد 

1000 را وارد کرده و سپس OK کنید.  

 
6-13-4  پاک ، حذف و کپی و… نمودن نقاط 

توسط دستور Cut از منوی Points می توانید نقاط انتخاب شده در جاب جاری را برداشته ودریک جاب دیگر 
با استفاده از گزینه Paste منقل نمائید. توسط دستور Copy می توان از نقاط انتخاب شده موجود یک کپــی در 
جاب دیگر تهیه نمود.روش استفاده از این دو دستور به این شکل می باشد که پس از انتخاب نقاط به روشـهای 
 Points را فعال نموده وپس از انتخاب و یا ایجاد یک جــاب دیـگر از منـوی Cut  ویا  Copy  گفته شده ، گزینه

بجـای دســتور گزینه Paste را اجرا نمائید. روش دیگر استفاده از این دستورات استفاده از آیکون        
بجای دستور   Paste می باشد. بجای دستور  Copy و استفاده از آیکــون       Cut ، آیکون           
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 با کلیک دکمه سمت راست ماوس نیز پنجره ای باز خواهد شد که میتوان دستورات فوق را نــیز از ایـن پنجـره 
انتخاب نمود. دستور  Delete از منوی Points باعث حذف نقــاط انتخـاب شـده مـی گردد. پـس از اسـتفاده از 

دستور Cut ویا Copy پنجره ای بصورت زیر باز می گردد: 

 
ــک  در این پنجره در صورت تمایل به حذف نقاط بر روی دکمه Yes و در غیر اینصورت بر روی دکمه No کلی
ــکل  نمائید. توسط دستور Oops می توان نقاط حذف شده را بازیابی کرد. با اجرای این دستور پنجره ای به ش

زیر گشوده خواهد شد: 

 
در این پنجره چنانچه بخواهید یک نقط یا نقاط خاص را بازیابی کنید بایستی نقاط مورد نظررا با کلیک بر روی 

آنها انتخاب نموده وسپس بر روی دکمه  Undelete کلیک کنید.   
 

7-13-4        گرفتن گزارش از نقاط 
پس از انتخاب نقاط مورد نظر برای تهیه گزارش از لیست نقاط از منوی Points  گزینه List را فعال نمائید. لـذا 

پنجره ای بصورت زیر باز خواهد شد : 
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در پنجره بالا مشخصات لازم برای تهیه گزارش از نقاط ( از قبیل شماره نقطــه ، Z ، Y ، X ، کـد و …..) را بـا 
 Column کلیک بر روی هر مشخصه انتخاب نمائید.  ترتیب قرار گیری و همچنین عرض ستون ها را درقســمت
وwidth مشخص کنید. در قسمت Sort By میتوان دو گزینه Point No و Chainage می توان انتخــاب نمـود. 
ــد  در حالت Point No نقاط به ترتیب شماره نقاط ودر حالت Chainage نقاط به ترتیب کیلومتراژ مرتب خواهن

شد. پس از تکمیل پنجره بالا بر روی دکمه Ok کلیک نموده تا گزارش تهیه شده بصورت زیر نمایان گردد: 
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1-5   اضافه کردن رشته خطوط 
رشته خطوط یک مسیر باز یا بسته برداری است که برای برنامه تعریف می کنیم و می تــوان بـه کمـک برنامـه 
روی هر کدام از این رشته ها کار کرد. مثلا مساحت رشته را بدست آوریم و یا پروفیل آن را رسم کنیم. قبل از 

ترسیم رشته خطوط لازم است مطالبی در رابطه با رشته خطوط بیان گردد. 
 

 : ( Folder ) 1- پوشه
 هر پوشه می تواند شامل تعدادی رشته خطوط باشد و می توان پوشه را به عنوان لایه حاوی خطوط شناخت. 
ــیره رشـته هـا مـورد اسـتفاده قـرار گیـرد.  در  به عبارت دیگرمی توانید مشخص کنید که کدام پوشه برای ذخ
ــا چـاپ  بسیاری از مواقع لازم است که بنا به ضرورت لایه های نقاط خاموش بوده و فقط خطوط را مشاهده ی

نمائیم. لذا این امکان با استفاده از قابلیت پوشه ها بدست خواهد آمد. 
 

 : ( Class) 2- کلاس رشته ها
در یک پوشه می توانید رشته های مشابه را در یک گروه قرار داده و هر گروه را بطور جداگانه نمایش داد. بــه 
هر گروه یک کلاس گفته می شود. به عنوان مثال می توانید کلیه خطوط مربوط به محوطه را در یک کلاس بنام 
Had قرار داده و رنگ آن را آبی نمود. یا می توان آکس جاده را درکلاس دیگری به نام Center ترســیم کـرده 

و رنگ آن را به رنگ قرمز در آورد و در هنگام چاپ ، کیلومتراژ نقاط این خطوط را در کنار آنها درج نمود. 
 

 : ( String ID ) 3- کد رشته ها
برای تفکیک رشته ها از هم ، از یک کد استفاده می کنیم. در واقع به مجوعه ای از خطوط وابسته به هم باید یک 

نام، شماره یا یک ID اختصاص داد. یک ID را می توان به چند رشته خط متفــاوت اختصـاص داد. کـد رشـته   
ــردن ممـیز، خـط فاصلـه، کامـا،  می تواند ترکیبی از حروف A تا Z و اعداد 0 تا 9 باشد مثلا LOT 1 . به کار ب

ویرگول در نامگذاری کد رشته مجاز نمی باشد. 
 

توجه: 
ــایش  تفاوت بین پوشه و کلاس در این است که کلاس تعیین می کند انواع خاص خطوط در یک پوشه چگونه نم
داده شوند و پوشه تعیین می کند که خطوط خاص را بتوان نمایش یا چاپ کرد و یا آنها را موقتا مخفی نمود. 

 
 
 

جهت ترسیم رشته خطوط بر روی نقاط موجود در Database کافیست که دستور زیر اجراء کنید: 
 Strings>Add….

با اجرای دستور بالا پنجره ای مشابه زیر گشوده می گردد: 
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ابتدا یک کد یا نامی برای رشته خطوط ترسیمی در قسمت String ID وارد نمائید ( مثــلا LOT1 ) . در قسـمت 
Folder می توان پوشه ای را که خطوط ترسیمی در آن قرار خواهند گرفت را تایپ نمود. این قسمت بصــورت 

پیش فرض LOTS در نظر گرفته خواهد شد ولی در صورت لزوم می توانید عبــا رت دلخواهـی را در آن وارد 
کنید ( مثلا Lines ). اگر بخواهیم خطوط ترسیمی در کلاس یک قرار گیــرد در جلـوی قسـمت Class عـدد 1 را 
تایپ کنید. نوع خطوط ترسیمی و رنگ دلخواه را مــی توانیـد بـا اسـتفاده از دکمـه Line وColour  مشـخص 
سازید. درفضای خالی داخل پنجره باز شده می توان شماره نقاط محدوده رشته خطوط را وارد کــرد. بـه ایـن 
صورت که شماره نقطه را تایپ کرده و بعد یک کاما گذاشته و شماره نقطه بعدی، مجددا کاما و به همین ترتیب 
ــردن بـر روی  الی آخر شماره نقاط رشته خطوط را تایپ می کنیم. همچنین بوسیله ماوس می توانیم با کلیک ک
نقاط مورد نظر آنها را انتخاب کنیم. در این صورت شماره نقاط انتخاب شده در فضــای خـالی پنجـره مذکـور 
بطور خودکار به نمایش در خواهند آمد. برای ایجاد یک محدوده بسته و امکــان محاسـبه مسـاحت آن بایسـتی 
اولین نقطه مجددا در انتها وارد شود. ( بعنوان مثال 1,3,9,8,1 ) در نهایت پــس از تـائید شـکل ایجـاد شـده بـر 
روی دکمه Apply کلیک نمائید. در این حال مکان نما مجددا بر روی قســمت String ID رفتـه و منتظـر تـایپ 
نامی برای مجموعه خطوط جدید خواهد بود. این کار را تا ترســیم تعـداد خطـوط مـورد نیـازتکرار کـرده و در 

نهایت بر روی دکمه Finish کلیک کنید. 
 

توجه: 
چنانچه بخواهیم بین چند نقطه که شماره نقاط آن متوالی بوده رشته خطوطی ترسیم کنیم کافیست که بین نقطه 
شروع و نقطه پایان یک علامت  .  قرار داده شود. بعنوان مثال اگر بخواهیم بین نقــاط شـماره 1 الـی 50 رشـته 
ــر  خطوطی را ترسیم کنیم کافیست در فضای خالی پنجره Add   String عبارت  1.50 را تایپ کرده و سپس ب

روی دکمه Apply کلیک نمود. 
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2-5     ترسیم قوس 
اگر لازم باشد در وارد کردن رشته ، یک قوس را نیز اضافه کنیم باید به ترتیب نقطه شروع، مرکز و نقطه پایان 
قوس را وارد کرده و در صورتی که قوس ساعت گرد باشد قبل از نقطه مرکز قــوس یـک علامـت + و اگر پـاد 
ــه مـی گردد رشـته خطـوط را از نقطـه  ساعت گرد باشد قبل از نقطه مرکز قوس یک علامت- قرار دهید. توصی

شروع قوس وارد نکنید.  
 

3-5     تغییر خصوصیات رشته خطوط 
برای ویرایش رشته خطوط موجود در دیتابیس نرم افزار از منوی  String گزینه  Change را انتخاب کنید. لذا 

پنجره ای به صورت زیر باز خواهد شد: 
 

 
ــود را انتخـاب و سـپس آنـرا  در این پنجره می توانید با دادن نام پوشه و همچنین کد رشته، رشته مورد نظرخ
ویرایش نمود. جهت انتخاب رشته خطوط باز یا بسته می توانید بر روی قسمتی از خط بــاز یـا داخـل محـدوده 

بسته مورد نظر نیز کلیک نمائید. 
 

4-5   انتخاب رشته خطوط 
ــان مـی گردد  از منوی String گزینه  Select را انتخاب کنید. ملاحظه خواهید کرد که 5 گزینه به شرح زیر نمای

که در زیر به شرح هر کدام از آنها می پردازیم : 
 
 
 
 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01 نرم افزار
 

82
 

  : Single String selection  • 
جهت انتخاب رشته خطوط به صورت تک تک بکار می رود. بنابراین با کلیک بر روی هر کدام از رشته خطــوط  

می توان آن را انتخاب نمود. جهت انتخاب یک مرز بسته کافیست داخل آن کلیک کنید. 
 

  : Select by Range • 
توسط این گزینه پنجره ای باز می گردد که می توانید رشته خطوط را از روی اسامی پوشه ها انتخاب نمائید.  

 
ــا بـا کلیـک بـر روی  ? (تیک ) دار نمود. ی در این صورت کافیست بر روی پوشه مورد نظر کلیک کرده و آن را 

دکمه All همه رشته خطوط را انتخاب نمود. 
 

 : Select all • 
 توسط این گزینه می توانید تمام رشته خطوط موجود در دیتابیس را انتخاب کنید. 

 
 : Select by polygon • 

 توسط این گزینه می توانید با کمک ماوس یک چند ضلعی بسته فرضــی ایحـاد کنیـد و سـپس دکمـه Enter را 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01   نرم افزار
 

83  

بزنید در این صورت تمامی رشته خطوط داخل چند ضلعی بسته فرضی انتخاب خواهند شد. 
 

  : Clear selectoon • 
از این گزینه می توان خطوط انتخاب شده را که فعال بوده از حالت انتخابی خارج نمود. این عمل بــا زدن دکمـه 
Esc نیز امکان پذیر می باشد. همچنین با کلیک دکمه سمت راست ماوس و اجرای گزینه Cancel می تـوان ایـن 

عمل را انجام داد. 
 

5-5    گرفتن گزارش از رشته خطوط 
ــرای تهیـه گزارشـی از لیسـت رشـته خطـوط از منـوی String گزینـه  پس از انتخاب رشته خطوط مورد نظر ب

Listing را فعال کنید. پنجره ای بصورت زیر باز خواهد شد: 

 
  : Full listing

گزارش کاملی از نام خطوط، نقاط تشکیل دهنده خطوط، فاصله و زاویه بین آنها ، مختصــات رئـوس خطـوط و 
همچنین در صورت امکان محیط و مساحت محدوده بسته را ارائه خواهد نمود. 
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 : Full listing with heights

ــها ، مختصـات  گزارش کاملی از خطوط، نقاط تشکیل دهنده خطوط به همراه ارتفاع نقاط، فاصله و زاویه بین آن
رئوس خطوط و همچنین در صورت امکان محیط و مساحت محدوده بسته را ارائه خواهد نمود. 

 : Points coordinates

 گزارشی از نام خطوط وشماره نقاط تشکیل دهنده خطوط به همراه مختصات آنها را ارائه می کند. 
 

 
 : Points only

گزارشی از نام خطوط وشماره نقاط تشکیل دهنده خطوط را ارائه می کند. 
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  : ID’s only

گزارشی از نام و پوشه رشته خطوط را ارائه می کند. 
 

  : 3D surface Area

ــی کنـد. در صـورت اسـتفاده از ایـن گزینـه بایسـتی در قسـمت  گزارشی از مساحت رویه سه بعدی را ارائه م
Surface  نام رویه را وارد کرد. 

 
  : Misclose Report

گزارش کاملی از نام خطوط، نقاط تشکیل دهنده خطوط، فاصله و زاویه بین آنها ، مختصــات رئـوس خطـوط و 
ــای بسـت  همچنین در صورت امکان محیط و مساحت محدوده بسته را ارائه خواهد نمود. همچنین میزان خطاه

چند ضلعی در انتهای گزارش فوق بنمایش در خواهد آمد. 

 
 

6-5     اعمال برخی تغییرات بر روی خطوط 
 String انتخاب خطوط نیز به همان روشی که برای انتخاب نقاط گفته شد می باشد. برای این منظــور از منـوی

گزینه  Select را انتخاب و سپس یکی از زیر مجموعه های آن را فعال و رشته خطــوط مـورد نظـر را انتخـاب  
 Listing , paste , copy,  می کنیم. در اینجا نیز پس از انتخاب رشته خطوط می توانید از دستورات ویرایشی

 Cut , Delete , alter که در منوی String  مشاهده می شوند نیز استفاده نمائید. 
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با استفاده از دستور Alter از منوی String  می توان مشخصات خطوط انتخاب شده را بصورت یکجــا تغیـیر 
ــود. بـا انتخـاب  داد. با استفاده از این دستور می توان تواما بر روی چندین خطوط تغییرات دلخواه را اعمال نم

این دستور پنجره ای مشابه زیر باز می گردد: 
 

 
ــتفاده از ایـن دسـتور کلیـک سـمت راسـت  در پنجره بالا تغییرات لازم را اعمال نموده و Ok کنید. راه دیگر اس

ماوس و انتخاب گزینه Alter می باشد. 
  

از گزینه Spilt  در منوی  String  می توان جهت جدا کردن یک رشته خطوط از هم اســتفاده نمـود. با اجـرای 
دستور فوق پنجره ای به شکل زیر باز می گردد: 

 
ــالا بـه  همانطوری که مشاهده می کنید پس از انتخاب یک رشته خط ، شماره نقاط تشکیل دهنده آن در پنجره ب
نمایش در خواهند آمد. با استفاده از گزینه Split at  point  می توان رشته خــط انتخـاب شـده را توسـط یـک 
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نقطه و با استفاده از گزینه  Spilt at string  می توان رشته خط انتخاب شده  را با استفاده از یک امتداد از هم 
جدا نمود. راه دیگر استفاده از این دستور کلیک سمت راست ماوس و انتخاب گزینه Spilt می باشد. 

 
گزینه  Join برای ترکیب خطوط جدا ازهم بکار گرفته می شــود.  در واقـع ایـن دستـور خطـوط جـدا از هـم را 
بصورت یک خط پیوسته در می آورد. برای اینکار ابتدا خطــوط مـورد نظـر را انتخـاب کـرده سـپس از منـوی 

String گزینه Spilt را فعال نمائید. در اینصورت پنجره ای بصورت زیر باز می گردد: 

 
در این پنجره می توانید ابتدا تغییرات مورد نیاز را اعمال نموده و OK کنید. راه دیگر اســتفاده از ایـن دسـتور 

کلیک سمت راست ماوس و انتخاب گزینه Join  می باشد. 
 

توسط دستور Cut از منوی String می توانید خطوط انتخاب شده در جاب جاری را برداشــته وبـه یـک جـاب 
دیگر با استفاده از گزینه Paste متنقل نمائید. توسط دستور Copy می توان از خطوط انتخاب شده موجود یک 
ــاب خطـوط  کپی در جاب دیگر تهیه نمود. روش استفاده از این دو دستور به این شکل می باشد که پس از انتخ
ــا ایجـاد یـک جـاب دیـگر از  به روشهای گفته شده ، گزینه  Copy  ویا  Cut را فعال نموده وپس از انتخاب و ی

منوی String  گزینه Paste را اجرا نمائید. روش دیگر استفاده از این دستورات استفاده از آیکون                         
  Paste  و استفاده از آیکون                بجای دستور Copy  آیکون            بجای دستور ، Cut بجای دستور 

می باشد. 
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توجه:  
برای رشته خطوط همانند نقاط دستوری با نام Oops وجود ندارد لذا در حذف کردن خطوط دقت کافی را بکار 

گیرید. 
 

ــان دادن مشـخصات  7-5 استفاده از کلاسها برای رنگ آمیزی رشته ها، نش
خاصی از رشته، هاشورزنی و درج نوشتارهای مرتبط 

 
ــاز کنیـد  برای تمرین پروژه db. CL1 را از مسیر Program fiels\SDRmapping &Design\Examples\ ب
که شامل خطوطی در کلاسهای متفاوت می باشد. سپس از منوی String گزینه String attributes را انتخـاب 

نمائید. پنجره ای بصورت زیر باز می گردد: 
 

 
در بالای پنجره باز شده می بینید که سه کلاس به نام های  SMALL, villas, o  ظاهر مــی گردنـد .در مـورد 
این نامها نگران نباشید زیرا هر موقع که بخواهید می توانید این اسامی را تغییر دهید. در مقابل هــر یـک از ایـن 

کلاسها گزینه هائی به چشم می خورند که برای محدوده های بسته کاربرد دارند و عبارتند از: 
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 : Fill 

? )  مقابل Vilas محدوده های بسته موجود در این کلاس با رنگ معرفی شده   با کلیک بر روی علامت مربع (
در قسمت Fill color  پر می شوند. 

 
 : Fill color 

ــر شـده محـدوده هـای بسـته را  با کلیک بر روی این قسمت میتوان از پنجره ای که باز می شود رنگ فضای پ
مشخص نمود. 

 
  : Hatch

? )  مقابل این قسمت یــک علامـت ضربـدر در داخـل مربـع ایجـاد مـی شـود.  با کلیک بر روی علامت مربع ( 
 Hatch بنابراین داخل  محدوده های بسته  کلاس انتخاب شده با رنگ مشکی ها شورزده خواهد شد. در قسمت

ــوده و در قسـمت Hatch size انـدازه هاشـور را    name اسم هاشور مورد نظر که مطابق با نرم افزار اتوکد ب

می توان مشخص نمود. 
 

توجه: 
 String ــس از ورود بـه پنجـره اگر یک رشته خطی را بعنوان آکس جاده با کلاس Road ترسیم کرده باشیم پ
attributes ملاحظه خواهید کرد که کلاس  Road در لیست کلاســهای موجـود در جـاب در قسـمت Class بـه 

نمایش در خواهد آمد. حال اگر این کلاس را انتخاب کرده و گزینه  Chain (کیلومــتراژ) را تیـک دار کـرده ودر 
ــازید پـس از Ok کـردن  قسمت های  Size  ، Font  ، Pen و…. رنگ ، فونت و اندازه کیلومتراژ را مشخص س

ملاحظه خواهید کرد که مقدار کیلومتراژ بر روی نقاط آکس جاده درج خواهند شد.  
و یا اینکه با انتخاب کلاس SMALL و تیک دار کردن گزینه  Distance (فاصله ) و معرفی نمودن نوع ، رنگ و 
اندازه فاصله خطوط با Ok کردن ملاحظه خواهیــد کـرد کـه طـول هـر کـدام از اضـلاع رشـته خطـوط کـلاس 

SMALL در کنار آن درج خواهند شد. 
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1-6    مقدمه 
در این فصل به چگونگی درج علائم و متون در نقشه ها خواهیم پرداخت. در صــورت نیـاز مـی تـوان علائـم و 
نشانه های ( سمبلهای) مورد نیاز را در نرم افزار هائی از قبیل  Autocad تولیـد نمـوده و در ایـن نـرم افـزار 
مورد استفاده قرار داد. علاوه بر آن می توان از سمبلهای موجود و تعریف شده در این نرم افزار نیز اســتفاده 
نمود. سمبلها را می توان به دو صورت دستی و یا خودکار ( با توجه به کد نقاط) روی نقشه هــا قـرارداد. هـر 
فایلی با فرمت WMF یا EMF را می توان بصورت یک سمبل در نقشه درج کرد. توصیــه مـی گردد هـر فـایل 
WMF یا EMF را ابتدا به اندازه 1×1 واحد طراحی نموده سپس به اندازه اعدادی که به عنوان طول یــا عـرض 

داده می شود در نقشه جایگزین کرد. سمبلها را می توان با اندازه واقعی آنها در روی زمین بر روی نقشه درج 
کرد. در این صورت اندازه آنها هنگام چاپ در نقشه نهائی وابسته بــه مقیـاس نقشـه مـی باشـد. عـلاوه بـر آن 
سمبلهائی نیز وجود دارند که اندازه آنها ارتباطی با اندازه واقعی آنها روی زمین ندارد مانند سمبل یک درخــت. 
این سمبلها در هر مقیاسی که نقشه چاپ شود به اندازه مشخص شده ظاهر خواهند شد.جهت درک بهتر مطالب 
 program files\ SDRmapping & Design\ Examples را از مسیر db.sy1 بالا توصیه می گردد که جاب

باز کرده و کار را بر روی این جاب دنبال کنید. 
 

2-6      مشاهده کتابخانه سمبلها  
سمبلهای موجود و تعریف شده در این نرم افزار 

ــرار دارنـد و در   بصورت پیش فرض در شاخه  Program fies\   SDRmapping & Desing\ Symbols  ق
صورت طراحی سمبل تحت فایل WMF یا EMF که قابل استفاده در این نرم افزار باشــد بایسـتی در شـاخه  
ــتفاده در  Program files\ SDRmapping & Design\ Variable  قرار گیرند. لذا جهت رویت علائم قابل اس

این نرم افزار بایستی مسیر زیر را دنبال کرد: 
 Entry> Symbols> Symbol Library

با اجرای دستور بالا پنجره ای بصورت زیر باز خواهد شد: 
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در ستون اول پنجره بالا یک پیش نمایشی از سمبل نشان داده خواهــد شـد. درغـیر اینصـورت بـر روی دکمـه 
Reread کلیک کرده تا شکل کوچکی از سمبلها به نمایش در آیند. ستون دوم پنجره بالا نام فایل حاوی ســمبل 

می باشد. با کلیک بر روی علامت مربع جلوی هر سمبل در ستون  Scaled مـی تـوان قـابلیت مقیـاس پذیـری 
ــمبل را هنـگام درج در نقشـه  سمبل را مشخص کرد. درستونهای  Widthو Height می توان طول و عرض س
ــتی خـاطر نشـان  مشخص کرد. بالاخره ستونهای  insert X وinsert Y  محل نقطه درج سمبل می باشد. بایس

کرد که دو ستون  insert X وinsert Y  نشان دهنده مختصات مرکز سمبل می باشد. 
 

توجه1: 
ــر انـدازه از سـمبل  چنانچه بخواهیم یک سمبل را در اندازه های متفاوت در نقشه درج نمائیم بایستی به ازای ه
ــر مـورد  یک کپی از آن فایل با نامهای متفاوت تهیه نمائیم . سپس می توان در جدول بالا اندازه لازم را برای ه

تعیین کرد. 
 

توجه 2: 
ــره بـالا  چنانچه بخواهیم سمبلی را تحت یک فایل مشخص از قبل تعیین شده به لیست سمبلهای موجود در پنج
ــائیم. در ایـن صـورت پنجـره ای  اضافه نمائیم کافیست که بر روی دکمه  Add symbol از پنجره بالا کلیک نم

بصورت زیرباز می گردد: 
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  از این پنجره ابتدا فایل حاوی سمبل مورد نظر را انتخاب کرده و سپس Open  نمائید. در این صورت ســمبل 
انتخاب شده به لسیت سمبلهای موجود در نرم افزار در پنجره  symbol  library افزوده خواهد شد. 

 
توجه 3: 

توجه داشته باشید که در پنجره مربوط به کتابخانه ســمبلها (Symbol Library ) اگر روبـروی سـمبل مـورد 
ــی اگر تیـک نخـورده  نظر در ستون Scaled  تیک خورده باشد سمبل با توجه به مقیاس نقشه تغییر می کند ول
باشد و طول و عرض سمبل وارد شده باشد آنگاه بر روی نقشه این سمبل با همان مقــادیر داده شـده ترسـیم 

خواهد شد. 
 

3-6     درج، ویرایش و حذف سمبلها 
جهت درج سمبلها بایستی مسیر زیر را دنبال نمائید: 

 Entry> symbols> insert a symbol
لذا پنجره ای بصورت زیر باز خواهد شد: 

 
در پنجره بالا ابتدادرقسمت symbol نام سمبل مورد نیاز خودرا انتخاب کنید.درقسمت  Scale مقیـاس سـمبل 
ودرقسمت  Rotation میزان چرخش سمبل راوارد کرده وOK  نمائید.دراینصورت مربعی به اندازه عــدد وارد 
شده درقسمت Scale به نمایش درخواهد آمد. به کمک ماوس میتوانید محل آنراتغییرداده ودرمحل دلخواه خود 
قراردهید. جهت مشاهده کامل سمبل قرارداده شده درمحل دلخواه کلید  D را ازصفحه کلید فشارداده وصفحــه 

رابازسازی نمائید. 
 

ــروزدن دکمـهD ازصفحـه کلیـد سـمبل مـورد نظـر  ممکن است پس ازقراردادن سمبل دلخواه درمحل مورد نظ
برروی صفحه بنمایش درنیاید. دراین حالت ممکن است که گزینه  Symbols درحالت خاموش ( off) باشد.  
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برای روشن کردن سمبلها ابتدا دکمهF9 رازده وازپنجره ای که بصورت زیر بــازمیگردد حـالتSymbols رابـه 
حالت روشن (On) دربیاورید. 

 
  Symbolsگزینـه Entry  جهت اینکه یک سمبل را دقیقاروی یک نقطه موجود دردیتا بیــس قراردهیـد ازمنـوی

وسپس زیر گزینه Symbol  Display را انتخاب نمایید.دراینصورت پنجره ای به صورت زیربازمیگردد: 
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ــه منزلـه آن  دراین پنجره نام سمبل ومشخصات محل درج آن رامشاهده می فرمایید. عدد1- درستون  Point ب
ــورد نظـر درایـن قسـمت میتـوان  است که محل قرارگیری سمبل به صورت آزاد بوده که باتایپ شماره نقطه م
سمبل را دقیقا برروی آن نقطه قرار داد. دراین پنجره علاوه بر شماره نقطه میتوان مختصات محل درج ســمبل 
رادرستونهای  East و North تایپ کرد. امکان تغییر مقیاس وهمچنیــن مـیزان چرخـش سـمبل درایـن پنجـره 
ــد. درضمـن بـه کمـک ایـن دسـتورمیتوان  نیزوجوددارد. پس از اعمال تغییرات بالا برروی دکمه OK کلیک کنی
ــاید نـام فـایل حـاوی سـمبل وسـایر مشـخصات  سمبلهای جدید را نیز به  نقشه اضافه کرد. برای این منظور ب
مربوط به آن رادرپنجره بالا تایپ نمایید. جهت حذف یک سمبل ازپنجره بالا کافیست برروی سطر حاوی سمبل 
ــد  مورد نظرکلیک کرده وسپس کلید  Delete را ازصفحه کلید فشرده و سپس با استفاده از دکمه D صفحه کلی

صفحه گرافیکی را بازسازی نمود.  دقت داشته باشید که این عمل غیرقابل برگشت میباشد.  
 

4-6      درج خودکار سمبلها 
ــورد نظـررا بـرروی  چنانچه نقاط موجود در دیتا بیس دارای کد باشند میتوان بااستفاده از کد نقاط سمبلهای م
آنهادرج نمود. به این صورت که ابتدا بایستی که نقاط وسمبلی راکه بایســتی بـرروی آن نقـاط درج گردد رابـه 
نرم افزار معرفی نموده وپس از اعمال آنها به دیتابیس برروی صفحه گرافیکی نرم افزار مشاهده نمود. درواقع 
ــن اسـت کـه ازایـن کتابخانـه کـد میتـوان در  بایستی یک کتابخانه کد نقاط برای پروژه تعریف نمایید. نکته درای

پروژه های دیگرنیزاستفاده نمود. لذاجهت تعریف کتابخانه کد بایستی مسیرزیررادنبال نمایید:  
 Entry>Feature codes….

بااجرای دستوربالاپنجره ای مشابه زیرگشوده خواهد شد.  
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درقسمت  Library name نامی برای کتابخانه کد وارد کنید. درستون  Code کلیک کرده ونام کد نقاط موجود 
ــوده  دردیتابیس راوارد کنید. باکمک ماوس ویا کلید  Tabصفحه کلید خط های لایت رابه ستون  Typeمنتقل نم
وازلیست بازشده دراین ستون گزینه  Pointرا انتخاب نمایید. مجدد خط های لایت رابه ستون  Action منتقــل 
کرده ودرآن نوع سمبلی راکه بایستی روی نقاطی که دارای کد معرفی شده درقسمت  Code درج شوند راتایپ 
کنید. به عنوان مثال تایپ عبارت S=Bush به معنی این اســت کـه نـرم افـزار روی نقـاط بـا کـد معرفـی شـده 
درقسمت   Code سمبل Bush راقراردهد. درستون Layer میتوانیــد نـام لایـه ای کـه سـمبل همـراه بـا نقطـه 
بایستی در آن قرارگیرند راوارد کنید. باتوجه به توضیحــات بـالا نمونـه تکمیـل شـده ای ازپنجـره مربـوط بـه 

کتابخانه کد درزیر به نمایش درآمده است: 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
   

 
 

 
پس ازتعریف کدهای مربوط به پروژه برروی دکمه  Apply to DB کلیک کرده تاپردازش کدها مطابق تعاریف 
پنجره بالا انجام گردد. درنهایت برروی کلید  OK کلیک نمایید تاکتابخانه کدها ذخیره گردد. توجه داشته باشید 
درهرزمان که بخواهید درنوع سمبلهای درج شده برروی نقــاط تغیـیراتی دهیدبایسـتی ایـن تغیـیرات درپنجـره 
مربوط به کتابخانه کدها داده شود. وپس ازاعمال تغییرات لازم مجددا میتوانید آنها رابه دیتا بیس انتقال دهید. 
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 توجه 1: 
  OL-p2L3 عبـارت S=BUSH با یک فاصلــه پـس از عبـارت  Action  درپنجره بالا درصورتی که درستون
تایپ گردد به این معنی است که نقاطی که دارای کد TREE هستند وسمبل  Bush برروی آنها درج خواهد شد 
توسط یک خط بازبا نوع خط3 و رنگ  2 به همدیگرمتصل شوند. ترسیم خطوط به ترتیب شماره نقاط صــورت 
خواهد گرفت. اما چنانچه به جای عبارت OL-P2L3 عبارت CL-P2L3 تایپ شود. یــک خـط بسـته بیـن نقـاط 

ترسیم میگردد. به عبارت دیگرتوسط این عبارت میتوانید یک محدوده بسته نیز بین نقاط ایجاد کنید.  
 

توجه 2: 
اگر در پنجره  Feature Code Library پس از عبارت S=STN یــک خـط فاصلـه و سـپس عبـارت M0.3  را 

تایپ کنید سمبل STN  با ضریب مقیاس 0.3 بر روی نقطه درج خواهد شد. 
 

5-6   درج ، ویرایش و حذف متون 
جهت ایجاد یک نوشته درنقشه بایستی دستورزیررااجرا کنید : 

 Entry>Text>insert text
لذا پنجره ای به صورت زیر بازخواهد شد:  

 
درفضای خالی پنجره بالا متن خود را تایپ کنید . محل قرارگیری متن رابا کلیک ماوس برروی صفحه مشخص 
ــات محـل درج متـن رادر قسـمتهای Position East و Position North وارد کنیـد. مـیزان  سازید .یا مختص
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ــرد راانتخـاب  چرخش متن رادر قسمت Bearing و درقسمت Layer نام لایه ای راکه متن بایستی درآن قرارگی
کرده ودرقسمت  Height اندازه متن رامشخص سازید. درقسمت Font نوع رنگ ونوع نوشته متــن را انتخـاب 

کنید.  

 
ــک دکمـه   درنهایت بر روی دکمه Apply کلیک کرده وجهت ذخیره بر روی دکمه Ok کلیک نمائید. سپس با کم

D از صفحه کلیدصفحه را نوسازی کنید. حال مشاهده خواهید کرد که متن روی صفحه ظاهرشده است .  
با استفاده از زیر گزینه    Text display از گزینه Text در منوی Entry  پنجره ای بصورت زیربازمیشود که 

میتوان به کمک آن محل، زاویه وسایر خصوصیات متن هاراویرایش کرد.  
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1-7      مقدمه 
پس از ورود نقاط داخل Database نرم افزار و ویرایش نقاط و ترسیم عــوارض مسـطحاتی نوبـت بـه ترسـیم 
منحنی میزان می رسد. یکی از مهمترین پردازشهائی که توسط نرم افزار SDRmap V8.01 انجـام مـی شـود 
ــیزان در نـرم افـزار فـوق بسـیار  تهیه منحنی میزان و به عبارتی دیگر انترپولاسیون است. گرچه تهیه منحنی م
ــی را صـرف  سریع و آسان است ولی در صورتی که نقاط برداشت شده مناسب نباشند باید زمان نسبتا طولات
تصحیح نقاط کرد. بنابراین هر چه دقت نقاط برداشت شــده بیشـتر باشـد دقـت ترسـیم منحنیـهای مـیزان نـیز 

افزایش می یابد. 
 

2-7   تنطیمات اولیه 
برای تهیه منحنی میزان ابتدا بایستی تنظیمات اولیه ای را انجام داد. چهارراه برای تنظیمات اولیه جهت ترسیم 

منحنی میزانها وجود دارد: 
 

از نــوار ابــزار بــالای نــــرم افـــزار و انتخـــاب زیـــر منـــوی              1. کلیک بر روی آیکون            
 Surfece Parameters

از نــوار ابــزار بــالای نــــرم افـــزار و انتخـــاب زیـــر منـــوی               2. کلیک بر روی آیکون            
 Serface Parameters

 Surface Parametrers از صفحه کلید و انتخاب زیرمنوی F9 3. زدن کلید 
 Contours>Surface Parameters 4. اجرای دستور 

 
 با اجرای هر کدام از روشهای بالا پنجره ای بفرم زیر باز می گردد: 
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در پنجره بالا  که به پنجره Surface Parameters معروف می باشد پارامترهای یک سطح منحنی میزان تعیین 
می شوند. بایستی توجه داشته باشید که پارامترهای بالا را در هر زمان که نیاز باشد می تــوان تعییـن نمـود و 
لزوما قبل از تشکیل منحنی میزان تعیین نشده و حتی می توان بعد از تشکیل منحنی مــیزان نسـبت بـه تغیـیر و 
تنظیم این پارامترها اقدام نمود. حال به توضیح هر کدام از پارامترهای تشکیل سطح منحنی میزان می پردازیم. 

 
  : Surfece 

در این قسمت نام سطح منحنی میزان ظاهر می گردد که بصورت پیش فرضSurface 1 می باشد. اگر بخواهیم 
ــه Add  از پنجـره بـالا  یک سطح جدیدی ایجاد کرده و پارامترهای آن را تنظیم کنیم ابتدا بایستی بر روی گزین

کلیک کرده تا پنجره ای مشابه زیرباز گردد: 
 

 
چون هدف ایجاد منحنی میزان بوده از پنجره بالا گزینه Contours only را فعال کرده و Ok می کنیم در ایــن 
صورت در قسمت Surface عبارت Surface 2 ظاهر می گردد. به همین صورت می توان سطوح مختلفی را بر 
روی نقاط ایجاد نمود. سپس برای فعال نمودن سطح دلخواه از پنجره Surface Parameters  بر روی قســمت 

Surface کلیک کرده وسطح مورد نظر را انتخاب کنید. 

 
توجه: 

 Surface از پنجـره Delete ــاک کنیـد ابتـدا آن را انتخـاب کـرده وبـرروی دکمـه چنانچه بخواهید سطحی را پ
Parameters کلیک نمائید. 

 
 : Maximum RL , Minimum RL 

ــیزان شـرکت خواهنـد کـرد را وارد  در این دو قسمت می توان حداقل و حداکثر ارتفاع نقاطی را که در منحنی م
ــاط موجـود در Database را شناسـائی  نمود. خود نرم افزار بصورت پیش فرض کمترین و بیشترین ارتفاع نق
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کرده و در قسمتهای فوق درج می کند. در صورت لزوم می توانید مقادیر این دو قسمت را تغییر دهید. 
 

 : Minimum Distance between points 

ــوان وارد نمـود.   در این قسمت حداکثر فاصله بین دو نقطه ای که در منحنی میزان شرکت خواهند کرد را می ت
بصورت پیش فرض این قسمت 0,001 متر یا 1 میلی متر می باشد. مقدار به نمایش درآمده در این قسمت نشان 
ــرای  می دهد که اگر فاصله دو نقطه در  Database کمتر از مقدار ظاهر شده در این قسمت باشد از نقطه اول ب

تشکیل منحنی میزان استفاده خواهد شد. 
 

   : Maximum Distance Along Edge of Triangle 

ــی گردد. درواقـع  در این قسمت حداکثر طول اضلاع مثلثهائی که در تشکیل منحنی میزان بکار می روند تعیین م
در این قسمت حداکثر فاصله نقاطی که در تشکیل منحنی میزان و مثلث بندی استفاده خواهند شد را می توان به 

نرم افزار معرفی نمود. لذا در قسمت جلوی گزینه فوق و در بخش دوم می توان این مقدار را وارد کرد.  
از این پارامتر جهت کنترل بهتر محدوده مورد نظر برای تشکیل منحنی میزان اســتفاده مـی شـود.در بخشـهای 
بعدی در مورد معرفی محدوده برای شکل دهی به منحنی ها و حذف مثلث های غیر ضــروری صحبـت خواهـد 
شد. اگر این قسمت در حالت No check باشد مقدار وارد شــده تـاثیری در تشـکیل مثلـث هـا ومنحنـی مـیزان 

نخواهد داشت. 
 

  : Maximum contour level , Minimum contour level 

در این دو قسمت می توان مشخص نمود که منحنی های میزان از چه ارتفاعی تا چه ارتفاعی نمایش داده شوند. 
ــن قسـمت تعییـن  به عبارت دیگر حداقل و حداکثر ارتفاع جهت نمایش منحنی ها بر روی صفحه گرافیکی ، در ای

می گردد. 
 

  : Minor contoure interval , Major contoure interval 

 در این دو قسمت فاصله منحنی میزانــهای اصلـی (  Major) و فرعـی (Minor ) مشـخص مـی گردد. معمـولا 
فاصله منحنی اصلی 5 برابر فاصله  منحنی های فرعی می باشد. یعنی اگر فاصله منحنی های فرعی را 1 مــتری 

انتخاب کنیم بهتر است فاصله منحنی های اصلی 5 متری باشد. 
 

پس از انجام تنظیمات لازم بر روی دکمه OK  از پنجره Surface parameters  کلیک نمائید. 
 

توجه1: 
در قسمت پائین پنجره Surfase parameters دو گزیـنه Contours وTriangles  بـه چشـم مـی خورنـد در 
ــام شـده بـه  صورتی که گزینه Contours فعال باشد منحنی ها و اگر Triangles فعال باشد مثلث بندیهای انج
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نمایش در خواهند آمد. 
 

توجه 2:  
با زدن دکمه Reset از پائین پنجره Surface parameters تمامی تنظیمات اعمال شده به حالت اولیه خــود بـاز 

گردانده خواهند شد. 
 

3-7      انتخاب نقاط جهت تشکیل منحنی های میزان 
 توصیه می شود جهت فراگیری بهتر این بخش جاب DB.EX3 را از شاخه 

Progerame files \ SDRmapping & design\Examples \  ا نتخاب نموده و فواصل منحنی های فرعی را 

 0.5 و اصلی را 2 متری قرار داده. سپس دستور زیر را جهت ایجاد  منحنی ها بکار گیرید: 

 
  Contours> Surface Area.……

توسط دستور فوق می توان نقاط مورد نیاز را جهت شرکت در انترپولاسیون انتخاب نمود. با اجــرای دسـتور 
بالا پنجره ای بصورت زیر باز می گردد: 

 

 
قبل از انتخاب گزینه دلخواه ابتدا در قسمت  Display کلیک کرده تا پس از انتخاب هر یک از گزینه های پنجــره 
بالا محدوده انتخاب شده بر روی صفحه ظاهر گردد. سپس با انتخــاب گزینـه Extents کلیـه نقـاط موجـود در 
ــاهر خواهـد شـد.بـا  Database انتخاب شده و یک کادر بر روی صفحه که در بر گیرنده کلیه نقاط می باشد ظ

استفاده از گزینه Window می توان نقاط Database را توسط یک پنجره ترسیمی انتخاب نمود. در اینصورت 
بر روی نقطه ای از صفحه کلیک کرده و در حالی که دکمه سمت چپ ماوس را پائین نگه داشــته ایـد  آن را بـه 
موقعیت جدید منتقل کرده و سپس دکمه را رها کنید. گزینه Polygon جهت انتخاب نقاط Database با اسـتفاده 
از یک چند ضلعی بسته ترسیمی بکار می رود . و در صورتی که محدوده ای از نقاط انتخاب شده باشند توسط 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01   نرم افزار
 

107  

گزینه  Additional polygon می توان یک چند ضلعی بسته دیگری را به عنوان محدوده جدید جــهت انتخـاب 
نقاط به محدوده  قبلی اضافه نمود. 

 
ــتور  در صورتی که بخواهید نقاط را از روی شماره نقاط، کد و لایه آنها انتخاب کنید بایستی پس از اجرای دس
ــره ای کـه بـاز مـی گردد منـوی Surface point selection را   Contours> Surface parameters از پنج

انتخاب نمائید. با انتخاب گزینه فوق پنجره ای به شکل زیر باز می گردد: 
 

 
در ردیف اول می توان نقاط را بر حسب شماره، در ردیف دوم برحســب کـد و درردیـف سـوم برحسـب لایـه 
ــک کـرده سـپس بـر  انتخاب کرد . .مثلا برای انتخاب نقاط از طریق شماره ابتدا توسط ماوس در ردیف اول کلی
روی دکمه Add کلیک نمائید. در این صورت پنجره ای بصورت زیر جهت انتخاب محدوده نقاط باز می گردد: 
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در قسمت Min کمترین شماره نقطه و در قسمت Max بیشترین شماره نقطه را وارد کنید . در صورتی کــه در 
پنجره بالا گزینه Include  فعال باشد محدوده نقاط انتخاب شده در تشکیل سطح ، شرکت کرده و در صــورت 

فعال کردن گزینه Exclude محدوده نقاط انتخاب شده در تشکیل سطح ، شرکت نخواهند کرد. 
 

توجه 1:  
با انتخاب هر یک از ردیف های پنجره بالا و استفاده از کلیدهای  Remove وEdit  مـی تـوان آن محـدوده را 

ویرایش و یا حذف نمود. 
 

توجه 2: 
با انتخاب هر یک از ردیف های پنجره بالا و استفاده از کلیدهای  Exclude وInclude  می توان آن محدوده را 

در تشکیل منحنی میزان شرکت داده ویا ازمنحنی میزان خارج نمود.  
 

توجه 3: 
ــی از ردیفـهای مربـوط بـه  با استفاده از دکمه  Reset و باز شدن پنجره ای بصورت زیر می توان همه و یا یک

شماره نقاط، کد نقاط و لایه را به حالت اولیه باز گرداند. 
 
 

 
4-7    تشکیل منحنی میزان  

پس از انتخاب نقاط به روش های گفته شده در بالا دستور زیر را جهت ایجاد مثلث بندیها اجراء نمائید: 
 Contours> Form model

در اینصورت مثلثهای تشکیل دهنده سطح روی صفحه بصورت زیر ظاهر خواهند شد: 
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حال برای دیدن منحنی های تشکیل شده بایستی از دستور زیر استفاده نمود: 

 Contours> Calculate contours
 

در اینصورت نرم افزار برای ذخیره منحنی ها سوال می کند که با زدن yes  منحنی ها ظاهر شده و ذخیره نیز 
می گردند. 

 
ــی هـا   توجه کنید که با هربار تغییر در وضعیت مثلثها و سایر پارامترها بایستی این عمل را تکرار کنید تا منحن
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به هنگام شوند. 
 

توجه:  
برای روشن و یا خاموش کردن منحنی ها دو راه وجود دارد: 

الف) استفاده از کلیدهای F8 وF7 .  بدین صورت که با زدن کلید F7 از صفحه کلید منحنــی هـا خـاموش و بـا 
زدن مجدد آن منحنی ها روشن می گردند. همچنین بــا زدن کلیـد F8 از صفحـه کلیـد مثلـث بندیـها خـاموش و 

بازدن مجدد آن مثلثها را می توان نمایان ساخت. 
ــتور Contours> Surface parameters و انتخـاب منـوی Modes- display  . در ایـن  ب) استفاده از دس

صورت ملاحظه خواهیــد کـرد کـه در پـائین پنجـره ظـاهر شـده دو گزینـه Triangles و contours بـه چشـم        
ــه خـاموش و یـا روشـن نمـودن  می خورد با فعال نمودن گزینه های Off وOn  برای هر یک می توان نسبت ب

منحنی ها و یا مثلث بندیها اقدام کرد. 
 

5-7    تصحیحات 
ــود خطـا و یـا اشـتباه ، ترسـیم  پس از کنترل نمایش منحنیهای میزان و یا مثلث بندی ها ، ممکن است بعلت وج
منحنی های میزان دچار مشکل شده وتوپوگرافی منطقه با واقعیت فیزیکی زمین مطابقت نداشــته باشـد. در ایـن 
ــم  صورت بایستی تصحیحات لازم را جهت واقعی نمودن توپوگرافی لحاظ نمود. که در زیر به آن اشاره خواهی

کرد. 
 

1-5-7  استفاده از خطوط شکست درتصحیح منحنی های میزان 
ــه مـانع از انـترپولاسـیون نقـاط دو طـرف ایـن خـط          خطوط شکست یا Breaklines اصالتا خط جدائی است ک

می گردد و نشان دهنده خط القعرها و خط الراسها و یا ناپیوستگی سطح می باشد. این خطوط باعث طبیعی تـر 
شدن منحنی میزانها می گردد. به عنوان مثال جاب db.ex3 را باز کرده و با دانستن شماره نقــاط سـمت چـپ، 
ــرم افـزار معرفـی  مرکز وراست نهر که به صورت زیر می باشند بایستی خطوط شکست مربوط به نهر را به ن

کنیم. 
نقاط سمت راست نهر: 78،61،41،26،46 

نقاط سمت چپ نهر: 76،59،39،24،11 
نقاط سمت وسط نهر: 77،60،40،25،45 

 
ــط ایجـاد کنیـم بنـابراین از منـوی String گزینـه Add را  برای اعمال خطوط شکست بایستی یکسری رشته خ
انتخاب کرده و سپس از قسمت  Folder پوشه Discon 1  را انتخاب ودر قسمت String ID عبارت دلخواهــی 
را مثلا RB ( مخفف  Right Bank به معنی سمت راست نهر ) وارد کرده و هنگامی که کرسر در قسمت پـائین 
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پنجره قرار گرفت نقاط سمت راست نهر را بصورت زیر تایپ می کنیم: 
 

 
 Left مخفف ) LB عبارت String ID را کلیک کرده و برای معرفی نقاط سمت چپ نهر در قسمت Apply کلید

Bank به معنای چپ نهر ) را نوشته و نقاط چپ نهر را نیز بصورت زیر تایپ می کنیم: 

 
 
  Center line مخفف ) CL عبارت String را کلیک کرده و برای معرفی مرکز نهر در قسمت Apply مجدد کلید

به معنی مرکز نهر ) را نوشته و نقاط مرکز نهر را بصورت زیر تایپ می کنیم: 
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کلید Apply و بعد کلید  Finishرا کلیک نمائید. در این صورت خواهید دید که نقاط مرکــز ، چـپ وراسـت نـهر 
بصورت رشته خطوطی به هم متصل شده وبر روی صفحه بنمایش در خواهنــد آمـد.حـال بـرای لحـاظ کـردن 
 Calculate و سپس Form model ابتدا Contours خطوط شکست ترسیم شده به سطح توپوگرافی، از منوی
contours را انتخاب نمائید. پس از  Zoom کردن در قسمت نهر ملاحظه خواهیــد کـرد کـه شـکل نـهر از روی 

منحنی های میزان مشخص بوده و نقاط دو طرف نهر با هــم انـترپولـه نشـده انـد و بـهم ریختـگی منحنـی هـا 
نیزاصلاح شده است. 

 
2-5-7     محدود کردن طول اضلاع مثلث بندی جهت تصحیح منحنی ها 

یکی دیگر از انواع تصحیحات ، محدود کردن طول اضلاع مثلثها برای تصحیح منحنی های میزان می باشد.برای 
این منظور از شاخه   programs files \ SDRmapping & design\ examples \ جـاب DB.BDY را بـاز 
کرده و فواصل منحنی های اصلی را 2/5 متری و منحنی های فرعی را 0/5 متری قرار دهید. به روش های گفته 
شده قبلی کل نقاط را مثلث بندی کنید. پس از ترسیم منحنی های میزان مشــاهده خواهیـد کـرد کـه در پـائین و 
سمت چپ نقشه یک بهم ریختگی وجود دارد و در نقاط 130 و 230 منحنی ها بصورت گوشه دار درآمــده انـد. 
ــت مثلـث هـای بسـیار بـزرگ تشـکیل شـده اسـت. در  همچنین بین نقاط 204 و 239 به دلیل آنکه فاقد نقطه اس
اینصورت برای تصحیح منحنی ها بایستی جلوی تشکیل چنین مثلث هائی که ایجــاد بـهم ریختـگی مـی کننـد را 

گرفت . 
اگر به مثلث بندیهای پروژه db.bdy با دقت نگاه کنید متوجه می شوید که بین نقاط 204 و214 یک مثلث بزرگ 
ــزرگتـر از فاصلـه نقـاط  تشکیل شده است. با بررسی این پروژه متوجه می شوید که مثلث هائی با طول ضلع ب
ــا اسـتفاده از آیـکون Join  از نـوار  204 و210, بهتر است تشکیل نشوند. لذا به کمک کلید j  از صفحه کلید وی

ــط مـاوس یـا  ابزار بالای نرم افزار در پنجره ای که بصورت زیر باز می گردد  که  با انتخاب این دو نقطه توس
صفحه کلید در می یابید که فاصله این دو نقطه از 85 متر بیشتر می باشد.  
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ــدد 85 را وارد  حال در پنجره  Surface parameters در قسمت مقابل گزینه Maxinum Distance Along ع
ــه  Form model عمـل مثلـث بنـدی را انجـام دهیـد. پـس از ترسـیم     کرده و OK کنید. .سپس مجددا  ازگزین

ــاط حـذف شـده و همچنیـن تعـدادی از  منحنی های میزان در این صورت می بینید که مثلثهای بزرگ اطراف نق
ــذا بـرای تشـکیل  مثلثهای داخل مجموعه نیز حذف می گردند. برای همین دلیل این روش زیاد قابل قبول نبوده ل
کامل مثلثها مجددا از پنجره  Surface parameters گزینه No check  را انتخاب و بعد از OK کــردن مجـددا 
ــزرگی بـوده و تراکـم  مثلث بندیها را انجام دهید.این روش بیشتر در مورد پروژه هائی که حاوی مناطق مقعر ب

نقاط در سایر قسمتها مناسب باشد مورد استفاده قرار می گیرد. 
 

3-5-7   انتخاب مثلثها و ویرایش آنها 
با اجرای دستور Contours>Edit model پنجره ای بصورت زیر باز می گردد که شامل چند گزینه است: 

 

 
در پنجره بالا سه گزینه  Clear Selection وDelete Selected Triangles وSwap triangles sides بـه 

حالت غیر فعال می باشند که پس از انتخاب مثلثها این گزینه ها فعال خواهند شد. 
 

  : Select independent Triangles 

ــه مـی توانیـد بـا  این گزینه جهت انتخاب مثلث ها بصورت تکی مورد استفاده قرار می گیرد. با انتخاب این گزین
ــدا  کلیک کردن ماوس داخل هر مثلث آن را انتخاب کنید. با انتخاب مثلث مورد نظر رنگ آن به رنگ آبی تغییر پی

کرده ولی اگر چند مثلث کنار هم را انتخاب کنید رنگ اضلاع مشترک مثلثها تغییر نمی یابند. 
 

  : Select Tris by Interseting Line 

توسط این گزینه می توانید با استفاده از ماوس خطوط فرضی را رسم کنید. وپس از  Enter نمودن هر کجا که 
این خطوط مثلثها را قطع کنند می توان آن مثلث ها را انتخاب نمود. 
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  : Select  triangles by polygon 
  Enter ــد. پـس از ترسـیم و زدن کلیـد توسط این گزینه می توانید یک چند ضلعی را بر روی مثلثها ترسیم کنی

کلیه مثلثهائی که داخل چند ضلعی قرار گرفته شده باشند را می توان انتخاب نمود.   
 
 

 Contours>Edit model>delete Selected  triangles پس از انتخاب مثلث ها میتوان با استفاده از دستور
اقدام به حذف مثلث ها نمود.  با اســتفاده از دسـتور Contours>Edit model>Clear Selection  مثلثـها از 

     Contours>Edit model>Swap triangles sidesــوند وبـا اسـتفاده از دسـتور حالت انتخابی خارج می ش
می توان دو مثلث مجاور هم را جاروب کرد. به این صورت که هر گاه دو مثلث مجاور هم را در نظر بگیریم یک 
چهار ضلعی را بوجود خواهد آورد که یک قطر آن ترسیم شده است (معمــولا قطـر کـوچکـتر ) . ایـن اصـل در 
ــد.  مواردی نقشه را از حقیقت دور می کند ونیاز است که این قطر جابجا گردد تا منحنی ها نظم مناسبی پیدا کنن
بنابراین پس از انتخاب دو مثلث مجاور هم و اجرای دستور فوق می توات همان چهارضلعی را با قطر بزرگتــر 
ــن سـه دسـتوروهمچنین  داشته باشیم. این عمل باعث تغییر شکل منحنی ها خواهد شد. راه دیگر استفاده از ای
تمامی دستورات مربوط به انتخاب مثلث ها این است که پس ازانتخاب یکی از مثلثهای مــورد نظـر دکمـه سـمت 

راست ماوس را کلیک کرده واز پنجره ای که باز خواهد شد دستورات فوق را اجرا نمود.  
 
 

4-5-7   استفاده از رشته خطوط بسته خاص جهت اصلاح منحنی ها 
 ( Inculde boundary ,  Omit boundary ) در این روش می توان توسط یک رشته خطوط بسته خــاص
محدوده مورد نظرجهت ترسیم منحنی ویا حذف منحنی را مشخص نمود. برای اســتفاده از ایـن روش بـاید بـه 

نکات زیر توجه نمود: 
 

 - رشته خطوط محدوده باید در پوشه ای بنام Bound ترسیم شوند. 

 - تمامی رشته خطوط محدوده بایستی بسته بوده از یک نقطه شروع شده و به همان نقطه ختم گردد. 

 - اگر می خواهید فضای داخل رشته خطوط محدوده را خــالی کنیـد بـاید در هنـگام ترسـیم رشـته خطـوط 

قسمت String ID را با حرف IN شروع کنید مثلا IN2 یا IN1 و … 
 - اگر می خواهید فضای بیرون رشته خطوط محدوده را خالی کنیــد بـاید در هنـگام ترسـیم رشـته خطـوط 

قسمت String ID را با حرف OUT شروع کنید مثلا  out 1, out 2و …. 
 

ــوی  String گزینـه Add را انتخـاب کـرده و رشـته خطوطـی در پوشـه  برای مثال در جاب DB.BDY از من
 Bound با String ID  به صورت  In1 که شامل نقاط زیر باشند را ایجاد کنید: 

 
 203,236,230,231,127.128,130,133,136,137,203
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پس از کلیک کردن بر روی دکمه Apply قسمت String ID را به صورت In2 تغییر داده و نقاط زیر را معرفی 
نمائید: 

 239,237,204,208,210,212,213,214.239
 
ــه  Bondaries و سـپس Contours را انتخـاب کنیـد.  پس از کلیک بر روی Finish از منوی  Contours گزین

بدین ترتیب منحنی های داخل محدوده های ترسیم شده حذف خواهند شد. 
 

توجه 1: 
 با توجه به مطلب بالا در می یابید که در این حالت منحنی های داخل محدوده حذف ولــی مثلثـها بـاقی خواهنـد 
ماند. لذا اگر محاسبات حجمی صورت گیرد حجم قسمت های داخل رشته خطوط نیز محاسبه خواهند شــد. لـذا 

در کارهای محاسباتی بایستی از این روش استفاده کرد. 
 

توجه 2:  
ــه Triangles را انتخـاب کنیـد. در ایـن صـورت  چنانچه از منوی  Contours گزینه Bondaries و سپس گزین

مثلثهای داخل محدوده ترسیمی نیزحذف خواهند شد.  
 

6-7      ذخیره منحنی میزانها 
 ( Contour>Surface parameters) ــوط بـه سـطح منحنـی مـیزان ایجـاد شـده پس از تعیین پارامترهای مرب

ـــــاط                        وانتخـــاب نقـــاط جـــهت انـــترپولاســـیون ( Contour> Surface Area)و فـــرم بنـــدی نق
 ( Contour> Form model) مشاهده خواهید کرد که مثلث بندیهای انجام شده بر روی نقاط بر روی صفحـه 

 Calculate contour ــه گرافیکی ظاهر خواهند شد. حال برای دیدن منحنی های میزان از منوی Contour گزین
ــر روی صفحـه گرافیکـی ظـاهر شـده و  را اجراء کنید.  مشاهده خواهید کرد که منحنی میزانهای ترسیم شده ب

پیغامی بصورت زیر بر روی صفحه ظاهر می گردد: 
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در این پنجره اگر بر روی دکمه Yes کلیک کنید منحنی های ایجاد شده ذخیره می گردنــد و اگر بـر روی دکمـه 
ـــائید منحنــی هــای ایجــاد شــده را مــی تــوان در مراحــل بعــدی بــا اســتفاده از دســتور                 No کلیـک نم

Contour> Save contour ذخیره نمود. 

 
توجه:  

 
ــا کـرده باشـید  چنانچه در این مرحله اقدام به ذخیره منحنی ه
  Contour >  Save contour در مراحل بعدی اگر از دستور

ــابل   استفاده نمائید ملاحظه خواهید کرد که پیغامی بصورت مق
بر روی صفحه ظاهر می گردد: 

این پیغام به این معنی است که منحنی ها در مرحله قبل ذخیره 
شده و نیازی به ذخیره مجدد نخواهید داشت. 

 
 
 

7-7     قرار دادن برچسب بر روی منحنی های میزان 
ــاید موقعیـت قـرارگیـری آنـها را  در صورتی که بخواهید منحنی میزانهای شما دارای برچسب ارتفاعی باشند ب
توسط نرم افزار مشخص نمائید. لذا از منوی  Contour گزینه Position Labels  را انتخاب کنید. دو گزینه در 
اختیار شما قرار می گیرد یکی  Atuo (اتومــاتیک ) و دیـگری  Manual (دسـتی).  گزینـه Manual را انتخـاب 
کرده و حال با استفاده از ماوس مشخص کنید که برچسب ارتفاعی در کجای منحنی قرار گیرد. به این صورت 
که ابتدا با ماوس در یک نقطه از منحنی کلیک کرده ودر حالی که دکمه ماوس پائین نگه داشته شــده بـا حرکـت 
دادن آن به مکان دیگر یک خط کشیده خواهد شد. هر کجا که این خط منحنی را قطع کند همانجا عــدد ارتفـاعی 

درج می شود. بعد از پایان کار کلید Enter را بزنید. 
 

در صورتی که به جای گزینه Manual  گزینه Auto را انتخاب کرده باشید پنجره ای بفرم زیر گشوده خواهــد 
شد: 
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در این پنجره فاصله بین برچسبها را بر حسب متر در طول منحنــی مـیزان وارد کـرده و Ok مـی کنیـم. بـرای 
مشاهده نتیجه کار به کمک کلید D ازصفحه کلید، صفحه نمایش را نوسازی کنید. 

 
 

8-7     رنگ آمیزی بین خطوط منحنی میزان 
جهت رنگ آمیزی بین خطوط منحنی میزان چندین روش وجود دارد که عبارتند از: 

 
  Surface colors 1- کلیک بر روی آیکون                از نوار ابزار بالای نرم افزارو انتخاب زیر منوی
 Surface colors 2- کلیک بر روی آیکون                از نوار ابزار بالای نرم افزارو انتخاب زیر منوی

 Surface colors از صفحه کلید و انتخاب زیر منوی F9 3- زدن کلید
 Contours> surface colors 4-  اجرای دستور

 
با اجرای هر کدام از روشهای بالا پنجره ای به شکل زیر گشوده خواهد شد: 
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  Shade by height آن را تیک دار کرده سپس گزینه  Surface colors در پنجره بالا با کلیک بر روی قسمت
ــرده و  را از سمت راست پنجره فوق فعال نمائید. در قسمتهای To به ترتیب ارتفاع منحنی های میزان را وارد ک
ــوان مثـال بـا وارد کـردن عـدد  با کلیک بر روی دکمه Colour جلوی هر To رنگ آن را نیز انتخاب کنید. به عن
179.64 در قسمت To ردیف اول و انتخاب رنگ قرمز و سپس وارد کردن عدد 182.18 در قسـمت To ردیـف 

دوم و انتخاب رنگ آبی برای آن و …… به منزله این است که از پائین ترین ارتفاع موجود در منطقه تا ارتفــاع 
179.64 فاصله بین منحنی ها با رنگ قرمز و از ارتفاع 179.64 تا 182.18 فاصله بین منحنی ها با رنگ آبی پر 

شوند. پس از ورود اطلاعات پنجره بالا را Ok کرده تا تصویری مشابه زیر ظاهر گردد: 

 
 

توجه :  
اگر بخواهید لژاندری از رنگهای بکار گرفته شده برای ارتفاعهای مختلف بر روی صفحه گرافیکی ببینید بایستی 
ــه نـیز بـر روی  از پنجره Surface Colour  گزینه Legend را فعال نموده و چنانچه بخواهید مساحت هر روی
صفحه گرافیکی به نمایش درآید گزینه Surface area را از پنجره Surface colour  فعال کنید. در این صورت 

کادری مشابه زیر در گوشه سمت چپ و بالای صفحه گرافیکی به نمایش در خواهد آمد: 
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مقدمه 
پس از ایجاد یک جاب و ورود اطلاعات به درون جاب ایجاد شده و ترسیم عوارض مسطحاتی و همچنین ایجاد 
منحنی های میزان بر روی نقاط نوبت به چاپ نقشه می رسد. گاهی اوقات نتیجه کار را می توان در یــک شـیت 
جای داد ولی در اکثر مواقع نمی توان نقشه ایجاد شده را تنها در یک شیت جای داد و نیاز به شیتهای متعـددی 
ــرد. امـا قبـل از چـاپ نقشـه  است. در نرم افزار SDRmap شیت بندی در نهایت سهولت و راحتی انجام می گی

بایستی تنظیماتی را جهت تعیین پارامترهای مربوط به پلات ایجاد شده انجام داد. 
 

1-8    تنظیمات مربوط به شیت 
جهت تعیین پارامترهای مربوط به شیت بایستی دستور زیر را اجراء کنید: 

 File> Plot Parameters> Sheet  Details
 

لذا پنجره ای بفرم زیر که به پنجره view- print- Export contorl  معروف بوده باز خواهد شد: 
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ــازی بـه وارد کـردن نـام در  در پنجره بالا اگر بخواهید مستقیما نقشه را از  SDRmap به چاپگر منتقل کنید نی
قسمت Name نخواهید داشت وتنها کافیست که بر روی دکمــه  Printer Change کلیـک کـرده تـا پنجـره ای 

بصورت زیر باز گردد: 

 
( راه دیگر باز کردن این پنجره استفاده از دستور  File> Printer  Setup می باشد ) 

دراین پنجره که به پنجره Printer setup  معروف بوده در قسمت  Name نوع چاپگر ودر قسمت Size انــدازه 
ــد تـا نقشـه بـه صـورت  کاغذ را می توان انتخاب نمود. در قسمتOrientation گزینه Landscape را فعال کنی
طولی چاپ شود. سایر تنظیمات دیگر را نیز می توان در این پنجره انجام داد. در نهایت پنجره فوق را Ok کرده 
ــوع چـاپـگر و  تا به پنجره قبل برگشته و ملاحظه خواهید کرد که در پنجره  View- Print- Export contorl ن

ابعاد کاغذ انتخاب شده در قسمتهای جلوی دکمه Printer Change به نمایش در خواهند آمد. 
 

توجه:  
 View- Print- Export contorl از پنجـره Name اگر هدف ارسال نقشه به اتوکد باشد بایستی در قســمت
نامی برای فایل خروجی در نظر گرفته شود. سپس با کلیک بر روی دکمه Browse می توان محل ذخیره فــایل 

را نیز تعیین نمود. این فایل می تواند به فرمتهای dxf, dwg, fpf  ذخیره گردد. 
 

ــه  در قسمت Bearing زاویه چرخش شیت تعیین می شود. مقیاس نقشه را در قسمت Scale معرفی نماید. توج
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داشته باشید که فقط مخرج کسر مقیاس در این قسمت وارد می گردد بعنوان مثــال اگر هـدف مقـایس 1:2500 
باشد کافیست که در قسمت  Scale عدد 2500 را وارد کنید. در قسمتهای Origin E وOrigin N  مختصـات 

       Shift Y mm,sو Shift X mm,s گوشه سمت چپ و پائین شیت خروجی معرفی می گردد. در قسمتهای
ــه روی کـاغذ معیـن نمـود. در قسـمت  Sheet plotiiing distance در بخـش          می توان حاشیه ای برای نقش

 X mm,s اندازه طولی و در بخش Y mm,s اندازه عرض نقشه چاپ شده بروی کاغذ را می توان کنترل نمود. 

حال اگر بخواهیم نقشه تحت سیستم مختصات جهانی به اتوکد ار سال گردد در قسمت Dwg export as گزینه 
World coordinates و در صورت تمایل به انتقال نقشه بصورت سیستم مختصــات محلـی بـه اتوکـد گزینـه 

Paper coordinates را فعال می کنیم. با فعال کردن قسمت 3D to dwg/ dxf  هنگام ارسال نقشه بــه اتوکـد، 

ــاده  می توان یک فایل سه بعدی نیز تهیه نمود. در صورتی که قسمت  Border فعال باشد می توان یک کادر س
ــواع دیـگری از کادرهـا را  به دور نقشه ترسیم نمود وبا کلیک کردن بر روی  فلش مقابل این قسمت می توان ان
ــدی را تعییـن کـرد. در صـورت انتخـاب  انتخاب نمود. در قسمت Grid می توان نوع خطوط مربوط به شبکه بن
None هیچ شبکه ای بر روی نقشه مشاهده نخواهد شد. در قسمت Interval در صورت انتخــاب شـبکه بنـدی 

فواصل خطوط شبکه که معمولا یک دهم مقیاس بوده معرفی می گردد. به عنوان مثال اگر مقیاس 1:2500 باشد 
بایستی فواصل خطوط شبکه بندی را 250 متری انتخاب نمود. در صورتی که قسمت  Annotation فعال باشد 
ــوان  مقادیر مربوط به خطوط شبکه بندی بر روی خطوط شبکه درج خواهند شد. در سایر قسمتهای دیگر می ت

رنگ و نوع خطوط و نوع نوشته های مربوط به خطوط شبکه بندی را معرفی کرد. 
 

2-8 تنظیمات مربوط به نقاط 
برای کنترل پارامترهای مربوط به پلات نقاط بایستی دستور زیر را اجراء کرد: 

 File> Plot parameters> Point param
بنابراین پنجره ای مشابه پنجره زیر باز خواهد شد: 
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با فعال نمودن گزینه Points می توان تعیین نمود که نقاط در پلات ایجــاد شـده دیـده شـوند. در ردیـف پـائین 
گزینه Points با کلیک یر روی فلش می توان سمبل مربوط به نقاط را انتخاب کرد که معمولا . می باشد. 

ــه  در قسمتهایPen و Size  می توان رنگ، اندازه نقاط و در قسمت Layer  نام لایه ای که در صورت ارسال ب
ــخصه هـائی کـه  اتوکد نقاط در آن قرار خواهند گرفت را اختصاص داد. در قسمتهای پائین پنجره می توان مش
بایستی در کنار نقاط چاپ شوند را تعیین نمود. بعنوان مثال اگر بخواهیم کنار نقاط ارتفــاع درج گردد بایسـتی 
قسمت Heights را فعال نمائیم. پس از انتخاب هر مشخصه می توان در قسمتهای جلوی آن رنگ، اندازه، زاویه 
چرخش و نام لایه ای در صورت انتقال به اتوکد، تعداد ارقام اعشار آن مشخصه را تعیین نمود. در جلــوی هـر 
ــه بتـوان محـل درج هـر  مشخصه دو قسمت بنامهای X off وY off وجود دارد. این دو گزینه برای آن است ک
مشخصه را اندکی حرکت داد زیرا در صورتی که دو مشخصه را انتخاب کنیــد ایـن دو مشـخصه در چـاپ بـر 
روی هم خواهند افتاد. لذا می توانید با وارد کردن مقادیری در قسمتهای فوق محل درج مشخصه دوم را جابجا 
ــر مـی باشـند را بـا اسـتفاده از  کنید. پس از معرفی پارامترهای نقاط می توان نقاطی را که برای چاپ مورد نظ

دستور زیر انتخاب نمود: 
 File> Plot Parameters> Point Selection

با اجرای دستور فوق پنجره ای مشابه زیر باز می گردد: 
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در مورد این پنجره و چگونگی انتخاب نقاط در فصل مربوط به منحنی میزان صحبت شد. ( صفحه 107 ) 
 

3-8 تنظیمات مربوط به خطوط 
برای کنترل پارامترهای مربوط به چاپ خطوط بایستی دستور زیر را اجراء کرد: 

 File> Plot parameters> String Param
با اجرای دستور بالا پنجره ای بصورت زیر باز می گردد: 

 
ــه 88 صحبـت شـد. پـس از معرفـی پارامترهـای خطـوط مـی تـوان  در مورد این پنجره در فصل خطوط صفح

خطوطی را که برای چاپ مورد نظر می باشند را با استفاده از دستور زیر را انتخاب نمود: 
 File> Plot parameters> String selection

 
با اجرای دستور فوق پنجره ای مشابه زیر باز می گردد: 
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در مورد این پنجره و چگونگی انتخاب خطوط در فصل مربوط به خطوط صحبت شد ( صفحه 82 ) 
 

4-8    تنظیمات مربوط به منحنی های میزان 
برای تعیین پارامترهای مربوط به چاپ منحنی های میزان از دستور زیر استفاده کنید: 

 File> Plot parameters> Contours
با اجرای دستور بالا پنجره ای مشابه پنجره زیر گشوده خواهد شد: 
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ــان چـاپ منحنـی هـا فراهـم گردد. سـپس  اولین گزینه این پنجره Contours  می باشد. آن را فعال کرده تا امک
گزینه Smooth را فعال کنید. به تناسب مقدار وارد شده در قسمت Factor منحنی های میزان نرم خواهند شــد. 
مقدار پیش فرض برای این قسمت 0.4  می باشد. توجه کنید که هر چه این عدد کوچکتر باشد میزان نرم شدگی 
منحنی ها کمترو امکان تداخل منحنی ها نیز کمتر بوده و هرچه این عدد بیشترباشد میزان نرم شدگی منحنی ها 

بیشتر و امکان تداخل نیزبیشتر خواهد شد. عدد وارد شده در این قسمت بایستی بین صفر الی یک باشد. 
 

ــت  در قسمت Major contours  در بخش ve+ رنگ، نوع خطوط و لایه مربوط به منحنی های میزان اصلی مثب
ــه همیـن  و در بخش Ve– رنگ، نوع خطوط، لایه مربوط به منحنی های میزان اصلی منفی مشخص می شوند. ب
ــه مربـوط بـه منحنـی هـای مـیزان  صورت در قسمت Minor contours در بخش ve+ رنگ، نوع خطوط و لای

فرعی مثبت و در بخش Ve– رنگ، نــوع خطـوط، لایـه مربـوط بـه منحنـی هـای مـیزان فرعـی منفـی مشـخص          
می شوند. 

 
قسمت  Major Label را فعال کرده سپس رنگ، اندازه، تعداد ارقام اعشــار و نـام لایـه مربـوط بـه بـرچسـب 
ــر چسـب ارتفـاعی بـر  ارتفاعی خطوط منحنی میزان اصلی را مشخص سازید. در صورت تمایل به قرارگیری ب

روی خطوط منحنی میزان فرعی قسمت Minor Label را نیز فعال نمائید.  
 

در صورتی که قسمت Triangles فعال گردد مثلث بندیهای انجام شده بر روی نقاط با رنگ تحت لایه مشخص 
شده بر روی پلات دیده خواهند شد. پس از انجام تنظیمات بالا پنجره فوق را Ok نمائید تا تنظیمات ثبت گردند. 

 
 

5-8      موقعیت پلات 
 File از منـوی  Position  plot window پس از اعمال تمامی تنظیمات گفتــه شـده در بـالا بـه کمـک گزینـه
محدوده مورد نظر برای چاپ را بر روی صفحه گرافیکی انتخاب کنید. در اینصورت کادر سفید رنگی مطابق با 
سایز کاغذ و مقیاس مشخص شده در گزینه  Plot  parameters ظاهر خواهد شد. توسط مــاوس کـادر سـفید 

رنگ فوق را در جای مناسب و دلخواه خود قرار دهید. 
 
 

6-8     نمایش قبل از چاپ 
از منوی File گزینه Print preveiw را کلیک نمائید. در اینصورت پنجره ای بصورت زیر باز می گردد. در این 
ــه مـانیتور مشـاهده  پنجره شما می توانید قبل از چاپ کردن نقشه و یا ایجاد یک فایل اتوکد آنرا بر روی صفح

نمائید.  
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سپس در این پنجره با زدن دکمه Print و باز شدن پنجــره ای بصـورت زیـر آنچـه را کـه در صفحـه مـانیتور     
می بینید را می توان به همان شکل چاپ کرد.  

 
 
 
 
 
 
 
 
 

  8-8
 
 
 
 
 

راه دیگر باز شدن این پنجره استفاده از دستور File>Print و یا استفاده از کلیدهــای  Crl+ p صفحـه کلیـد   
می باشد. 
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در این فصل به چگونگی ورود اطلاعات مربوط به یک پیمایش، همچنیــن چـک کـردن خطـای بسـت پیمـایش و 
سرشکنی و در انتها ذخیره نقاط سرشکن شده به دیتابیس نرم افزار خواهیم پرداخت. 

 
1-9    ورود اطلاعات یک پیمایش با داشتن ژیزمان هر امتداد 

فرض کنید که اطلاعات زیر مربوط به یک پیمایشی است که اندازه گیری شده است. حال می خواهید آن را وارد 
نرم افزار نموده و محاسبات لازم را بر روی آن انجام دهید. 

 
 from pt                   to pt                     Bearing                        Vert.Angle                    Distance

  
  1                              2                    16’35′15″                       93°15′20                       134.828  

    2                               3                     83°45′05″                      88°27′30                        103.127 
 3                                4                    67°04′55″                       86°12′25                        101.051 

      4                               5                    111°47′30″                     92°14′55                        158.772 
  5                              6                  191’56′20″                       93°04′15                        77.511   

    6                               7                   142°33′15″                      90°30′30                        97.174   
 7                                8                  241°28′20″                       87°12′40                       106.076  

      8                               9                   276°22′45″                     88°13′50                        151.522  
  9                           10                  306’07′20″                       90°30′00                        95.150    

    10                              1                  274°41′40″                      89°45′00                        102.827  
 

  X= 2500, Y=1555, Z=200  عبارتست از  S1 ومختصات ایستگاه استقرار
 

جهت نیل به این هدف از منوی File با استفاده از دستور New به روش گفته شده قبلی یــک جـاب جدیـد مثـلا 
DB.TRV ایجاد نمائید. سپس از منوی Entry  گزینه Traverse Network را انتخاب کنید. پنجره ای به شکل 

زیر خواهد شد: 
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در این پنجره به همان روشهائی که در فصل ورود اطلاعات گفتــه شـد بـر روی دکمـه New  کلیـک نمـائید تـا 
پنجره ای بفرم زیر گشوده گردد: 

 
 

در خط اول پنجره فوق که عبارت Stn ظاهر شده و مخفف  Station به معنای ایستگاه است مختصات ایستگاه 
ــط دوم  استقرار شماره 1 را وارد کرده سپس Enter کنید تا علامت چشمک زن به خط بعدی منتقل شود. در خ
ــا ورود بـه هـر  با کلیک بر روی علامت فلش نوع نقطه را از Stn به Traverse تغییر دهید. توجه داشته باشید ب
خط جدید عبارت Stn ظاهر خواهد شد و چون ما از این به بعد با Traverse سرو کــار داریـم بـهتر اسـت کـه 

حالت Traverse را بعنوان پیش فرض انتخاب کنیم. 
 لذا برای این منظوردستور  Options> Entry Type> Traverse را بکار برید.  توجــه داشـته باشـید کـه در 
مورد اکثر گزینه و آیکونهای مربوط به پنجره بالا در فصل ورود اطلاعات صحبت شده و جهت جزئیات بیشتر 
توصیه  می شود که ابتدا فصــل ورود اطلاعـات سـپس ایـن فصـل را مطالعـه فرمـائید. پـس از انتخـاب حـالت 
Traverse در سایر ستونهای دیگر اطلاعات مورد نیاز را وارد کرده و Enter نمائید تا به ردیف بعــدی منتقـل 

شوید. سایر اطلاعات مربوط به ایستگاه های دیگر را به همین ترتیب تا انتها وارد کنید.  
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توجه کنید که From point شماره نقطــه مبـداء، To point شـماره نقطـه قراولـری،  Ang / Bear ژیزمـان 
امتدادها،  Vert زاویه عمودی،  Pt code کد نقطه می باشد. همچنین اگر بخواهید زاویه ″15 ′35 °16 را وارد 

کنید آنرا بصورت 16.3515 تایپ کرده و Enter نمائید. 
این نرم افزار قادر است پیمایشهائی تا بی نهایت ضلع را سرشکن و محاسبه کنــد ولـی بیشـتر نـرم افزارهـای 

ــش از 12 ضلـع نیسـتند. حـال بایسـتی مسـیر پیمـایش را بـه        نقشه برداری قادر به سرشکنی پیمایشهائی با بی
نرم افزار معرفی نمائیم. برای این منظور بر روی خط دوم مــی رویـم و کلیـد  Insert را مـی زنیـم سـپس در 
ــارت زیـر  فضای خالی ایجاد شده نوع نقطه را Fnote  انتخاب کرده و در خانه خالی روبروی آن یکی از دو عب

را به دلخواه وارد می کنیم TR 1.10, 1 یا  TR 1,2,3,4,5,6,7,8,9,10,1 . هـر یـک از ایـن دوعبـارت نشـان    
می دهد که پیمایش از نقطه 1 شروع شده و مجددا پس از نقطه 10 به همان نقطه 1 متصل گردیده است و شکل 

حاصل یک پیمایش بسته را نشان می دهد. در زیر نمونه پر شده ای از مثال فوق آمده است. 

 
1-1-9 محاسبه دقت و خطای پیمایش 

ــا اینکـه بـر  پس از ورود اطلاعات پیمایش از منوی  Options گزینه Calculate misclose را انتخاب کرده و ی
روی آیکون  Re   کلیک نمائید. مشاهده خواهید کرد که در قسمت بالای پنجره خطای بســت پیمـایش محاسـبه 

شده و همچنین دقت و محیط پیمایش نیز به نمایش در آمده است. 
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ــوان نسـبت بـه  در این مثال ملاحظه می کنید که دقت پیمایش 1:24147 بوده که قابل قبول می باشد. حال می ت
سرشکنی آن اقدام نمود. جهت سرشکنی از منوی Option  گزینه Traverse adjustment options را انتخاب 

کرده تا شش گزینه بصورت زیر در اختیار شما قرار گیرد: 

 
برای سرشکنی مثال فوق می توانید از سه روش  Compass, Transit , Bowditch اسـتفاده نمـائید. توجـه 
ــه بـا حـرف  داشته باشید جهت انتخاب هر یک ازگزینه های پنجره فوق می توانید از آیکونهای مربوط به آنها ک

اول آنها شروع شده استفاده کنید. مثلا آیکون    A      از نوار ابزار بالای نرم افزار مخفف سرشکنی بــه روش  
 Angular adjvstment و یا آیکون  B        مخفف سرشکنی به روش Bowditch می باشـد. پـس از انتخـاب 

یکی از روشهای گفته شده بالا عمل سرشکنی صورت گرفته ولی تغییری در اطلاعات خــام تـایپ شـده اعمـال 
نخواهد شد. 

 
2-1-9 محاسبه و نمایش مختصات نقاط 

جهت محاسبه مختصات نقاط سرشکن شده دستور زیر را اجراء کنید: 
 Options> Calculate coordinates
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همچنین جهت مشاهده مختصات نقاط سرشکن شده کافیست که دستور زیر را اجراء نمائید: 
 Options> Show coordinates
پس از مشاهده مختصات نقاط سرشکن شده ملاحظه خواهید کرد که مختصات آخرین نقطه برابر با مختصـات 
ــرا نـیز بـه کمـک  ایستگاه استقرار خواهد بود. اما از لحاظ ارتفاعی 35 میلی متر خطا وجود دارد که می توان آن

حالت Heigh adjusment و یا استفاده ازآیکون  H     سرشکن کرد. 
 

3-1-9     ذخیره نقاط به دیتابیس 
جهت ذخیره نقاط سرشکن شده به دیتابیس نرم افزار از دستور زیر استفاده کنید: 

 Options> Store data in Database
در اینصورت پنجره ای بصورت زیر باز می گردد: 

  
 

 
در این پنجره که در فصلهای قبل در مورد آن صحبت شده در صورت انتقال کل نقاط به دیتابیس گزینه All و 
در صورت انتقال بخشی از نقاط به دیتابیس گزینه Point range را فعال کنید. سپس بر روی دکمــه Ok کلیـک 
کرده و از پنجره ورود اطلاعات خارج و یا آن را ببندید و سپس با زدن دکمه Z و سپس دکمهE  از صفحه کلید 

کل نقاط را بر روی صفحه گرافیکی مشاهده فرمائید. 
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2-9 پیمایش زاویه ای 
فرض کنید یک پیمایش زاویه ای به شکل زیر موجود می باشد: 

 
 
 
 
 
 
 
 
 
 
 

حال می خواهیم اطلاعات مربوط به پیمایش بالا را وارد نرم افزار کرده و محاسبات لازم را انجام دهیــم. روش 
ورود اطلاعات فوق همانند وارد کردن اطلاعات پیمایش به صورت ژیزمانی بوده و اندک تفاوتهائی دارد کــه بـا 

توجه به جدول پر شده زیر آنها را بررسی می کنیم: 
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در خط اول پنجره بالا مشخصات ایستگاه استقرار شماره 1 را وارد می کنیم. در خط دوم کــه بـه خـط توجیـه 
معـروف بـوده نـوع نقطـه را از STN بـه Bsite تغیـیر داده و در قســـمت At point  عــدد 1 و در قســمت                 

ــه بـر روی نقطـه    To point  عدد 2 و در قسمت Ang /Bear صفر را وارد می کنیم . این به این معنی است ک
ــه را بـه Fnote تغیـیر داده و عبـارت      یک مستقر شده و به نقطه دو صفر صفر کرده ایم. در خط سوم نوع نقط

TR  1,2,3,4,1 را تایپ می کنیم. این به این معنی است که پیمایش از نقطه 1 شروع و مجدد به همان نقطه ختم 

شده است . در خط چهارم در حالی که نوع نقطه در حــالت Fnote بـوده عبـارت Angle را بـه خـاطر پیمـایش 
زاویه ای تایپ می کنیم. در خط پنجم نوع نقطه Fnote بوده و عبارت Anti clockwise را تایپ کنید. 

در ردیف های بعدی با توجه به اینکه نوع نقطه را Traverse انتخاب کرده اید اطلاعــات مربـوط بـه پیمـایش را 
ــت کنیـد در اینجـا وقتـی از  وارد کنید. توجه داشته باشید که ژیزمان امتداد 1 به 2 برابر 45 درجه می باشد. دق
ــه هـای سـاعت  نقطه 1 به سمت چپ حرکت می کنیم و زاویه ای داخلی را قرائت کرده ایم در خلاف جهت عقرب
هستیم پس برای همین عبارت  Anticlockwise را تایپ کرده ایم و در انتها نوع نقطــه را بـه حـالت Close در 
 Calculate گزینـه Options  ــم. پـس از اتمـام عملیـات ورود اطلاعـات از منـوی آورده و پیمایش را می بندی
ــد. ملاحظـه خواهیـد  misclose را اجراء کرده تا دقت و همچنین محیط پیمایش در بالای پنجره به نمایش در آی

 Option در زوایا وجود دارد. جهت سرشــکنی آن از منـوی misclose, Ang کرد که یک درجه خطا در قسمت
گزینه Traverse adjustment options و سپس زیر گزینه Angular adjustment را انتخاب کــرده تـا زوایـا 
سرشکن شوند. ملاحظه خواهید کرد که 1 درجه به 4 تا 15 دقیقه تقسیم شده و بین زوایا سرشکن مــی شـوند. 
  Show coordinates و Calculate coordinates سپس جهت محاسبه مختصات و نمایش آنها از گزینه های

از منوی Options استفاده نمائید. 
حال برای سرشکنی مختصات بدست آمده می توانیداز روش Bowditch جهت سرشــکنی اسـتفاده نمـائید. در 

این صورت پیغامی بصورت زیر باز می گردد: 
 

 
 

ین پیغام بدین معنی است که مقادیر تصحیح شده به روز در آمده و نمایش داده شوند.  کــه بـا کلیـک بـر روی 
دکمه Ok مختصات سرشکن شده بر اساس مقادیر جدید بدست خواهد آمد. 

 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01 نرم افزار
 

140
 

 

 
در انتها پس از بدست آوردن مختصات نقاط سرشکن شده جهت ذخیره نقاط به دیتابیس نرم افزار از دســتور 
ــد کـل  Options>Store data in database استفاده کنید. سپس با زدن دکمه Z و سپس دکمه E از صفحه کلی

نقاط را بر روی صفحه گرافیکی مشاهده فرمائید. 
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1-10      مقدمه       
برای نمایش پستی و بلندی زمین در طول یک امتداد مانند مسیر راه یا مسیر کانال بر روی نقشــه، یـک صفحـه 
ــرش را بـا مقیـاس مشـخصی بـر روی  قائم فرضی بر امتداد مورد نظر مرور می دهند اگر تصویر نیمرخ این ب
 (profile  ) ــل صفحه کاغذ ترسیم نمائیم، تصویر مزبور که حاوی پستی و بلندیهای موجود می باشد به پروفی
ــی جـهت آب رسـانی و نـیز نفـت رسـانی و غـیره،  موسوم است. در بعضی از کارهای مهندسی مانند لوله کش
ــگر از کارهـای عمومـی مهندسـی  پروفیل طولی به تنهایی جوابگوی عملیات مربوطه می باشد ولی در برخی دی
مانند جاده سازی، کانال کشی و غیره چون باند نسبتا عریضی مــورد اسـتفاده قـرار خواهـد گرفـت  وضعیـت 
ــرای مشـخص کـردن عـوارض طرفیـن  طرفین محور مرکزی تا چندین متر در هزینه کار موثر است. بنابراین ب
محور مرکزی، احتیاج به تهیه مقاطع عرضی است. در این حالت پس از انتخــاب عمودهـایی بـر مسـیر و تعییـن 
ــط  نقاط مورد نظر به فواصل مشخص بر روی خط عمود، پس از ترازیابی می توان ارتفاع نقاطی که بر روی خ
عمود قرار دارند را تعیین نموده و با توجه به ارتفاع و فاصله از محور مرکزی مسیر شروع بــه ترسـیم مقـاطع 

عرضی مذکور نمود. 
برای ترسیم پروفیلها و مقاطع در نرم افزار SDRmap V8.01 طرق مختلفی وجود دارد که در زیر به توضیــح  

روشهای متداول آن خواهیم پرداخت. 
 

2-10     تهیه پروفیل و مقطع از روی کیلومتراژ ، ارتفاع و فاصله از محور 
ــه ازمحـور مرکـزی (  offset) و ارتفـاع   ( Reduced level) نقـاط  با داشتن کیلومتراژ (chainage) ، فاصل
ــرم افـزار نمـود. در زیـر تعـدادی از اطلاعـات  برداشت شده می توان اقدام به ترسیم پروفیل و مقاطع در این ن
مربوط به پروفیلها و مقاطع عرضی برداشت شده زمین اولیه وثانویه نشان داده شده است. ستون اول مربـوط 
به شماره نقاط برداشت شده زمینی( point number)، ستون دوم مربوط بــه کیلومـتراژ نقـاط برداشـت شـده 
( chainage)، ستون سوم مربوط به فاصله از محور مرکزی مسیر (offset ) و ستون چهارم مربوط به ارتفاع 

محاسبه شده نقاط زمینی (Reduce level ) می باشد. 
 

اطلاعات مربوط به پروفیلها و مقاطع عرضی برداشت شده زمین اولیه: 
 1      0+840.00 0 83.011

  2    0+840.00 -9 84.407
 3   0+840.00 -19 86.172
 4  0+840.00 10 81.035
 5  0+840.00 15 81.011
 6  0+840.00 18 80.531
 7  0+880.00 0 82.213
 8  0+880.00 -10 83.431
 9  0+880.00 -17 83.821
 10 0+880.00 10 82.020
 11 0+880.00 14 81.080
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 12 0+880.00 17 82.341
 13 0+920.00 0 93.290
 14 0+920.00 -9 93.461
 15 0+920.00 -12 91.595
 16 0+920.00 -17 87.181
 17 0+920.00 -26 83.418
 18 0+920.00 10 89.979
 19 0+920.00 20 86.689
 20 0+940.00 0 89.689
 21 0+940.00 5 90.111
 22 0+940.00 12.20 91.198
 23 0+940.00 -3 88.100
 24 0+940.00 -12.30 87.269
 25 0+960.00 0 91.000
 26 0+960.00 5 90.500
 27 0+960.00 11.30 88.300
 28 0+960.00 -5 89.400
 29 0+960.00 -13 92.200
 
 

اطلاعات مربوط به پروفیلها و مقاطع عرضی برداشت شده زمین ثانویه: 
 1      0+840.00 0 84.300

  2    0+840.00 -9 83.310
 3   0+840.00 -19 85.300
 4  0+840.00 10 82.195
 5  0+840.00 15 82.200
 6  0+840.00 18 79.100
 7  0+880.00 0 83.200
 8  0+880.00 -10 84.400
 9  0+880.00 -17 85.121
 10 0+880.00 10 80.132
 11 0+880.00 14 81.400
 12 0+880.00 17 83.100
 13 0+920.00 0 92.121
 14 0+920.00 -9 92.131
 15 0+920.00 -12 89.300
 16 0+920.00 -17 88.500
 17 0+920.00 -26 83.600
 18 0+920.00 10 89.225
 19 0+920.00 20 88.921
 20 0+940.00 0 90.222
 21 0+940.00 5 89.321
 22 0+940.00 12.20 90.321
 23 0+940.00 -3 89.321
 24 0+940.00 -12.30 88.421
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 25 0+960.00 0 89.369
 26 0+960.00 5 90.659
 27 0+960.00 11.30 89.222
 28 0+960.00 -5 90.311
 29 0+960.00 -13 93.871

 
توجه: 

ــه بـر روی محـور مرکـزی  در ستون مربوط به فاصله از محور مرکزی (offset ) ملاحظه می کنید که نقاطی ک
قرار گرفته اند را با عدد صفر و نقاط سمت راست محور مرکزی را با اعداد مثبــت و نقـاط سـمت چـپ محـور 
ــد بـود. در ایـن  مرکزی با اعداد منفی نشان داده شده اند. همیشه جهت مسیر به اطرف افزایش کیلومتراژ خواه

صورت همواره دست راست، سمت راست مسیرو دست چپ، سمت چپ مسیر را مشخص می کند. 
 

حال با توجه به مطالب بالا جهت ورود اطلاعات  مربوط به پروفیلها و مقاطع برداشت شده زمین اولیه وترسیم 
آنها بایستی مراحل زیر را طی نمود: 

 ( db.profile مثلا جاب ) و ایجاد یک پروژه جدید SDRmap  الف) ورود به نرم افزار
ب) اجرای دستور  Entry> Reduced level . با اجرای دستور فوق پنجره ای به شکل زیر گشوده می گردد: 

 
 

ــرده و در قسـمت Level number شـماره ای را بـه فـرم   در پنجره بالا ابتدا گزینه Level sheet را انتخاب ک
ایجاد شده نسبت دهید ( بطور پیش فرض 1 می باشد) . در پنجره بالا همانطور که مشاهده می کنید در قســمت 
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Path عبارت D:\program files\sdrmapping & design\Examples\lvlsh1.profile ظاهر شده است . در 

ــرم دیـگری را  صورت وجود چنین فرمی در نرم افزار می توان با  استفاده از دکمه Open Existing  آن ویا ف
که از قبل موجود می باشد را باز نموده و یا با کلیک بر روی دکمه New  می توان یک فــرم جدیـدی را ایجـاد 
نمود. هدف ایجاد یک فرم جدید می باشد لذا با کلیک کردن بر روی دکمه New پنجره ای به صورت زیر ظاهر 

خواهد شد: 

 
در این پنجره شماره مسیری که اطلاعات پروفیلها و مقاطع مربوط به آن می باشــد، سـوال مـی گردد. بـا وارد 
کردن شماره ای دلخواه در قسمت مربوطه ( مثلا 1 ) پنجره فوق راOk نمائید. در این صورت پنجــره ای بفـرم 

زیر گشوده خواهد شد: 
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ــد. بـر روی  در پنجره بالا  عبارت Lvlsh1.profile نام فرم وrd1  شماره مسیر را که 1 میباشد ، نشان می ده
   Pt , Chain ,Offset ,RL ,Code را بزنید تا خط دوم فعال گردد. سپس در ستونهایenter  کلید rd1 عبارت
شماره نقاط، کیلومتراژ، فاصله از محور مرکزی، ارتفاع محاسبه شده نقاط، کد نقاط را وارد کنید. پــس از وارد 
کردن اطلاعات مربوط به هر نقطه کلید Enter را زده تا به خط بعــدی برویـد. در زیـر فـرم تکمیـل شـده ای از 

نحوه ورود اطلاعات ارائه شده نشان داده شده است: 

 
ــورت لـزوم مـی توانیـد بـا اسـتفاده  پس از پایان تایپ اطلاعات مربوط به برداشت  نقاط مسیرشماره 1 در ص
ازآیکون                  و یا دستورهای  File> save و یا File> save as  فرم ایجاد شده را ذخــیره نمـود و در 
صورت نیاز با استفاده از آیکون               و یا دســتور File>print از فـرم ترازیـابی پرینیـت گرفـت. قبـل از 
ــن صـورت پنجـره ای  گرفتن پرینیت می توان آن را با استفاده از دستور  print preveiw مشاهده نمود. در ای

بصورت زیر مبنی بر تعداد خطوط چاپ شده در هر برگ ظاهر خواهد شد:  w
w
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پنجره فوق را  Ok کرده تا پیش نمایشی از اطلاعات چاپ شده بصورت زیر باز گردد: 

 
پس از تائید موارد فوق با کلیک بر روی دکمه Print اطلاعات به چاپگر ارســال و بـر روی کـاغذ چـاپ خواهـد 

  Store Data in Database گزینه Options از منوی Database شد.حال برای انتقال اطلاعات تایپ شده به
را کلیک نمائید. با اجرای دستورفوق پنجره کوچکی بفرم زیر گشوده می شود: 

 
این پنجره به ما اجازه می دهد که بتوان محدوده ای از نقاط و یا همه نقاط موجود در فرم ایجاد شده را انتخاب 
نمود. شما گزینه All را انتخاب کرده و Ok نمائید. سپس با کلیک کردن بر روی آیکون        و یـا اجـرای 
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دستور File>exit از پنجره فوق خارج شوید. در هنگام خروج پنجره ای جهت ذخیره اطلاعات ظاهر مــی گردد 
ــرای همیـن بـر روی  پنجره فوق را yes کنید. توجه داشته باشید که در این مرحله نقاط هیچ مختصاتی ندارند ب
صفحه گرافیکی دیده نمی شوند. حال برای دیدن پروفیل از منوی Road گزینه Display & ploting را انتخاب 

نمائید. چهار گزینه دیگر در اختیارتان قرار می گیرند که عبارتند از: 
 

 •  Display profile: جهت نمایش پروفیل طولی 
 • Profile parameters : جهت انجام تنظیماتی در مورد پروفیل طولی 

 •  Display section: جهت نمایش مقاطع عرضی 
 • Section parameters : جهت انجام تنظیماتی در مورد مقاطع عرضی 

 
توجه: 

ــه را وارد نـرم افـزار  به روش گفته شده در بالا اطلاعات مربوط به پروفیلها و مقاطع برداشت شده زمین ثانوی
 Level ــد شـد . در قسـمت کنید. در اینجا پس از اجرای دستور Entry>Reduced levels پنجره ای باز خواه
 number عدد 2 را وارد کرده و سپس بر روی دکمه New کلیک کنید. سپس در پنجره باز شده شماره مسـیر 

2 را وارد کرده و Ok نمائید. در اینصورت پنجره ای باز خواهد شد که می توان اطلاعات مربوط به پروفیلها و 
مقاطع برداشت شده زمین ثانویه را بصورت زیر به نرم افزار معرفی نمود: 
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3-10     مشاهده پروفیلها و مقاطع عرضی  
ــه Display profile را اجـرا نمـائید.  پروفیلـهای   از منوی  Road گزینه Display & plotting و سپس گزین
طولی مربوط به مسیری با اطلاعات وارد شده مشاهده می شود. این پروفیل مربوط به مسیر شماره 1 و نقــاط 

روی محور مرکزی مسیر شماره 1 می باشد.  

 Display & plotting گزینه  Road  در صورت نیاز به مشاهده پروفیل مسیر شماره 2 مجددا از منوی
 و سپس گزینه Profile parameters را انتخاب کرده و برگه Reference  را کلیک کرده تا پنجره ای بصورت 

زیر باز گردد: 
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ــرده ودر قسـمت  از پنجره بالا بر روی ردیف شماره 2 کلیک کرده و در قسمت #Rd شماره مسیر 2 را وارد ک
Plot رنگ و نوع خطوط مسیر شماره 2 را انتخاب کرده و Ok کنید. در اینصــورت مشـاهده خواهیـد کـرد کـه 

پروفیل مسیر شماره 2 به صورت زیر بر روی پروفیل مسیر شماره 1 قرار گرفته است . 

 
ــاطع  مجددا از منوی  Road گزینه Display & plotting و سپس گزینه Display section را اجرا نمائید تا مق

عرضی مربوط به مسیر شماره 1 مشاهده  گردد. 
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 در پنجره ظاهر شده اولین مقطع عرضی مشاهده خواهد شد به کمــک دکمـه Next از پـائین پنجـره مـی تـوان 
سایر مقاطع را نیز مشاهده نمود. دکمه Start جهت مشاهده اولین مقطــع و دکمـه End جـهت مشـاهده آخریـن 
مقطع بکار می رود. با دکمه prev می توان مقاطع را از انتها به ابتدا مشاهده نمود. با دادن کیلومتراژ مورد نظر 

در قسمت Chainage از پائین پنجره  می توان مقطع مربوط به آن کیلومتراژ را مشاهده نمود.  
ــرده  جهت نیاز به مشاهده مقاطع عرضی مسیر شماره 2 بر روی مقاطع مسیر شماره 1 دستور زیر را اجراء ک

و بر روی برگه CS reference  کلیک نمائید. در اینصورت پنجره ای بشکل زیر گشوده گردد: 
 Road>Display & plotting > Section parameters

 
 

 
در ریف 2 از پنجره بالا کلیک کرده و شماره مسیر مورد نظــر (مسـیر شـماره 2 ) را در قسـمت #Road وارد 
کرده و سپس در قسمتهای  Pen وLinetype  رنگ و نوع خط مسیر شماره 2 را انتخــاب کـرده و Ok نمـائید. 

در اینصورت مقاطع مسیر شماره 2 بصورت زیر بر روی مقاطع مسیر شماره 1 قرار خواهد گرفت.  
w
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ــاطع عرضـی را بـه  حال می توانید با استفاده از منوی Window و مرتب سازی پنجره ها ، پروفیل طولی و مق
صورت زیر بطور همزمان مشاهده نمائید. 

 

 
 در این حالت اگر پنجره مربوط به مقاطع فعال باشد یا تغییر محل ماوس فاصله از محورو ارتفاع آن محل ، در 
نوار پائین پنجره اصلی دیده خواهد شد و اگر پنجره پروفیل طولی فعال باشد با تغییر محــل مـاوس فاصلـه از 

مبداء ( کیلومتراژ) و ارتفاع آن در نوار پائین پنجره اصلی ظاهر خواهد شد. 
 

4-10     تعیین پارامترهای مربوط به چاپ پروفیل 
ــن  پس از ایجاد پروفیل و مشاهده آن می توان تنظیماتی را بر روی آن جهت چاپ انجام داد. بنابراین جهت تعیی
 Profile plt ــر روی بـرگه پارامترهای مربوط به چاپ پروفیل ایجاد شده دستور زیر را اجراء کرده و سپس ب

کلیک کرده تا پنجره ای بشکل زیر گشوده گردد: 
 Road> Display & Plotting> Profile Parameters
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در قسمت  # Plot شماره پلات ایجاد شده و در قسمت  Ranqe of chainages می توانید محــدوده کیلومـتراژ 

ــائید. بـا کلیـک بـر روی دکمـه هـای Min و Max کیلومـتراژ ابتـدا و انتـهای پروفیـل در      مورد نیاز را وارد نم
ــن دو قسـمت مـی تـوان مشـخص نمـود کـه پروفیـل در چـه     قسمت های فوق ظاهر خواهند شد. در واقع در ای

 ( VS: ) و مقیاس ارتفــاعی ( HS: ) می توان مقیاس طولی  Scales فاصله ای مورد نیاز می باشد. در قسمت
را برای پروفیل تعیین نمود.  معمولا مقیاس ارتفاعی را 10 برابر مقیاس طولی در نظر می گیرند. به عبارت دیگر 
اگر مقیاس طولی در پروفیل 1000 باشد مقیاس ارتفاعی را 100 در نظر می گیرند. در قسمت Origin می تــوان 
مختصات قرارگیری پروفیل روی کاغذ را مشخص نمود. در قســمت Type دو حـالت وجـود دارد. یکـی حـالت 
ــت و در حـالت Grid پروفیـل بـر روی  Box که در این حالت پروفیل داخل یک کادر مستطیلی قرار خواهد گرف

شبکه هائی که شامل خطوط اصلی ( Major ) و فرعــی ( Minor ) بـوده ترسـیم مـی گردد. در حـالت اخـیر      
می توان در قسمتهای  Major و Minor  فاصله خطوط شبکه های اصلی و فرعی را مشخص نمود. در قسمت 
Broder مشخص نمود که کادری دور پروفیل ترسیم گردد یا خیر. در حالت On کادر ترسیم شده و در حالت 

Off کادری ترسیم نخواهد شد. 
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ــمت  در قسمت Datum سطح مبناء پروفیل معرفی می گردد. اگراین قسمت در حالت On باشد  می توان در قس
Datum Val مقداری را برای سطح مبناء در نظر گرفت. در واقع در این قسمت فاصله پروفیل بــا کـادر زیریـن 

آن مشخص می گردد. در قسمت Extra  ch می توان فواصل غیر از محلهائی که در آنها مقطع عرضی برداشت 
 Table ــا کلیـک کـردن بـر روی دکمـه شده را در زیر پروفیل درج نمود. لذا با On کردن این قسمت می توان ب
مقابل این قسمت در پنجره ای که باز می شــود اطلاعـات مربوطـه را درج کـرد. بـرای مثـال اگر بخواهیـد بیـن 
کیلومتراژ 840.00+0 تا 0.880.00 فاصله 8.30 را درج کنید بایستی در قسمت From chainge مقـدار 840 و 
ــرده و  در قسمت To chainage مقدار 880 و در نهایت در قسمت Chainage interval مقدار 8.30  را وارد ک

سپس Save نمائید. 
 

 
 

ــی رود.  در قسمت Delete ch جهت حذف فواصل بین دو کیلومتراژی را که در آنها مقطع برداشت شده بکار م
اگر این قسمت در حالت On باشد با کلیک بر روی دکمه Table مقابل این قسمت در پنجره ای که بصورت زیر 
ــتراژ هـای مـورد نظـر را وارد کـرده و  باز می گردد در قسمت های From chainage و To chainage کیلوم

Save کنید در این صورت تمامی فواصلی که بین این دو مقدار قرار گرفته باشند حذف خواهند شد. 
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اگر  قسمت Adjust در حالت On باشد در پنجره ای که بصورت زیر باز می گردد می توان یک مقدار ثابتی را 
به مقدار کیلومتراژهای وارد شده اضافه یا کسر نمود. بعنوان مثال اگر عدد 10 را در قسمت Correction وارد 
ــرده باشـیم ایـن مقـدار از مقـادیر  نمائیم این مقدار به مقادیر کیلومتراژ اضافه و در صورتی که 10- را وارد ک

کیلومتراژ کسر می گردد. 
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ــود. بـر کلیـک بـر  در قسمت Text string می توان انواع نوشته های مورد نیاز را در چاپ پروفیل مشخص نم
روی این دکمه پنجره ای بفرم زیر گشوده می گردد. 

 
ــالا انتخـاب نمـود. در  در این پنجره با کلیک بر روی قسمت All می توان تمامی نوشته های موجود در پنجره ب

قسمت Heading می توان عنوانی را به دلخواه برای پروفیل وارد کرده وOk کرد. 
در قسمت Format می توان مشخصات انواع خطوط و برچسب های  ( Labels ) مورد نظر را تعیین نمود. بــا 

کلیک کردن بر روی این دکمه پنجره ای بصورت زیر باز می گردد: 
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در قسمت Box Height  می توان ارتفاع Box مربوط به عناوین به کار رفته در پروفیل را مشــخص نمـود. در 
 Descender مشخص مــی گردد.  در قسـمت Box نوع خطوط و رنگ مربوط به خطوط  Box Lines   قسمت
lines مشخصات مربوط به خطوط Descender معرفی می گردد. خطوط  Descender خطوطی است که نقطه 

ــه در قسـمت Type از پنجـره اصلـی  ای روی پروفیل را به مقادیر آن در جدول مربوط می کند. در صورتی ک
ــی و فرعـی شـبکه را در قسـمت       حالت Grid را انتخاب کرده باشید می توان مشخصات مربوط به خطوط اصل

Major Grid و Minor Grid از پنجره بالا معرفی نمود. در قسمت Box contains می توان مشخص نمود که 

چه نوشته ای در زیر پروفیلها درج گردد. پس از کلیک کردن بر روی دکمه فلش هر ردیف می توان نوع نوشته 
ــه نوشـته مذکـور را معرفـی نمـود. پـس از  را مشخص و سپس در جلوی هر ردیف سایر مشخصات مربوط ب
تعیین مشخصات و پارامترهای مورد نظر دکمه Ok را کلیک کرده و پس از اطمینان از فعال بودن پنجره نمایش 

دهنده پروفیل، از منوی File گزینه Print preview را جهت مشاهده پیش نمایش چاپ کلیک کنید. 

 
5-10     تعیین پارامترهای مربوط به چاپ مقاطع عرضی 

پس از ایجاد مقاطع عرضی و مشاهده آنها می توان تنظیماتی را بــر روی آن جـهت چـاپ  انجـام داد. بنـابراین 
ــه پروفیـل ایجـاد شـده دسـتور زیـر را اجـرا کـرده و سـپس بـر روی بـرگه     جهت تعیین پارامترهای مربوط ب
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Section plt  کلیک کنید: 
 Rood> Display & Plotting> Section Parameters

لذا پنجره ای بصورت زیر باز خواهد شد: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

اکثر گزینه های موجود در پنجره بالا همانند گزینه های مربوط به تعیین پارامترهای پروفیل بوده که در بخــش 
قبلی در مورد آن صحبت شد. در زیر به تعدادی از گزینه های پنجره بالا می پردازیم: 

 
ــن 1 الـی 14 بـوده را مشـخص  Format Type :  در اینجا می توان یکی از قالبهای پیش فرض نرم افزار که بی

نمود. 
Rows و Cols : در این دو قسمت تعــداد ردیـف هـا و تعـداد سـتونهای چـاپ شـده در هـر بـرگ را مشـخص         

می سازذ. پس از تعیین مشخصات و پارامترهای مورد نظر Ok  کرده و پس از اطمینان از فعـال بـودن پنجـره 
نمایش دهند مقاطع از منوی  File گزینه Print Preview را جهت مشاهده پیش نمایش چاپ انتخاب نمائید. 
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توجه1: 

ــوی File  یکـی از گزینـه هـای  در صورت مناسب بودن پیش نمایش پروفیلها یا مقاطع عرضی می توانید از من
 Print و یا Export dwg را جهت چاپ یا ارسال نقشه حاوی پروفیل و مقاطع به اتوکد انتخاب کنید. 

 
توجه2: 

در زیر کاربرد برخی از آیکونهای مربوط به پروفیلها و مقاطع توضیح داده شده است: 
 

             مربوط به نمایش مقاطع عرضی ( رجوع به صفحه 151 ) 
 

              مربوط به نمایش پروفیلها ( رجوع به صفحه 150 ) 
 

             مربوط به تنظیم پارامترهای مربوط به چاپ پروفیلها ( رجوع به صفحه 153 ) 
 

             مربوط به تنظیم پارامترهای مربوط به چاپ مقاطع ( رجوع به صفحه 158 ) 
 

             مربوط به نمایش سایر مقاطع مربوط به مسیرهای مختلف ( رجوع به صفحه 152 ) 
 

             مربوط به نمایش پروفیلهای مربوط به مسیر های مختلف ( رجوع به صفحه 150 ) 
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6-10 محاسبه حجم خاکبرداری و خاکریزی بین مقاطع 
قبل از محاسبه حجم بین مقاطع ابتدا بایستی پارامترهای مربوط به محاسبه حجم مقاطع را تنظیــم کـرد. جـهت 
نیل به این هدف بر روی آیکون              از نوار ابزار بالای نرم افزار کلیک کرده یا دستور زیر را اجراء کنید: 

 
 Road > Volumes > Natural volume parameters

با اجرای دستور بالا پنجره ای بشکل زیر گشوده خواهد شد: 
 

 
          

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

در پنجره بالا محدوده کیلومــتراژی را کـه حجـم بیـن مقـاطع آن محـدوده محاسـبه خواهـد شـد را در قسـمت   
ــر روی هر یـک از  Range of Chainages در بخشهای  Min و Max وارد کنید. توجه داشته باشید با کلیک ب

این دو بخش کمترین و بیشترین مقدار کیلومتراژ مسیر بطور خودکار در قسمتهای فوق ظاهر خواهند شد. 
در قسمت  Overlay Road number شماره مسیر مربوط به برداشــت اولیـه ثانویـه (مسـیر شـماره 2) و در 
قسمت  Base road number شماره مسیر مربوط به برداشت اولیه ( مســیر شـماره 1 ) را مـی تـوان معرفـی 
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ــرده و پـس  نمود.  در قسمت  Output format نوع فرمت فایل خروجی مربوط به محاسبات حجم را انتخاب ک
از  Ok کردن پنجره بالا دستور زیر را برای انجام محاسبه حجم اجراء کنید: 

 
 Road > Volumes > Natural valume
با اجرای دستور فوق وارد نرم افــزار Word یـا Wordpad شـده و شـما مـی توانیـد گزارش کـاملی از حجـم 
عملیات را مشاهده نموده و آن را ویرایش کنید. توجه داشته باشید که برای ذخیره کردن گزارش تهیه شده در 

نرم افزار Word یا Wordpad از منوی  File گزینه Save را انتخاب کرده و آن را ذخیره کنید. 
 

 : Condense نمونه ای از فایل خروجی تهیه شده با فرمت
 
 
 
 
 
 
 
 

 : Malaysian نمونه ای از فایل خروجی تهیه شده با فرمت
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 : Normal نمونه ای از فایل خروجی تهیه شده با فرمت

7-10     ایجاد یک پروفیل ساده بین دو نقطه از روی توپوگرافی  
  Interpolate گزینه Contour جهت ایجاد و ترسیم یک پروفیل ساده بین دو نقطه از روی توپوگرافی  از منوی
ــه ابتـدا و انتـهای پروفیـل کلیـک کنیـد.  و سپس گزینه  Simple profile را انتخاب کنید. سپس بر روی دو نقط
بعنوان مثال پس از باز کردن جاب DB.bdy و انتخاب گزینه فوق ابتدا در نزدیکی نقطه 203 کلیک کرده ســپس 
ماوس را حرکت دهید و به کنار نقطه 239 رفته و مجددا کلیک کنید. ملاحظه خواهید کرد که پنجره ای بصورت 

زیر باز شده و شما می توانید پروفیل ساده ای را از مسیر ایجاده شده بین دو نقطه مشاهده کنید: 
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پس از مشاهده پروفیل می توانید با وارد کردن عددی به عنوان شماره مسیر در قسمت  Road از پنجره بالا و 
کلیک بر روی دکمه Ok+Save پروفیل تهیه شده را برای استفاده های بعدی ذخیره نمائید. در ضمــن بـا فعـال 
ــوان در بخـش  Chain کیلومـتراژ ابتـدای مسـیر را وارد کـرده ودر  کردن قسمت Store as Xsection  می ت
 Start مشـخص شـده در قسـمت  Chain ــدای مسـیرکه در قسـمت صورت نیاز به تهیه مقطع درکیلومتراژ ابت
offest عرض مقطع را وارد کنید. همچنین با فعال کردن قسمت Store profile string  می توان پروفیــل تهیـه 

ــه  شده را به عنوان یک رشته خط ذخیره کرد.  لذا بایستی نام رشته خط را در قسمت  String ونام پوشه ای ک
خط در آن قرار می گیرد را در قسمت  Folder  وارد نمود.پس از ذخیره پروفیل مسیر ساده ایجاد شده  تحــت 
یک شماره خاص  می توانید با استفاده از آیکون                مقطع عرضی کیلومتراژ ابتدای مسیر و با اســتفاده 
از آیکون              پروفیل مسیر مورد نظر را مشاهده نمائید. در مورد نمایش و تعیین پارامترهای مربــوط بـه 

پروفیلها و مقاطع قبلا صحبت شد. 
 

8-10     ایجاد یک پروفیل ساده بین چند نقطه از روی توپوگرافی 
مجددا در همان جاب DB.bdy از منوی  Contour گزینـه  Interpolate وسـپس  گزینـه Multi profile را 
انتخاب کرده و پس از کلیک ماوس بر روی نقــاط 241 ، 229 ، 139 از صفحـه کلیـد کلیـد  Enter را بزنیـد. تـا 

پروفیل مسیر ایجاد شده بصورت زیر بر روی صفحه ظاهر گردد: 
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در مورد گزینه های پنجره بالا در بخش 7-10 صحبت شد. 
 

ــک رشـته خـط ایجـاد شـده بـر روی  9-10     ایجاد یک پروفیل از روی ی
توپوگرافی 

ــه نمـائید ابتـدا بایسـتی بـا  در صورتی که بخواهید از یک رشته خط ایجاد شده بر روی توپوگرافی پروفیل تهی
ــس  توجه به مطالبی که در فصل منوی خطوط بیان شد یک رشته خط ایجاد کرده و سپس آن را انتخاب کنید. پ
ــه  Interpolate و سـپس گزینـه String profile را  از انتخاب رشته خط مورد نظر از منوی  Contour گزین

فعال کرده تا پنجره ای بشکل زیر گشوده گردد: 

 
پنجره فوق را Yes کرده تا پنجره دیگری بفرم زیر نمایان شود: 
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در پنجره فوق نام وپوشه ای را که رشته خط انتخاب شده در آن قراردارد در قسمتهای  String و Folder  به 
نمایش در آمده است. در قسمت #Rd شماره ای را بعنوان شماره مسیر جهت استفاده های بعدی وارد کنید. در 
قسمت  Start کیلومتراژ ابتدای مسیر و در قسمت های  Xs st و Xs cur  به ترتیب فواصــل مقـاطع در مسـیر 
مستقیم و قوس دار مشخص می گردند. در قسمت  Left عرض سمت چــپ مسـیر و در قسـمت Right عـرض 
سمت راست مسیر را وارد کرده و بر روی دکمه Refresh Table کلیک کرده تا اعداد بازسازی شوند. ســپس 

بر روی دکمه Save کلیک کرده تا پروفیل مسیر بصورت زیر بنمایش در آید: 

 
در پنجره بالا پروفیل مسیررا در قسمت  Long section و با کلیــک بـر روی دکمـه  Next  مـی تـوان مقـاطع 
عرضی مسیر را در قسمت Cross section  مشاهده نمود. پس از مشاهده پروفیل مــی توانیـد بـا وارد کـردن 
ــر روی دکمـه Ok+Save پروفیـل تهیـه  عددی به عنوان شماره مسیر در قسمت  Road از پنجره بالا و کلیک ب
شده را برای استفاده های بعدی ذخیره نمائید. در ضمن با فعال کردن قسمت Store as Xsection  مــی تـوان 
در بخش  Chain کیلومتراژ ابتدای مسیر را وارد کرده ودر صورت نیــاز بـه تهیـه مقطـع درکیلومـتراژ ابتـدای 
مسیرکه در قسمت Chain  مشخص شده در قسمت Start offest عرض مقطع را وارد کنید. همچنیــن بـا فعـال 
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کردن قسمت Store profile string  می توان پروفیل تهیه شده را به عنوان یک رشته خــط ذخـیره کـرد.  لـذا 
   Folder ــمت بایستی نام رشته خط را در قسمت  String ونام پوشه ای که خط در آن قرار می گیرد را در قس
وارد نمود.پس از ذخیره پروفیل مسیر ساده ایجاد شده  تحــت یـک شـماره خـاص  مـی توانیـد بـا اسـتفاده از   
آیکون              مقطع عرضی کیلومتراژ ابتدای مسیر و با استفاده از آیکون              پروفیل مسیر مورد نظـر 

را مشاهده نمائید. در مورد نمایش و تعیین پارامترهای مربوط به پروفیلها و مقاطع قبلا صحبت شد. 
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1-11  نصب برنامه 
نرم افزار  Terragen برنامه ای است که می توان از جــاب هـای موجـود درSDRmap تصـاویر سـه بعـدی و 

ــا کیفیـت بـالا ایجـاد نمـود. ایـن نـرم افـزار بعنـوان یـک برنامـه کمکـی درCD نرم افـزار    انیمیشن های زیبا ب
 SDRmap V8.01  قرار داده شده است. پس از فعال نمودن سی دی SDRmap V8.01 پنجــره ای بصـورت 

زیر باز می گردد: 

 
 Crack ــتفاده از دکمـه ابتدا بر روی دکمه Terragen 0.9.19 کلیک کرده و برنامه را نصب نموده سپس با اس
ــک  For Terragen  قفل آن را نیز بر روی کامپیوتر نصب نمائید. پس از نصب ، جهت اجرای برنامه فوق با کلی

بر روی دکمه  Start ویندوز از منوی  Program گزینه Terragen  سپس زیر گزینه Terragen را اجرا کنید. 
توجه داشته باشید در این فصل هدف توضیح اجمالی نرم افزار فــوق بـوده و از توضیحـات کلـی صـرف نظـر 

کرده و آن را بعهده خواننده واگذار می نمائیم.  
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2-11   ایجاد تصویر و نمای سه بعدی 
مراحل کلی کار جهت تهیه نمای سه بعدی از جاب درون  SDRmap  به شرح زیر می باشد: 

 ( DB.DAM بعنوان مثال جاب )   SDRmap   الف )    انتخاب جاب دلخواه در نرم افزار
ــده و منحنـی میزانـها ایجـاد شـده انـد. هـر چقـدر فواصـل     فرض بر این است که جاب انتخاب شده انترپوله ش

منحنی های اصلی و فرعی کمتر باشد دقت نمای سه بعدی تهیه شده بالا خواهــد بـود.  در مـورد تهیـه منحنـی 
میزان و تعیین پارامترهای مربوط به منحنی میزان در فصل منحنی میزان صحبت شد. در زیر منحنی میزانهای 

جاب  DB.DAM نشان داده شده است: 

 
ب ) اجرای دستور .… File > Exports > Export  . با اجرای این دستور پنجــره ای بشـکل زیـر گشـوده 

خواهد شد: 
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در پنجره بالا فرمت  Terragen format (.ter) را انتخاب کرده و Ok نمــائید. پنجـره دیـگری بشـکل زیـر بـاز    

می گردد: 

 
  در این پنجره مسیر و نام فایل خروجی ایجاد شده با فرمت TER.  را وارد کرده و بر روی دکمه Save کلیک 

نمائید. در اینصورت پنجره دیگری همانند زیر نمایان خواهد شد: 
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ــدد 164 را  در پنجره بالا در قسمت Oversize factor  عدد 1 را برای بزرگنمائی ودر قسمت  Edge height ع
برای ارتفاع لبه ها و در قسمت Number grid points تعداد نقاط شبکه را 400 وارد نموده و در انتها بر روی 
دکمه Ok کلیک کرده و صبر کنید تا فایل خروجی تهیــه گردد. سـپس وارد نـرم افـزار  Terragen  شـوید. در 

اینصورت پنجره زیر گشوده خواهد شد: 
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ــک کـرده و فـایل خروجـی ایجـاد شـده بـا فرمـت  در این پنجره در قسمت  Terrain بر روی دکمه  Open کلی
Terragen را انتخاب کنید. 

 

 
 

  Terragen کلیک نمــوده واز شـاخه ای که نـرم افـزار Open  بر روی دکمه Surface map  سپس در قسمت 
نصب شده تصویر Desert and Grass را انتخاب کنید. سپس در پنجــره Rendering control بعـد از تنظیـم 

w
w

w
.K

U
R

D
in

at
e.

ir



 SDRMAP V8.01 نرم افزار
 

176
 

دوربین دکمه Render Preview را کلیک کرده تا تصویری از منطقه در محل خاص خود به نمایش درآید. 

 
اگر جای دوربین درست بود و به تصویر دلخواه خود رسیدید بر روی دکمه Render Image کلیک کرده تا 

تصویر را بصورت زیر مشاهده کنید در غیر اینصورت در پنجره بالا محل دوربین را تغییر داده تا به تصویر 
دلخواه خود برسید. 
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اگر بخواهید در قسمت گودی وسط تصویر بالا  مقداری آب قرار  
دهیم تا یک دریاچه بوجود آید ابتدا بر روی آیکون Water کلیک 

 کرده تا پنجره ای بشکل زیر باز گردد: 
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در پنجره بالا در قسمت  Water Level عدد 14 را وارد کرده سپس بر روی دکمه Update maps کلیک کنید. 
سپس دوباره از پنجره  Rendering Control بر روی دکمه Render Image کلیک کرده تا تصویری مشابه 

زیر ظاهر گردد: 
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